DXM150-Bx and 1500-Bx Wireless Controller Instruction Manual
Contents

Chapter 1 System Overview
System Overview for the DXM150-B1 ................................................................. 5
System Overview for the DXM150-B2 ................................................................. 6
System Overview for the DXM150-B3 ................................................................. 7
System Overview for the DXM150-B2 ................................................................. 8
Hardware Overview ......................................................................................... 10
DXM Configuration Software ........................................................................... 12
DXM Automation Protocols ............................................................................. 12
DXM Modbus Overview ................................................................................. 13

Chapter 2 Quick Start Guide
Device Setup ..................................................................................................... 15
Apply Power to the Controller ......................................................................... 15
Binding and Conducting a Site Survey with the ISM Radio .............................. 15
Set a Static IP Address ................................................................................. 17
Configuration Instructions ............................................................................. 18
Configuring the Controller ........................................................................... 18
Introduction to Traditional Setup Mode ......................................................... 18
Banner Engineering Corp Limited Warranty .................................................... 21

Chapter 3 ISM Radio Board (Slave ID 1)
MultiHop Radio DIP Switches .......................................................................... 23
Application Mode ........................................................................................... 24
Baud Rate and Parity ...................................................................................... 24
Disable Serial................................................................................................... 25
Transmit Power Levels/Frame Size ................................................................ 25
DIP Switch Settings for the Performance Gateway Radio Module .......... 25

Chapter 4 Processor Boards
Processor Board for the DXM1x0 Models ......................................................... 27
DIP Switch Settings for the Processor Board .................................................. 28
Ethernet .......................................................................................................... 28
USB ................................................................................................................ 28

Chapter 5 IO Base Boards
Board Connections for the DXM150-B1 and DXM1500-B1 ............................. 31
Board Connections for the DXM150-B2 and DXM1500-B2 ............................. 33
DIP Switches for the IO Board ........................................................................ 34
Setting the Modbus ID on the I/O Base Board ............................................... 34
Example to Set the DXM Modbus ID using DIP Switches .............................. 35
Example to Set the DXM I/O Board Modbus ID using Modbus Registers ........ 35
I/O Board Jumpers .......................................................................................... 35
Applying Power to the B1 Models .................................................................. 35
Applying Power to the B2 or S2 Models ......................................................... 28
Connecting a Battery ..................................................................................... 36
Supplying Power from a Solar Panel ............................................................... 36
Connecting the Communication Pins .............................................................. 36

Modbus RTU Master and Slave Ports ............................................................... 37
Set the Client and Server Port Parameters ..................................................... 38
Set the DXM Modbus Server Port ID ............................................................... 38
Inputs and Outputs ......................................................................................... 38
Universal Inputs ............................................................................................. 39
Isolated Discrete Inputs .................................................................................. 40
Relay Outputs for the DXM150-B1, 1500-B1, and 150-S1 .............................. 41
NMOS Outputs ............................................................................................... 41
PNP and NPN Outputs for the B2 and S2 Models .......................................... 42
Analog Outputs (DAC) ................................................................................... 42
### Chapter 6 Cellular Modem Boards

- Cellular Modem Board ........................................................................................................... 43
- Cellular Power Requirements .................................................................................................... 43
- Using the DXM Cellular Modem ............................................................................................... 44
- Activating a Cellular Modem ..................................................................................................... 44
- Install the Cellular Modem (DXM100, 150, 700, and 1000 Models) ...................................... 45
- Install the Cellular Modem (DXM1200 Models) ..................................................................... 46
- Activate a 4G LTE CAT M1 Cellular Plan ............................................................................... 47
- Activate a Worldwide 4G LTE MNO-IOT Cellular Plan (RED-CE) ......................................... 48
- Configure the DXM Controller for a Cellular Modem .............................................................. 48

### Chapter 7 LCD and Menu System

- Registers .................................................................................................................................... 51
  - Push ......................................................................................................................................... 52
  - ISM Radio ................................................................................................................................. 52
  - IO Board ................................................................................................................................... 53
- System Config ............................................................................................................................ 54
  - ISM Radio ............................................................................................................................... 54
  - IO Board ................................................................................................................................. 55
  - Ethernet .................................................................................................................................. 55
  - Provision Cell ......................................................................................................................... 56
  - DXM Modbus ID ..................................................................................................................... 56
  - LCD Contrast ......................................................................................................................... 56
  - Set .......................................................................................................................................... 56
  - System Info ............................................................................................................................ 57
  - Display Lock ........................................................................................................................... 58

### Chapter 8 Configuration Instructions

- DXM Configuration Software .................................................................................................. 12
  - Register Flow and Configuration .......................................................................................... 60
  - Basic Approach to Configuration ......................................................................................... 60
  - Troubleshooting a Configuration ......................................................................................... 60
  - Saving and Loading Configuration Files ............................................................................. 60
  - Uploading or Downloading Configuration Files ................................................................. 61
- Scheduler ................................................................................................................................. 61
  - Create a Weekly Event ......................................................................................................... 61
  - Create a One-Time Event ..................................................................................................... 62
  - Create a Holiday Event ........................................................................................................ 62
- Authentication Setup ................................................................................................................ 62
  - Set the Controller to use Authentication ......................................................................... 62
  - Controller Configuration Authentication ........................................................................... 63
- Ethernet IP Configuration ....................................................................................................... 63
  - Download an Existing Configuration from the DXM ......................................................... 64
  - Configuring the Controller .................................................................................................. 64
  - Configuring the Host PLC .................................................................................................... 65
- Define the Network Interface Settings .................................................................................. 66
  - Configure your Ethernet Connection ................................................................................ 66
  - Configure your Cellular Connection .................................................................................. 67
- Ethernet and Cellular Push Retries ........................................................................................ 67
  - Ethernet Push Retries .......................................................................................................... 67
  - Cellular Push Retries ........................................................................................................... 67
  - Event/Action Rule or Log File Push Retries ....................................................................... 67

### Chapter 9 Additional Information

- Working with Modbus Devices ............................................................................................... 69
  - Assigning Modbus IDs .......................................................................................................... 70
  - Wireless and Wired Devices ................................................................................................ 70
  - Modbus Communication Timeouts ..................................................................................... 71
  - Modbus TCP Client .............................................................................................................. 72
- Modbus Register Summary ................................................................................................... 72
  - DXM Modbus Registers ....................................................................................................... 72
  - Modbus Registers for the MultiHop Radio Board Module ................................................. 72
  - Modbus Registers for the Performance Gateway Radio Module ...................................... 73
  - Internal Local Registers (ID 199) for the DXM100 and DXM150 ......................................... 76
  - Modbus Registers for the -B1 and -S1 Model I/O Board .................................................... 79
  - Modbus Registers for the -B2 and -S2 I/O Board ................................................................. 80
  - Modbus Configuration Registers for the Discrete and Universal Inputs ............................ 81
  - Modbus Configuration Registers for the Analog Output ...................................................... 82
  - Modbus Configuration Registers for the IO (Definitions) .................................................. 83
Chapter 10 DXM150 and DXM1500 Dimensions ................................................................. 89

Chapter 11 Troubleshooting
Restoring Factory Default Settings for the IO Base Board ......................................................... 91
Updating the DXM Processor Firmware .................................................................................. 91
Update Your DXM Processor Firmware (Prior to Version 2.0) .................................................. 91
Updating Your DXM Processor Firmware (Version 2 or Later) .................................................. 93
Troubleshooting Issues ............................................................................................................. 96
Modbus Operation .................................................................................................................. 96

Chapter 12 Accessories............................................................................................................. 97

Chapter 13 Product Support and Maintenance
File System and Archive Process ............................................................................................ 99
DXM150 Documentation .......................................................................................................... 100
DXM1500 Documentation ...................................................................................................... 100
DXM Support Policy ............................................................................................................. 100
Firmware Updates ................................................................................................................ 101
Website Information ............................................................................................................. 101
Feature Requests ................................................................................................................ 101
Potential DXM Issues ......................................................................................................... 101
DXM Security ....................................................................................................................... 101
FCC and ISED Certification, 900 MHz, 1 Watt Radios ............................................................ 101
FCC Notices ......................................................................................................................... 101
FCC and ISED Certification, 2.4GHz .................................................................................... 103
FCC Notices ......................................................................................................................... 103
FCC and ISED Approved Antennas ....................................................................................... 103
Notas Adicionales ................................................................................................................ 103
Mexican Importer ................................................................................................................ 104
ANATEL ................................................................................................................................ 104
Contact Us ............................................................................................................................ 104
Warnings ............................................................................................................................... 105
Banner Engineering Corp Limited Warranty ........................................................................ 21
............................................................................................................................................ 106
Chapter 1  System Overview

System Overview for the DXM150-B1

Banner’s DXM Logic Controller integrates Banner’s wireless radio, cellular connectivity, and local I/O to provide a platform for the Industrial Internet of Things (IIoT). Various combinations of I/O and connectivity are available based on the different models.

Inputs and Outputs

<table>
<thead>
<tr>
<th>Inputs and Outputs</th>
<th>Connectivity</th>
<th>Logic Controller</th>
<th>User Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal inputs</td>
<td>Cellular</td>
<td>Action rules</td>
<td>LCD screen</td>
</tr>
<tr>
<td>Discrete outputs</td>
<td>Sure Cross radios</td>
<td>Programming language</td>
<td>LED indicators</td>
</tr>
<tr>
<td>Courtesy power</td>
<td>Ethernet</td>
<td>Scheduler</td>
<td></td>
</tr>
<tr>
<td>Isolated inputs</td>
<td>RS-485 client and server</td>
<td>Push to the cloud</td>
<td></td>
</tr>
<tr>
<td>Relay outputs</td>
<td>RS-232 or CAN</td>
<td>Data logging</td>
<td></td>
</tr>
</tbody>
</table>

Inputs and Outputs

- On-board universal and programmable I/O ports connect to local sensors, indicators, and control equipment.
- Universal inputs, discrete outputs, courtesy power and switched power outputs, isolated inputs, relay outputs
- Battery backup, solar controller

Connectivity

- The DXM’s wired and wireless connectivity options make it easy to share data between local and remote equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and control equipment.
- Wired Connectivity -- Ethernet: Modbus/TCP or Ethernet/ IP and Field Bus: Modbus RS-485 Client/Server
- Wireless Connectivity -- Sure Cross® Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz and Cellular modem: LTE-M (United States) or LTE-M/ NB-IoT (outside the United States)
- Controller Area Network (CAN)

Logic Controller

- Program the DXM’s logic controller using action rules and/or the ScriptBasic language, which can execute concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems. File and LCD password protection is an option.

Register Mapping

- Cyclical Read rules from wireless devices or local wired Modbus devices that include optional scaling, error conditions, and the ability to activate a read rule
- Cyclical or Change of State Write rules to wireless devices or local wired Modbus devices with scaling
- Modbus/TCP Client Read or Write rules for external devices on the network

Action Rules

- Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, and logging options
- Math/Logic Rules (arithmetic and bitwise operators)
- Control Logic (logical operators and SR/T/D/JK flip flops)
- Trending (multiple averaging filters)
- Tracking (counts, on/off times)
- Push data on conditions
DXM150-Bx And 1500-Bx Wireless Controller Instruction Manual

### Scheduler
- Time/calendar-based events
- Holiday skips; one-time events
- Dynamic scheduler updating
- Astronomical clock

### Optional Text Programming
- ScriptBasic to create variables, arrays, functions, loops, IF/THEN/ELSE, logical and arithmetic operators, API commands, register access, string functions and operators, and time commands

### Data Logging
- Cyclic data/event logging

### User Interface
-A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

#### User-Programmable LCD
- Binding Sure Cross Radios
- Conducting a Site Survey
- Viewing sensor information

#### User-Defined LED Indicators
- Four multicolored LEDs: green, amber, and red
- Programmable behavior

### System Overview for the DXM150-B2
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for the Industrial Internet of Things (IIoT).

<table>
<thead>
<tr>
<th>Inputs and Outputs</th>
<th>Connectivity</th>
<th>Logic Controller</th>
<th>User Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal inputs</td>
<td>Cellular</td>
<td>Action rules</td>
<td>LCD screen</td>
</tr>
<tr>
<td>PNP/NPN outputs</td>
<td>Sure Cross radios</td>
<td>Programming language</td>
<td>LED indicators</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>Ethernet</td>
<td>Scheduler</td>
<td></td>
</tr>
<tr>
<td>Isolated power</td>
<td>RS-485 client and server</td>
<td>Push to the cloud</td>
<td></td>
</tr>
<tr>
<td>Courtesy power outputs</td>
<td>RS-232 or CAN</td>
<td>Data logging</td>
<td></td>
</tr>
</tbody>
</table>

### Inputs and Outputs
- On-board universal and programmable I/O ports connect to local sensors, indicators, and control equipment.
- Universal inputs, analog outputs, PNP/NPN outputs, isolated inputs
- Courtesy power output, battery backup, solar controller

### Connectivity
- The DXM's wired and wireless connectivity options make it easy to share data between local and remote equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing and control.
- The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and control equipment.
- Wired Connectivity — Ethernet: Modbus/TCP or Ethernet/IP and Field Bus: Modbus RS-485 Client/Server
- Wireless Connectivity — Sure Cross® Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz and Cellular modem: LTE-M (United States) or LTE-M/ NB-IoT (outside the United States)

### Logic Controller
- Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems. File and LCD password protection is an option.

#### Register Mapping
- Cyclical Read rules from wireless devices or local wired Modbus devices that include optional scaling, error conditions, and the ability to activate a read rule
- Cyclical or Change of State Write rules to wireless devices or local wired Modbus devices with scaling
- Modbus/TCP Client Read or Write rules for external devices on the network

#### Action Rules
- Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, and logging options
- Math/Logic Rules (arithmetic and bitwise operators)
- Control Logic (logical operators and SR/T/D/JK flip flops)
- Trending (multiple averaging filters)
- Tracking (counts, on/off times)
- Push data on conditions

---

© Banner Engineering Corp.

June 05, 2023
Scheduler
- Time/calendar-based events
- Holiday skips; one-time events
- Dynamic scheduler updating
- Astronomical clock

Optional Text Programming Language
- ScriptBasic to create variables, arrays, functions, loops, IF/THEN/ELSE, logical and arithmetic operators, API commands, register access, string functions and operators, and time commands

Data Logging
- Cyclic data/event logging

User Interface
- A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

User-Programmable LCD
- Binding Sure Cross radios
- Conducting a Site Survey
- Viewing sensor information

System Overview for the DXM1500-B1
Banner’s DXM Logic Controller integrates Banner’s wireless radio, cellular connectivity, and local I/O to provide a platform for the Industrial Internet of Things (IIoT).

Inputs and Outputs
- Universal inputs
- Discrete outputs
- Courtesy power output
- Isolated inputs
- Relay outputs

Connectivity
- Universal inputs: Sure Cross radios
- Courtesy power output: Ethernet
- Isolated inputs: USB
- Relay outputs: RS-485 client/server, RS-232

Logic Controller
- Action rules
- Programming language
- Scheduler
- Data logging

User Interface
- LCD screen
- LED indicators
- Push to the cloud

Modbus registers for internal local registers (Modbus ID 199)

<table>
<thead>
<tr>
<th>Local Registers</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–845</td>
<td>32-bit integer</td>
<td>Local data registers</td>
</tr>
<tr>
<td>846–849</td>
<td>32-bit integer</td>
<td>Reset, Constant, Timer</td>
</tr>
<tr>
<td>851–900</td>
<td>32-bit non-volatile integer</td>
<td>Data flash, non-volatile</td>
</tr>
<tr>
<td>901–1000</td>
<td></td>
<td>Reserved for internal use</td>
</tr>
<tr>
<td>1001–5000</td>
<td>Floating point</td>
<td>Floating point registers, local data registers</td>
</tr>
<tr>
<td>5001–7000</td>
<td>32-bit integer</td>
<td>Local data registers</td>
</tr>
<tr>
<td>7001–8000</td>
<td>32-bit non-volatile integer</td>
<td>Data flash, non-volatile</td>
</tr>
<tr>
<td>&gt; 10000</td>
<td></td>
<td>Read-only virtual registers, system-level data</td>
</tr>
</tbody>
</table>

Inputs and Outputs
- On-board universal and programmable I/O ports connect to local sensors, indicators, and control equipment.
- Universal inputs, discrete outputs, courtesy power outputs
- Battery backup, solar controller

Connectivity
- The DXM’s wired and wireless connectivity options make it easy to share data between local and remote equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and control equipment.
- Wired Connectivity — Ethernet: Modbus TCP, Ethernet/IP, or Profinet; Field Bus: Modbus RS-485 Client/Server
Wireless Connectivity — Sure Cross Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz; Cellular modem: LTE-M (United States) or LTE-M/NB-IoT (outside the United States)

Logic Controller — Program the DXM’s logic controller using action rules and/or ScriptBasic language, which can execute concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems. File and LCD password protection is an option.

Register Mapping
- Cyclical Read rules from wireless devices or local wired Modbus devices that include optional scaling, error conditions, and the ability to activate a read rule
- Cyclical or Change of State Write rules to wireless devices or local wired Modbus devices with scaling
- Modbus/TCP Client Read or Write rules for external devices on the network

Action Rules
- Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, and logging options
- Math/Logic Rules (arithmetic and bitwise operators)
- Control Logic (logical operators and SR/T/D/JK flip flops)
- Trending (multiple averaging filters)
- Tracking (counts, on/off times)
- Push data on conditions

Scheduler
- Time/calendar-based events
- Holiday skips
- One-time events
- Dynamic scheduler updating
- Astronomical clock

Optional Text Programming Language
- ScriptBasic to create variables, arrays, functions, loops, IF/THEN/ELSE, logical and arithmetic operators, API commands, register access, string functions and operators, time commands

Data Logging
- Cyclic data/event logging

User Interface — A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

User-Programmable LCD
- Binding Sure Cross radios
- Conducting a Site Survey
- Viewing sensor information

User-Defined LED Indicators
- Four multicolor LEDs: green, amber, and red
- Programmable behavior

System Overview for the DXM1500-B2
Banner’s DXM Logic Controller integrates Banner’s wireless radio, cellular connectivity, and local I/O to provide a platform for the Industrial Internet of Things (IIoT).

<table>
<thead>
<tr>
<th>Inputs and Outputs</th>
<th>Connectivity</th>
<th>Logic Controller</th>
<th>User Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal inputs</td>
<td>Cellular</td>
<td>Action rules</td>
<td>LCD screen</td>
</tr>
<tr>
<td>PNP/NPN outputs</td>
<td>Sure Cross radios</td>
<td>Programming language</td>
<td>LED indicators</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>Ethernet</td>
<td>Scheduler</td>
<td></td>
</tr>
<tr>
<td>Isolated inputs</td>
<td>USB</td>
<td>Push to the cloud</td>
<td></td>
</tr>
<tr>
<td>Courtesy power output</td>
<td>RS-485 client/server</td>
<td>Data logging</td>
<td></td>
</tr>
</tbody>
</table>

Modbus registers for internal local registers (Modbus ID 199)

<table>
<thead>
<tr>
<th>Local Registers</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–845</td>
<td>32-bit integer</td>
<td>Local data registers</td>
</tr>
<tr>
<td>846–849</td>
<td>32-bit integer</td>
<td>Reset, Constant, Timer</td>
</tr>
<tr>
<td>851–900</td>
<td>32-bit non-volatile integer</td>
<td>Data flash, non-volatile</td>
</tr>
<tr>
<td>901–1000</td>
<td>32-bit integer</td>
<td>Reserved for internal use</td>
</tr>
<tr>
<td>1001–5000</td>
<td>Floating point</td>
<td>Floating point registers, local data registers</td>
</tr>
<tr>
<td>5001–7000</td>
<td>32-bit integer</td>
<td>Local data registers</td>
</tr>
</tbody>
</table>

Continued on page 9
### Local Registers

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7001–8000</td>
<td>32-bit non-volatile integer Data flash, non-volatile</td>
</tr>
<tr>
<td>&gt; 10000</td>
<td>Read-only virtual registers, system-level data</td>
</tr>
</tbody>
</table>

### Inputs and Outputs

- On-board universal and programmable I/O ports connect to local sensors, indicators, and control equipment.
- Universal inputs, discrete outputs, courtesy power output
- Battery backup, solar controller

### Connectivity

- The DXM's wired and wireless connectivity options make it easy to share data between local and remote equipment. The cellular modem option eliminates the need for IT infrastructure to connect remote equipment for sensing and control.
- The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and control equipment.
  - Wired Connectivity—Ethernet: Modbus TCP, Ethernet/IP, or Profinet and Field Bus: Modbus RS-485 Client/Server
  - Wireless Connectivity—Sure Cross Wireless Radio: DX80 900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz and Cellular modem: LTE-M (United States) or LTE-M/NB-IoT (outside the United States)

### Logic Controller

- Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems. File and LCD password protection is an option.

### Register Mapping

- Cyclical Read rules from wireless devices or local wired Modbus devices that include optional scaling, error conditions, and the ability to activate a read rule
- Cyclical or Change of State Write rules to wireless devices or local wired Modbus devices with scaling
- Modbus/TCP Client Read or Write rules for external devices on the network

### Action Rules

- Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, and logging options
- Math/Logic Rules (arithmetic and bitwise operators)
- Control Logic (logical operators and SR/T/D/JK flip flops)
- Tracking (counts, on/off times)
- Push data on conditions

### Scheduler

- Time/calendar-based events
- Holiday skips
- One-time events
- Dynamic scheduler updating
- Astronomical clock

### Optional Text Programming Language

- ScriptBasic to create variables, arrays, functions, loops, IF/THEN/ELSE, logical and arithmetic operators, API commands, register access, string functions and operators, time commands

### Data Logging

- Cyclic data/event logging

### User Interface

- A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system status and setup, view user-selectable events or data, and bind and perform site surveys for Sure Cross radios. Configure the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

#### User-Programmable LCD

- Viewing the system's status
  - Viewing sensor information

#### User-Defined LED Indicators

- Four multicolored LEDs: green, amber, and red
  - Programmable behavior
## Hardware Overview

The DXM can have several different configurations. The DXM has a model number label on the housing. Use the model number and model table to identify which boards are included in your controller.

### DXM150-Bx

**Base**

DXM150-B1

**Radio Configuration**

R1

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank = None</td>
<td></td>
</tr>
<tr>
<td>R1 = 900 MHz, 1 W PE5 Performance Radio (North America)</td>
<td></td>
</tr>
<tr>
<td>R2 = 900 MHz, 1W HE5 MultiHop Data Radio (North America)</td>
<td></td>
</tr>
<tr>
<td>R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)</td>
<td></td>
</tr>
<tr>
<td>R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)</td>
<td></td>
</tr>
<tr>
<td>R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)</td>
<td></td>
</tr>
<tr>
<td>R8 = 900 MHz, Performance Radios approved for Australia/New Zealand</td>
<td></td>
</tr>
<tr>
<td>R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand</td>
<td></td>
</tr>
</tbody>
</table>

**Radio Configuration**

**Base**

DXM1500-B1

**Radio Configuration**

R1

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank = None</td>
<td></td>
</tr>
<tr>
<td>R1 = 900 MHz, 1 W PE5 Performance Radio (North America)</td>
<td></td>
</tr>
<tr>
<td>R2 = 900 MHz, 1W HE5 MultiHop Data Radio (North America)</td>
<td></td>
</tr>
<tr>
<td>R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)</td>
<td></td>
</tr>
<tr>
<td>R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)</td>
<td></td>
</tr>
<tr>
<td>R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)</td>
<td></td>
</tr>
<tr>
<td>R8 = 900 MHz, Performance Radios approved for Australia/New Zealand</td>
<td></td>
</tr>
<tr>
<td>R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand</td>
<td></td>
</tr>
</tbody>
</table>

**Radio Configuration**

**Base**

DXM150-B1

**Radio Configuration**

R1

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank = None</td>
<td></td>
</tr>
<tr>
<td>R1 = 900 MHz, 1 W PE5 Performance Radio (North America)</td>
<td></td>
</tr>
<tr>
<td>R2 = 900 MHz, 1W HE5 MultiHop Data Radio (North America)</td>
<td></td>
</tr>
<tr>
<td>R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)</td>
<td></td>
</tr>
<tr>
<td>R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)</td>
<td></td>
</tr>
<tr>
<td>R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)</td>
<td></td>
</tr>
<tr>
<td>R8 = 900 MHz, Performance Radios approved for Australia/New Zealand</td>
<td></td>
</tr>
<tr>
<td>R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand</td>
<td></td>
</tr>
</tbody>
</table>
Radio Configuration

B2

B2 = Modbus controller for high I/O count applications
Power: 12-30 V DC / Solar / Battery
Comms: RS-485 and RS-232 w/flow control or secondary RS-485
Inputs: Eight universal, two isolated discrete
Outputs: Eight PNP/NPN selectable, two analog
Power Out: Two courtesy power out, two jumper selectable between 2.7 V or battery, 4.2 V or incoming power

R1

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)
R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)
R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)
R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)
R5 = 900 MHz, 65 mW HERL MultiHop Data Radio (Used for M-GAGE networks)
R6 = 900 MHz, Performance Radios approved for Australia/New Zealand
R7 = 900 MHz, MultiHop Radio approved for Australia/New Zealand

I/O Base Board—The DXM I/O base board provides connections for all inputs, outputs and power. The I/O base board contains a 12 V solar controller that accepts connections to a solar panel and sealed lead acid (SLA) battery. The battery connection can also be used with line power to provide a battery backup in case of line power outages.

Not all combinations of base boards and radios are supported.

IMPORTANT:

• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and assembling units on a grounded, static-dissipative surface.
ISM Radio—The ISM radio, either a MultiHop or DX80 Gateway, fits on the I/O base board in the parallel sockets. Install the ISM radio so the U.FL antenna connection is to the side with the SMA antenna connectors. Connect the U.FL cable from the ISM radio U.FL to the right side U.FL connector. The ISM radio boards are available with either a 900 MHz radio (North America) or a 2.4 GHz radio (world-wide).

Processor—The processor board plugs into the base board using the two 20 pin socket connectors. The board sits above the ISM radio socket and held by the base board standoffs. Position the processor board so the USB and RJ45 Ethernet connection is to the front, away from the SMA antenna connections.

Cellular Modem (Optional)—The optional cellular modem (purchased separately) board plugs into the processor board with the U.FL antenna connection to the left. Attach the antenna cable from the cellular modem to the left U.FL connection on the base board.

In some DXM models, the cellular modem may be replaced with an ISM radio. In this configuration, position the top ISM radio antenna connection to the left of the SMA antenna connector.

LCD (Display) Board—The top housing contains the LCD board. The display board is connected to the base board using a ribbon cable with a 20 pin connector.

DXM Configuration Software
Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Overview of the configuration software features

The configuration software configures the DXM by creating an XML file that is transferred to the DXM using a USB or Ethernet connection. The DXM can also receive the XML configuration file from a Web server using a cellular or Ethernet connection.

This configuration file governs all aspects of the DXM operation.

The wireless network devices are a separate configurable system. Use the DX80 User Configuration Software to configure the internal DX80 wireless Gateway and the attached wireless Nodes. Use the MultiHop Configuration Software if the internal radio is a MultiHop device.

All tools can be connected to the DXM using a USB cable or an Ethernet connection.

DXM Automation Protocols
The DXM supports the following automation protocols.
Modbus RTU
The DXM manages two separate physical ports running the Modbus RTU protocol. The DXM is the Modbus client when operating the Modbus client RTU port. The DXM uses the client Modbus RTU bus to communicate with locally connected Modbus devices or uses the Banner wireless radio to communicate with remote Modbus devices.

The other Modbus RTU port is used by a host system to access the DXM as a server device. The server Modbus RTU port allows access all the internal registers concurrently with the client RTU port. Set the Modbus ID using the LCD menu: SYSTEM CONFIG > DXM Modbus ID.

By default, the Modbus RTU ports are active. Configure the port parameters using the configuration software.

Modbus TCP/IP
A host system acting as a Modbus client can access the DXM using the Modbus TCP/IP protocol over Ethernet. Standard Modbus port 502 is used by the DXM for all Modbus TCP/IP requests.

All internal registers are available to the host system concurrently with Modbus RTU.

By default, Modbus TCP/IP is active. Configure the DXM using Modbus TCP rules in the configuration software.

EtherNet/IP™
The Ethernet port is actively running EtherNet/IP. From the factory, the DXM is configured to read and write registers on DX80 wireless devices 1 through 16. Custom configurations can be set using the configuration software.

By default, EtherNet/IP is active.

DXM Modbus Overview
The DXM uses internal 32-bit registers to store information. The processor's internal Local Registers serve as the main global pool of registers and are used as the common data exchange mechanism. External Modbus device registers can be read into the Local Registers or written from the local data registers.

The DXM, as a Modbus client or server, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP) uses the Local Registers as the accessible register data.

Using Action, Read/Write, and Threshold Rules allows you to manipulate the processor’s Local Registers. The ScriptBasic programming capabilities extends the use of Local Registers with variables to create a flexible programming solution for more complex applications.

The processor's Local Registers are divided into three different types: integer, floating point, and non-volatile. When using Local Registers internally, the user can store 32-bit numbers. Using Local Registers with external Modbus devices follows the Modbus standard of a 16-bit holding register. Local Registers are accessible as Modbus ID 199.

Accessing the I/O base board and the LCD follows the same communication as an external Modbus device. Each device has an ID number to uniquely identify itself. The I/O base board is Modbus ID 200 and the LCD is Modbus ID 201.

Overview of the DXM Modbus processor
Chapter 2  Quick Start Guide

Device Setup

Apply Power to the Controller
Follow these instructions to apply 12–30 V DC power to the controller using a wall plug.

Equipment used:
- DXM Wireless Controller
- MQDMC-401 0.3 m (1 ft) cordset with a 4-pin M12/Euro-style quick disconnect fitting
- PSW-24-1 Wall plug power supply; 24 V DC, 1 A

IMPORTANT:
- Never operate a 1 Watt radio without connecting an antenna
- Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
- To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure Cross MultiHop (1 Watt) radio without an antenna connected.

1. Connect the brown wire from the MQDMC-401 cordset to the DXM's PW (+ power) terminal.
2. Connect the blue wire from the MQDMC-401 cordset to the DXM's GD (- ground) terminal.
3. Connect the PSW-24-1 power supply to the MQDMC-401 cordset.
4. Plug in the PSW-24-1 wall plug power supply.

Binding and Conducting a Site Survey with the ISM Radio
Before the ISM radio can communicate, the ISM radio within the DXM must be bound to the other radios in the wireless network.

Use the DXM LCD menu to bind external radios to the internal ISM radio.

If you are having difficulty running binding or site surveys, it may be because of the speed of the XML configuration file or script running on the DXM. To resolve this issue, try one of the following options:
- Disable the XML and script by setting DIP switch 4 on the processor board to ON and cycling the power to the DXM.
- After binding the devices, turn DIP switch 4 back OFF and cycle power again to return to normal operation of the XML and script.
- Adjust the XML or script to slow down the RTU read or write rules.
- Upload a blank XML, bind all devices, then upload the configured XML file.

Bind a DX80 Node to a DXM and Assign the Node Address

Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound to. After a Gateway enters binding mode, the Gateway automatically generates and transmits a unique extended addressing (XADR), or binding, code to all Nodes within range that are also in binding mode. The extended addressing (binding) code defines the network, and all radios within a network must use the same code.

1. Apply power to all the devices.
Separate radios by two meters when running the binding procedure. Put only one DXM Gateway into binding mode at a time to prevent binding to the wrong Gateway.

2. Enter binding mode on the DXM radio:
   a. Use the arrow keys to select the **ISM Radio** menu on the LCD and press **ENTER**.
   b. Highlight the **Binding** menu and press **ENTER**.

3. Assign the Node address to the Node.
   - For Nodes without rotary dials: Use the DXM arrow keys to select the Node address to assign to the DX80 Node about to enter binding mode. The DXM assigns this Node address to the next Node that enters binding mode. Only bind one Node at a time.
   - For Nodes with rotary dials: Use the Node's rotary dials to assign a valid decimal Node Address (between 01 and 47). The left rotary dial represents the tens digit (0 through 4) and the right dial represents the ones digit (0 through 9) of the Node Address. You can leave the DXM "Bind to" address set to 1 because the Node's rotary dials will override that setting.

4. Start binding mode on the DXM radio by pressing **ENTER** on the DXM radio.

5. Enter binding mode on the DX80 Node.
   - For housed radios, triple-click button 2.
   - For board-level radios, triple-click the button.
   - For Nodes without buttons, refer to the Node's datasheet for instructions on entering binding mode.

   The left and right LEDs flash alternately and the Node searches for a Gateway in binding mode. After the Node binds, the LEDs stay solid momentarily, then they flash together four times. The Node automatically exits binding mode and reboots.

6. Label the Node with the assigned address number for future reference.

7. Press **BACK** on the DXM to exit binding mode for that specific Node address.
   The Node LEDs continue to flash red until the DXM exits binding mode with that Node address.

8. Repeat these steps for as many DX80 Nodes as are needed for your network.

9. When you are finished binding, press **BACK** on the DXM until you return to the main menu.

### Bind a MultiHop Radio to a DXM and Assign the Device ID

Before beginning the binding procedure, apply power to all the devices. Separate radios by two (2) meters when running the binding procedure. Put only one DXM MultiHop client radio into binding mode at a time to prevent binding the server or repeater radios to the wrong client radio.

Binding MultiHop radios ensures all MultiHop radios within a network communicate only with other radios within the same network. The MultiHop client radio automatically generates a unique binding code when it enters binding mode. This code is transmitted to all radios within range that are also in binding mode. After the Node binds, the LEDs stay solid momentarily, then they flash together four times. The Node automatically exits binding mode and reboots.

1. Enter binding mode on the DXM radio:
   a. Use the arrow keys select the **ISM Radio** menu on the LCD and press **ENTER**.
   b. Highlight the **Binding** menu and press **ENTER**.

2. Assign the device address to the repeater or server radios. Valid device IDs are 11 through 60.
   - For MultiHop radios without rotary dials: Use the DXM arrow keys to select the device ID to assign to the MultiHop radio about to enter binding mode. The DXM assigns this device ID to the next radio that enters binding mode. Only bind one server radio at a time.
   - For MultiHop radios with rotary dials: Use the MultiHop radio's rotary dials to assign a device ID. The left rotary dial represents the tens digit (1 through 6) and the right dial represents the ones digit (0 through 9) of the device ID. You can leave the DXM "Bind to" address set to 1 because the MultiHop's rotary dials will override that setting.

3. Start binding mode on the DXM radio by pressing **ENTER** on the DXM radio.

4. After entering binding mode on the DXM, put the MultiHop repeater or server radio into binding mode.
   - For housed radios, triple-click button 2.
Conduct a Site Survey from the DXM

Conduct a Site Survey to verify the wireless communication between the radios within your wireless network. Conduct the site survey when the Nodes and DXM Controller are at the proposed installation sites to determine each radio's signal strength with the DXM.

For a DX80 network, the Gateway controls the site survey and the results display on the LCD. Running a site survey on a DX80 network does not affect the throughput of the DX80 network. The DX80 Gateway-Node system can run a site survey analysis while the network is operational. For a MultiHop network, the client device passes the site survey request to the intended Modbus server device. The Site Survey runs and the results display on the LCD. Running a site survey on a MultiHop network stops all network traffic to that device.

If the Site Survey fails (100 missed packets), verify the radios are at least 10 feet from the DXM and/or rerun the binding procedure. If you find poor signal quality, common solutions include moving the DXM to a more central location relative to the Nodes or using higher-gain antennas on the DXM. Contact your local Banner Engineering representative for assistance.

Set a Static IP Address

Change the IP address of the DXM to connect to a local area network, Modbus TCP/IP host controller, or EtherNet/IP host controller.

There are two ways to set the IP address: using the DXM’s LCD menu or using the configuration software to change the XML file. IP addresses entered into the LCD menu system override the IP addresses in the XML configuration files. To use the IP addresses set in the XML configuration file, clear the IP addresses from the menu system.

Use the arrow keys to select the **System Config** menu. Press **ENTER**.

1. On the DXM: Use the arrow buttons to select the **ISM Radio** menu and press **ENTER**.
2. Select the **Site Survey** menu and press **ENTER**.
3. Use the Up or Down arrows to select the device ID number and press **ENTER** to run the site survey with that radio. The site survey results display as green, yellow, red, and missed packets. Green indicates the highest signal strength, then yellow, and red. Missed packets were not received.
4. When you are finished running the Site Survey, press **Back** twice to return to the main menu and exit site survey mode.

If the Site Survey fails (100 missed packets), verify the radios are at least 10 feet from the DXM and/or rerun the binding procedure. If you find poor signal quality, common solutions include moving the DXM to a more central location relative to the Nodes or using higher-gain antennas on the DXM. Contact your local Banner Engineering representative for assistance.

© Banner Engineering Corp.
Use this same procedure to set the subnet mask (SN) and default gateway (GW) to match your network requirements. Your IT department can provide these settings if needed.

Configuration Instructions

Configuring the Controller

Configure the DXM using the configuration software. The DXM Configuration Software allows the user to define parameters for the DXM, then saves the configuration in an XML file on the PC. To configure the DXM, connect the DXM's USB or Ethernet port to a computer.

After the configuration file is saved, upload the XML configuration file to the DXM for operation.

This quick start guide outlines the basic operations to set up a DXM using the configuration software. For a more comprehensive explanation of features, refer to the DXM Configuration Software Instruction Manual (p/n 209933).

By pressing the ENTER key on the final octet, you accept the changes.

7. Press ENTER on the final octet to accept the changes.
8. Cycle power to the DXM.
   The changes are saved on the DXM and the new IP address will be used.

Introduction to Traditional Setup Mode

This section will walk you through the traditional method of setting up the DXM Configuration Software and communicating with a connected DXM device. Version 4 of the configuration software supports multiple DXM device models, each of which incorporates different features.

As of DXM Configuration Software v4.10.28, the Simple Setup procedure is only available with the DXM100, DXM700, DXM1000, DXM1200, and DXM1500 models.

As soon as a DXM model is connected to your computer, the software automatically detects the correct model and loads the appropriate screens. You may also manually select which model of DXM you are configuring if you intend to create a configuration file without connecting a device. This ensures that the interface and the configuration file use the correct features.

Not all screens are available for all models. To change to another model of DXM, go to the Connect to DXM screen and use the drop-down list to select another model. If the active configuration is incompatible with the selected model, you will be prompted to either proceed and wipe out the active configuration or cancel the model change and preserve the configuration.
Connect via USB or Ethernet. If connecting via Ethernet, set network parameters through the DXM LCD menu in the System menu. Network parameters can also be set within the configuration software. Setting parameters on the LCD menu overrides the parameters stored in the configuration file. To use the network parameters in the configuration file, reset the network parameters on the DXM LCD menu.

Since the DXM-R90x connects only via TCP, its Connect to DXM screen differs from the other DXM models. When the Select DXM Model drop-down is set to DXM-R90x, a new network discovery table is displayed. Click Scan Network for DXMs to detect DXM devices on the host computer's network. Discovered DXMs are listed in the network discovery table. Double-click any row entry to connect to that DXM. If the DXM's IP address is already known, the standard TCP connection option is available below the network discovery table.

Banner recommends disconnecting the COMM port through the Device menu before turning off power or disconnecting the USB cable. Use Device › Reboot to restart the DXM if needed; the tool automatically disconnects the COMM port, then reconnect it again.

**TIP:** If connection attempts are failing (Application Status Icon in the footer of the tool is Red), close the configuration software and disconnect the USB cable from the computer. Reconnect the cable, launch the software, and attempt connecting again.

If you cannot connect to your DXM Controller, refer to “Troubleshooting” on page 91 for more information.

**IMPORTANT:** Any model of DXM may connect to the configuration software regardless of which device model is selected in the tool. Compatibility is checked before configuration files are uploaded to the device.

**Configuration Example: Reading Registers on a Modbus Server Device**

The local registers are the main global pool of registers that are defined by the user to store data within the DXM. The local registers are listed on the Local Registers › Local Registers in Use screen.

The bottom status bar displays the communications status, application status, and the DXM Configuration Software version.

In this short example, we will configure the DXM to read six registers on an external Modbus server device and save the data into the local registers.

The software only loads a file to the DXM. Internal parameter settings that are changed in the tool but not saved to the file will not be sent to the device.

**Modify Multiple Registers**

Modify a range of registers from the Local Registers › Local Registers in Use › Modify Multiple Registers screen.

Select which parameter fields to modify. Most parameters have three selections.
- Unchanged—no changes
- Default—change to default settings
- Set—modify the parameter. Other selections will appear based on the parameter.
Define an RTU Read Rule
Follow these steps to create a new read rule.

This example screen shows a read rule created to read six registers (address 1 through 6), from Modbus ID 4. The results are stored in the Local Registers 1 through 6.

1. From the **Register Mapping** › RTU › RTU Read screen, click **Add Read Rule**.
2. Click the arrow next to the name to display the parameters.
3. Name your rule.
4. Select the device ID.
5. Select how many registers to read, and the beginning register.
6. Define the register type, how often to read the register, and any other appropriate parameters.
7. If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.
Set the Time

Use the **Settings > System** screen to define the time zone and daylight saving option. The time zone and DST options are saved into the configuration file.

1. Go to the **Settings > System** screen.
2. If you connect the DXM to a computer, click **Sync PC Time with Device** to set the time on the DXM to match the time of the computer.
3. Set your time zone and select whether or not your device observes daylight saving time (DST).

Save and Upload the Configuration File

After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending the XML file to the device to avoid losing data. If you select **DXM > Send XML Configuration to DXM** before saving the configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the **File > Save As** menu.
2. Go to the **DXM > Send XML Configuration to DXM** menu.

**Status indicator bar**

- If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the cable and reconnect the DXM to the software.
- If the Application Status indicator is green, the file upload is complete.
- If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.

Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner product.

**THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING OR TRADE USAGE.**

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. **IN NO EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT,**
WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for personal protection applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change; Banner reserves the right to modify product specifications or update documentation at any time. Specifications and product information in English supersede that which is provided in any other language. For the most recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

Document title: DXM Controller Quick Start Guide
Part number: 191247
Revision: F
© Banner Engineering Corp. All rights reserved.
Chapter 3  ISM Radio Board (Slave ID 1)

Plug the ISM radio into the I/O base board with the U.FL antenna connector closest to the SMA connectors. Typically, users will not need to adjust the DIP switch settings on the physical radio modules.

For the DXM1200 models, set the radio options using the LCD menu.

**ISM radio board**

**Button Operation**
For DXM models without a LCD display, use the button to bind the ISM radio. For models with a LCD display, use the ISM menu to bind the radio.

**LED Operation**
The LED located on the ISM radio module indicates power and communications traffic. ISM board LED operations also display on the LED on the right side of the I/O base board.
- Solid green DX80 ISM radio LED indicates power.
- Flashing green MultiHop ISM radio LED indicates operation.
- Red and green combined: Communications traffic and binding.

**MultiHop Radio DIP Switches**

MultiHop ISM radio devices are defined with R2, R4, and R5 in the model number.
- DXMxxx-xxR2 - MultiHop 900 MHz
- DXMxxx-xxR4 - MultiHop 2.4 GHz
- DXMxxx-xxR5 - MultiHop 900 MHz, 100 mW
- DXMxxx-xxR9 - MultiHop 900 MHz, (Australia)

Making changes to the baud or parity settings requires that you make the same settings to the Modbus Client Communications section within the DXM Configuration Software (Settings > General).
Disabling the serial port disables the ISM radio in the DXM. Selecting Transparent mode causes radio communications to be slower and denies access to device I/O register data.

### DIP switch settings

<table>
<thead>
<tr>
<th>Device Settings</th>
<th>D1 Switches</th>
<th>D2 Switches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial line baud rate 19200 OR User defined receiver slots</td>
<td>OFF*</td>
<td>OFF*</td>
</tr>
<tr>
<td>Serial line baud rate 38400 OR 32 receiver slots</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>Serial line baud rate 9600 OR 128 receiver slots</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Serial line baud rate Custom OR 4 receiver slots</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>Parity: None</td>
<td>OFF*</td>
<td>OFF*</td>
</tr>
<tr>
<td>Parity: Even</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>Parity: Odd</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Disable serial (low power mode) and enable the receiver slots select for switches 1-2</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>Transmit power 900 MHz radios: 1.00 Watt (30 dBm)</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>2.4 GHz radios: 0.065 Watts (18 dBm) and 60 ms frame</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transmit power 900 MHz radios: 0.25 Watts (24 dBm)</td>
<td>OFF*</td>
<td></td>
</tr>
<tr>
<td>2.4 GHz radios: 0.065 Watts (18 dBm) and 40 ms frame</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application mode: Modbus</td>
<td>OFF*</td>
<td></td>
</tr>
<tr>
<td>Application mode: Transparent</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>MultiHop radio setting: Repeater</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>MultiHop radio setting: Client</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>MultiHop radio setting: Server</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>MultiHop radio setting: DXM LCD Menu Control</td>
<td>ON*</td>
<td>ON*</td>
</tr>
</tbody>
</table>

* Default configuration. The default settings for D2 DIP switches 1, 3, and 4 are ON. This allows for forcing the device into client mode and DXM menu control for the radio power settings.

### Application Mode

The MultiHop radio operates in either Modbus mode or transparent mode. Use the internal DIP switches to select the mode of operation. All MultiHop radios within a wireless network must be in the same mode.

**Modbus** mode uses the Modbus protocol for routing packets. In Modbus mode, a routing table is stored in each parent device to optimize the radio traffic. This allows for point-to-point communication in a multiple data radio network and acknowledgment/retry of radio packets. To access a radio’s I/O, the radios must be running in Modbus mode.

In **transparent** application mode, all incoming packets are stored, then broadcast to all connected data radios. The data communication is packet-based and not specific to any protocol. The application layer is responsible for data integrity. For one-to-one data radios it is possible to enable broadcast acknowledgment of the data packets to provide better throughput. In transparent mode, there is no access to the radio’s I/O.

### Baud Rate and Parity

The baud rate (bits per second) is the data transmission rate between the device and whatever it is physically wired to. Set the parity to match the parity of the device you are wired to.
Disable Serial
Disable an unused local serial connection to reduce the power consumption of a data radio powered from the solar assembly or from batteries. All radio communications remain operational.

Transmit Power Levels/Frame Size
The 900 MHz data radios can be operated at 1 watt (30 dBm) or 0.250 watt (24 dBm). For most models, the default transmit power is 1 watt.

For 2.4 GHz radios, the transmit power is fixed at 0.065 watt (18 dBm) and DIP switch 5 is used to set the frame timing. The default position (OFF) sets the frame timing to 60 milliseconds. To increase throughput, set the frame timing to 40 milliseconds. For battery-powered devices, increasing the throughput decreases battery life.

**IMPORTANT:** Prior to date code 15341 and radio firmware version 3.6, the frame timing was 40 ms (OFF) or 20 ms (ON).

DIP Switch Settings for the Performance Gateway Radio Module
The 900 MHz radios transmit at 1 Watt (30 dBm) or 250 mW (24 dBm). The 250 mW mode reduces the radio's range but improves the battery life in short range applications. For 2.4 GHz models, this DIP switch is disabled. The transmit power for 2.4 GHz is fixed at about 65 mW EIRP (18 dBm).

DX80 Performance Gateway ISM radio devices are defined with R1, R3, and R8 in the model number.
- DXMxxx-xxR1 - DX80 Performance 900MHz
- DXMxxx-xxR3 - DX80 Performance 2.4GHz
- DXMxxx-xxR8 - DX80 Performance 900MHz (Australia)

**IMPORTANT:** To adjust the transmit power on the Gateway radio, Banner recommends using the LCD menu (System Conf › ISM Radio › RF CNTRL).

---

**DIP switch bank 1 and bank 2**

**DIP switch settings for bank 1**

<table>
<thead>
<tr>
<th>DIP Switch 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>1 Watt (30 dBm, 900 MHz models only) (default configuration)</td>
</tr>
<tr>
<td>ON</td>
<td>250 mW (24 dBm, 900 MHz models only), DX80 compatibility mode</td>
</tr>
</tbody>
</table>
Chapter 4  Processor Boards

Processor Board for the DXM1x0 Models

Processor board for the DXM

Processor board features

<table>
<thead>
<tr>
<th>Cellout</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Cellular modem connec-</td>
<td>Install the cellular modem onto the processor board with the cellular mode-</td>
</tr>
<tr>
<td></td>
<td>tion</td>
<td>m's U.FL connector on the left. The antenna cable will go between the cel-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>lar U.FL connector and the left I/O base board U.FL connector. Always dis-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>connect the power to the device before installing or removing a cellular</td>
</tr>
<tr>
<td>B</td>
<td>Button</td>
<td>Use the processor board button to force a cloud push. To force a push to</td>
</tr>
<tr>
<td>C</td>
<td>Boot load jumpers</td>
<td>the cloud, press and hold this button for five (5) seconds to send an im-</td>
</tr>
<tr>
<td>D</td>
<td>DIP switches</td>
<td>medi ate push message from the device (if properly configured).</td>
</tr>
<tr>
<td>E</td>
<td>Micro SD card</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>LED 1</td>
<td>Heartbeat, indicates the processor is running</td>
</tr>
<tr>
<td>G</td>
<td>LED 2</td>
<td>Indicates the cellular modem power cutoff is active; if the incoming pow-</td>
</tr>
</tbody>
</table>

Continued on page 28
Continued from page 27

<table>
<thead>
<tr>
<th>Callout</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>LED 3</td>
<td>XML configuration file was rejected; or file load in process; or the second phase of boot loading is in process (flashing)</td>
</tr>
<tr>
<td>I</td>
<td>LED 4</td>
<td>ScriptBasic program failed to load; or the beginning phase of boot loading is in process (flashing = in process, on = complete)</td>
</tr>
</tbody>
</table>

### DIP Switch Settings for the Processor Board

After making changes to the DIP switch settings, cycle power to the device.

#### DIP switches for the DXM processor board

<table>
<thead>
<tr>
<th>Settings</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Ethernet Port</td>
<td>OFF *</td>
<td></td>
<td>OFF *</td>
<td>ON</td>
</tr>
<tr>
<td>Disable LCD Display</td>
<td></td>
<td>OFF *</td>
<td></td>
<td>ON</td>
</tr>
<tr>
<td>Not used</td>
<td></td>
<td></td>
<td>OFF *</td>
<td></td>
</tr>
<tr>
<td>Bypass XML</td>
<td>OFF *</td>
<td></td>
<td></td>
<td>ON</td>
</tr>
</tbody>
</table>

**Bypass XML**

- Turn on to have the XML file ignored at boot time. This is useful for ignoring a corrupt or questionable XML configuration file. After the device is running, a new XML file can be loaded using the DXM configuration tool.
- Turn on to stop the processor from executing defined configuration. This is useful if the loaded configuration is using all the processing time and not allowing DXM Configuration Tool operations.
  - The factory default position is OFF.

**Disable Ethernet Port**

- Set to on to power down the Ethernet interface. Disabling the unused Ethernet port reduces power consumption.
  - The factory default position is OFF.

**Disable LCD Display**

- Set to on to disable the LCD. This DIP switch should be on when the LCD display board is not connected.
  - The factory default position is OFF.

### Ethernet

Before applying power to the DXM, verify the Ethernet cable is connected.

The number of times the processor attempts to connect to the Ethernet network is configured in the DXM Configuration Software (Settings > Network Ethernet Connection Acquisition). The default setting is two retries one minute after the device boots up another retry two minutes later.

The Ethernet connection supports the DXM Configuration Software, Modbus/TCP, and EtherNet/IP. ScriptBasic also has access to Ethernet for custom programming. Use the software or LCD menu system to configure the characteristics of the Ethernet connection, including the IP address. Any parameters not changeable from the menu system are configurable from the configuration software.

Ethernet parameter changes entered through the LCD menu override the XML configuration parameters. To return to using the network settings in the XML configuration file, remove the Ethernet parameters defined by the LCD menu using the System Config > Ethernet > Reset menu.

### USB

The USB port is used with the DXM Configuration Software to program the DXM Controller. The USB port is also used as the console output for the processor and ScriptBasic.
Turn on debug messages to the serial console by selecting **Print push debug messages to serial console** in the DXM Configuration Software **Settings › Cloud Services** screen.
Chapter 5  IO Base Boards

Board Connections for the DXM150-B1 and DXM1500-B1

**DXM150-B1 and DXM1500-B1 Board Connections**

**DXM150-B1 and DXM1500-B1 pins**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC</td>
</tr>
<tr>
<td>2</td>
<td>12 to 30 V DC or solar power in (+)</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>Battery in (&lt; 15 V DC) (must be a sealed lead acid battery)</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>17</td>
<td>Isolated discrete input 2B</td>
</tr>
<tr>
<td>18</td>
<td>Ground</td>
</tr>
<tr>
<td>19</td>
<td>Output 1 Normally Open</td>
</tr>
<tr>
<td>20</td>
<td>Output 1 Common</td>
</tr>
<tr>
<td>21</td>
<td>Output 1 Normally Closed</td>
</tr>
<tr>
<td>24</td>
<td>Ground</td>
</tr>
<tr>
<td>25</td>
<td>Analog Output 1 (0–20 mA or 0–10 V)</td>
</tr>
<tr>
<td>33</td>
<td>PWR Out 2 - E Jumper Selectable</td>
</tr>
<tr>
<td>34</td>
<td>Ground</td>
</tr>
<tr>
<td>35</td>
<td>Universal Input 8</td>
</tr>
</tbody>
</table>

Continued on page 32
Continued from page 31

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>No.</th>
<th>Description</th>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Primary RS-485 –</td>
<td>22</td>
<td>Output 3 Normally Open</td>
<td>38</td>
<td>Universal Input 7</td>
</tr>
<tr>
<td>7</td>
<td>Primary RS-485 +</td>
<td>23</td>
<td>Output 3 Common</td>
<td>39</td>
<td>Universal Input 6</td>
</tr>
<tr>
<td>8</td>
<td>Ground</td>
<td>24</td>
<td>Output 3 Normally Closed</td>
<td>40</td>
<td>Universal Input 5</td>
</tr>
<tr>
<td>9</td>
<td>RS-232 Tx / CAN *</td>
<td>25</td>
<td>NMOS Output 5</td>
<td>41</td>
<td>Ground</td>
</tr>
<tr>
<td>10</td>
<td>RS-232 Rx / CAN *</td>
<td>26</td>
<td>No connection</td>
<td>42</td>
<td>Universal Input 4</td>
</tr>
<tr>
<td>11</td>
<td>Secondary RS-485 – or RS-232 RXRDY</td>
<td>27</td>
<td>NMOS Output 6</td>
<td>43</td>
<td>Universal Input 3</td>
</tr>
<tr>
<td>12</td>
<td>Secondary RS-485 + or RS-232 TXRDY</td>
<td>28</td>
<td>NMOS Output 7</td>
<td>44</td>
<td>Ground</td>
</tr>
<tr>
<td>13</td>
<td>Ground</td>
<td>29</td>
<td>No connection</td>
<td>45</td>
<td>PWR Out 1 - E Jumper Selectable</td>
</tr>
<tr>
<td>14</td>
<td>Isolated discrete input 1A</td>
<td>30</td>
<td>NMOS Output 8</td>
<td>46</td>
<td>Universal Input 2</td>
</tr>
<tr>
<td>15</td>
<td>Isolated discrete input 1B</td>
<td>31</td>
<td>Ground</td>
<td>47</td>
<td>Universal Input 1</td>
</tr>
<tr>
<td>16</td>
<td>Isolated discrete input 2A</td>
<td>32</td>
<td>Analog Output 2 (0–20 mA or 0–10 V)</td>
<td>48</td>
<td>Ground</td>
</tr>
</tbody>
</table>

**DXM150-B1 and DXM1500-B1 I/O base board components**

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>No.</th>
<th>Description</th>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Base board LED</td>
<td>E</td>
<td>PWR Out jumpers</td>
<td>G3</td>
<td>Analog output characteristics jumpers (jumper 1 sets analog out 1, jumper 2 sets analog out 2)</td>
</tr>
<tr>
<td>B</td>
<td>Cellular or secondary antenna</td>
<td>F</td>
<td>Radio binding button</td>
<td>H</td>
<td>ISM radio connection</td>
</tr>
<tr>
<td>C</td>
<td>Radio LED</td>
<td>G1</td>
<td>RS-485/RXRDY, pin 11, 12 selection jumper</td>
<td>J</td>
<td>Modbus ID DIP switches</td>
</tr>
<tr>
<td>D</td>
<td>Radio module antenna</td>
<td>G2</td>
<td>RS-232/CAN*, pin 9, 10 selection jumper</td>
<td>K</td>
<td>Rotary dials</td>
</tr>
</tbody>
</table>

* Controller Area Network (CAN) only available with DXM150 models.
### Board Connections for the DXM150-B2 and DXM1500-B2

#### DXM150-B2 and DXM1500-B2 board connections

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC</td>
<td>17  Isolated discrete input 2B</td>
</tr>
<tr>
<td>2</td>
<td>12 to 30 V DC or solar power in (+)</td>
<td>18  Ground</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
<td>19  Output 1 PNP/NPN</td>
</tr>
<tr>
<td>4</td>
<td>Battery in (&lt; 15 V dc) (must be a sealed lead acid battery)</td>
<td>20  Output 2 PNP/NPN</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>21  Output 3 PNP/NPN</td>
</tr>
<tr>
<td>6</td>
<td>Primary RS-485 –</td>
<td>22  Output 4 PNP/NPN</td>
</tr>
<tr>
<td>7</td>
<td>Primary RS-485 +</td>
<td>23  PWR Out OR</td>
</tr>
<tr>
<td>8</td>
<td>Ground</td>
<td>24  Ground</td>
</tr>
<tr>
<td>9</td>
<td>RS-232 Tx / CAN *</td>
<td>25  Ground</td>
</tr>
<tr>
<td>10</td>
<td>RS-232 Rx / CAN *</td>
<td>26  PWR OUT OR</td>
</tr>
<tr>
<td>11</td>
<td>Secondary RS-485 – or RS-232 RXRDY</td>
<td>27  Output 8 PNP/NPN</td>
</tr>
<tr>
<td>12</td>
<td>Secondary RS-485 + or RS-232 TXRDY</td>
<td>28  Output 7 PNP/NPN</td>
</tr>
<tr>
<td>13</td>
<td>Ground</td>
<td>29  Output 6 PNP/NPN</td>
</tr>
<tr>
<td>14</td>
<td>Isolated discrete input 1A</td>
<td>30  Output 5 PNP/NPN</td>
</tr>
<tr>
<td>15</td>
<td>Isolated discrete input 1B</td>
<td>31  Ground</td>
</tr>
<tr>
<td>16</td>
<td>Isolated discrete input 2A</td>
<td>32  Analog Output 2 (0–20 mA or 0–10 V)</td>
</tr>
</tbody>
</table>
**DXM150-B2 and DXM1500-B2 I/O base board components**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Location</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Base board LED</td>
<td>E</td>
<td>PWR Out jumpers</td>
</tr>
<tr>
<td>B</td>
<td>Cellular or secondary antenna</td>
<td>F</td>
<td>Radio binding button</td>
</tr>
<tr>
<td>C</td>
<td>Radio LED</td>
<td>G1</td>
<td>RS-485/RXRDY, pin 11, 12 selection jumper</td>
</tr>
<tr>
<td>D</td>
<td>Radio module antenna</td>
<td>G2</td>
<td>RS-232/CAN*, pin 9, 10 selection jumper</td>
</tr>
</tbody>
</table>

* Controller Area Network (CAN) only available with DXM150 models.

### DIP Switches for the IO Board

The DXM Controller I/O board DIP switches are set from the factory to Modbus ID 200.

### Setting the Modbus ID on the I/O Base Board

Only DXM150-Sx and SxR2 Modbus Server models require that the Modbus ID to be adjusted on the I/O base board. The DXMs use DIP switch J and rotary dial K to set the Modbus ID. The device can use a Modbus register 6804 in the I/O board to access the full range of Modbus IDs.

DIP Switch location J defines the course group of Modbus IDs. DIP Switch 4 must be set to ON for DXM1.xx-Sx and DXM1.xx-SxR2 models. Use rotary dial K to select the lower digit of the Modbus ID.

#### Location J DIP Switches

<table>
<thead>
<tr>
<th>Settings</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus ID set to 11 through 19</td>
<td>OFF</td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus ID set to 20 through 29</td>
<td>ON</td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus ID set to 30 through 39</td>
<td>OFF</td>
<td>ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus ID set to 40 through 49</td>
<td>ON</td>
<td>ON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not Used</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modbus Server Configuration (S1 model only)</td>
<td></td>
<td></td>
<td></td>
<td>ON</td>
</tr>
<tr>
<td>I2C Processor Communication</td>
<td></td>
<td></td>
<td></td>
<td>OFF</td>
</tr>
</tbody>
</table>

Use rotary dial location K and DIP switch location J to set the Modbus IDs.

#### Location K Rotary Dials — Position 0 through 9

<table>
<thead>
<tr>
<th>DIP Switches J</th>
<th>Location K Rotary Dials — Position 0 through 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1   2  0  1  2  3  4  5  6  7  8  9</td>
<td>1   2  0  1  2  3  4  5  6  7  8  9</td>
</tr>
<tr>
<td>OFF  OFF x (2)   11  12  13  14  15  16  17  18  19</td>
<td>OFF  OFF   20  21  22  23  24  25  26  27  28  29</td>
</tr>
<tr>
<td>ON   OFF  30  31  32  33  34  35  36  37  38  39</td>
<td>ON   ON  40  41  42  43  44  45  46  47  48  49</td>
</tr>
</tbody>
</table>

(1) Must be in the ON position for the -S1 model
(2) Uses value in Modbus register 6804.
Example to Set the DXM Modbus ID using DIP Switches
To set the DXM to a Modbus ID of 25, set the following:
   Location J DIP switches set to: 1= ON, 2=OFF
   Rotary dial set to 5

The DIP switch sets the upper digit of the server ID to 2 while the rotary dial sets the lower digit to 5.

Example to Set the DXM I/O Board Modbus ID using Modbus Registers
Write to the I/O board’s Modbus register 6804 to set the Modbus ID to any valid Modbus ID (1 through 245).
   • Rotary dial K should be in the zero position to use the Modbus register server ID.

I/O Board Jumpers
Hardware jumpers on the DXM I/O board allow the user to select alternative pin operations. Turn the power off to the device before changing jumper positions.

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Function</th>
<th>Positions</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Courtesy power output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Courtesy power outputs provide continuous power and cannot be turned on or off. Jumper 2 is the power jumper for pin 45. Jumper 1 is the power jumper for pin 35.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pin 45 jumper selects 2.7 V when in the &quot;a&quot; position and 12 V battery in the &quot;b&quot; position.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pin 35 jumper selects 4.2 V when in the &quot;a&quot; position and device power on pin 2 in the &quot;b&quot; position.</td>
<td></td>
</tr>
<tr>
<td>G1</td>
<td>RS-485 Modbus Serve or RS-232 Flow Control</td>
<td>Defines the operation of pins 11 and 12. Set the jumpers to use pins 11 and 12 as a secondary Modbus RS-485 server port or flow control pins for the RS-232 port. Both jumpers must be set to the same operation, RS-485 Modbus Server or Flow control. The default setting is RS-485.</td>
</tr>
<tr>
<td>G2</td>
<td>Generic RS-232 Serial Port or CAN Serial Port</td>
<td>Defines the operation of pins 9 and 10. Set the jumpers to use pins 9 and 10 as a CAN serial port or a generic RS-232 serial port. Both jumpers must be set to the same operation, CAN or RS232. The default setting is CAN serial port. Controller Area Network (CAN) is only available with DXM150 models.</td>
</tr>
<tr>
<td>G3</td>
<td>Analog output characteristics for AO2 (pin 32) and AO1 (pin 33)</td>
<td>Defines current (0–20 mA) or voltage (0–10 V) for analog output 1 and 2. By default, current (0–20 mA) is selected using jumpers 1 and 2 and registers 4008 and 4028 contain a value of 2.</td>
</tr>
<tr>
<td></td>
<td>To select voltage (0–10 V) for output Aout1, set jumper 1 in the voltage position (V) and set Modbus register 4008 on the I/O board (SID 200) to 3.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To select voltage (0–10 V) for output Aout2, set jumper 2 in the voltage position (V) and set Modbus register 4028 on the I/O board (SID 200) to 3.</td>
<td></td>
</tr>
</tbody>
</table>

Applying Power to the B1 Models
Apply power using either 12 to 30 V DC or a 12 V DC solar panel and 12 V sealed lead acid battery.

Power pins for the B1 models

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 1</td>
<td>No connection</td>
</tr>
</tbody>
</table>

Continued on page 36
Continued from page 35

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 2</td>
<td>12 to 30 V DC input (+) or solar panel connection (+)</td>
</tr>
<tr>
<td>Pins 3, 5, 8, 13, 18, 34, 36, 41, 44, 48</td>
<td>Main logic ground for the DXM</td>
</tr>
<tr>
<td>Pin 4</td>
<td>Solar or backup battery positive input. Battery voltage must be less than 15 V DC. Use only a sealed lead acid (SLA) battery.</td>
</tr>
</tbody>
</table>

Applying Power to the B2 or S2 Models

Apply power using either 12 to 30 V DC or a 12 V DC solar panel and 12 V sealed lead acid battery.

Power pins for the B2 and S2 models

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 1</td>
<td>No connection</td>
</tr>
<tr>
<td>Pin 2</td>
<td>12 to 30 V DC input (+) or solar panel connection (+)</td>
</tr>
<tr>
<td>Pins 3, 5, 8, 13, 18, 34, 36, 41, 44, 48</td>
<td>Main logic ground for the DXM</td>
</tr>
<tr>
<td>Pin 4</td>
<td>Solar or backup battery positive input. Battery voltage must be less than 15 V DC. Use only a sealed lead acid (SLA) battery.</td>
</tr>
<tr>
<td>Pin 23, 26, 35, and 45</td>
<td>Courtesy power output, configuration based on jumper block E (see &quot;I/O Board Jumpers&quot; on page 35)</td>
</tr>
</tbody>
</table>

Connecting a Battery

When attaching a battery to the DXM as a backup battery or as a solar battery, verify the charging algorithm is set properly. The factory default setting for the battery charging algorithm assumes you are using 12 to 30 V DC to recharge the battery.

The charging algorithm is designed to work only with a sealed lead acid (SLA) battery.

- When using 12 to 30 V DC, connect the 12 to 30 V DC + to pin 2 and connect the ground to pin 3.
- When using main dc power with a backup battery (default configuration), connect the incoming main power pin 2 (+) and to pin 3 (-). Connect the 12 V sealed lead acid battery to pin 4 (+) and pin 5 (-). The incoming main power must be 15 to 30 V DC to charge the battery.

Supplying Power from a Solar Panel

To power the DXM Controller from a 12 V DC solar panel, connect the solar panel to power pins 2(+) and 3(-). Connect a 12 V DC sealed lead acid (SLA) rechargeable battery to pins 4(+) and 5(-).

The factory default setting for the battery charging configuration assumes you are using 12 to 30 V DC power to recharge the battery. If the incoming power is from a solar panel, you must change the charging configuration.

The battery charging configuration defaults to a battery backup configuration. To change the charging configuration from the menu system:

1. From the DXM LCD menu, navigate to **System Config > I/O Board > Charger**.
2. Select **Solar** for solar panel configurations or **DC** for battery backup configurations.

To change the charging configuration by writing to Modbus register 6071 on the I/O base board (ID 200):

1. Write a 0 to select the solar power charging configuration.

Connecting the Communication Pins

The base board communications connections to the device are RS-485 (primary), RS-485 (secondary) or RS-232.
**RS-485**—The primary RS-485 bus is a common bus shared with the radio board (Modbus ID 1). The DXM is defined as the Modbus Client on this bus. Other internal Modbus servers include the local processor registers (Modbus ID 199), the base I/O controller (Modbus ID 200), and the display board (Modbus ID 201). When assigning Modbus Server IDs to externally connected devices, only use IDs 2 through 198.

**RS-232**—The RS-232 bus is not currently defined.

### Communication pins

<table>
<thead>
<tr>
<th>Pin</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 6</td>
<td>Primary RS-485 –</td>
<td>Use this bus to connect to other Modbus Server devices. The DXM is a Modbus Client device on this RS-485 port. The Modbus protocol baud rate is user configurable but is set to 19.2k by default.</td>
</tr>
<tr>
<td>Pin 7</td>
<td>Primary RS-485 +</td>
<td></td>
</tr>
<tr>
<td>Pin 9</td>
<td>RS-232 Tx</td>
<td>Serial RS-232 connection. This bus must use a ground connection between devices to operate correctly.</td>
</tr>
<tr>
<td>Pin 10</td>
<td>RS-232 Rx</td>
<td></td>
</tr>
</tbody>
</table>
| Pin 12| Secondary RS-485 + or RS-232 TXRDY | • In position “a” these pins are a secondary RS-485 bus. The DXM is a Modbus server on this bus.  
• In position “b” these pins are the flow control signals for the RS-232 signal on pins 9 and 10. |

### Modbus RTU Master and Slave Ports

The DXM can be a Modbus RTU client device to other server devices and can be a Modbus server device to another Modbus RTU client. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU client to control external server devices. All wired devices connected to the client RS-485 port must be server devices.

- As a Modbus RTU client device, the DXM controls the external server connected to the primary RS-485 port, the local ISM radio, the local I/O base board, and the local display board.
- As a Modbus RTU server device, the DXM local registers can be read from or written to by another Modbus RTU client device.

The secondary port (S+/S-) is the Modbus RTU server connection. The secondary (server) Modbus RS-485 port (S+/S-) is controlled by another Modbus client device, not the DXM. The server port is used by an external Modbus client device that will access the DXM as a Modbus server device.

Use the configuration software to define operational settings for both the Modbus RTU client port and the Modbus RTU server port.

Use the DXM’s LCD menu to set the Modbus ID for the secondary RS-485 port.
Set the Client and Server Port Parameters
The basic communications parameters for the RS-485 ports are set in the DXM Configuration Software and are saved in the XML configuration file.

**Settings > General screen**

1. In the DXM Configuration Software, go to the **Settings > General** screen.
2. To set the parameters for the Modbus Client, change the settings in the **Client Port Settings M+/M-** section.
3. To set the parameters for the Modbus Servers, change the settings in the **Server Port Settings S+/S-** section.

**Baud Rate**
Defined for both the Modbus client and server
Settings include: 19200 (default), 1200, 2400, 9600, 38400, 57600, and 115200.

**Delay between messages**
Applies to the Modbus client port
Sets the minimum wait time from the end of a Modbus transaction to the beginning of the next Modbus transaction.

**Parity**
Defined for both the Modbus client and server
Settings include: None (default), odd, even, space, and mark

**Timeout**
Applies to the Modbus client port
Covers the expected time for messages to be sent throughout the wireless network. For the DXM, the **Timeout** parameter is the maximum amount of time the DXM should wait after a request is sent until the response message is received from the Modbus server device.

**Wireless Modbus Backbone**
Applies to the Modbus server port
Define when there is an ISM radio plugged into the processor board. When this is done, the Modbus server port uses the MultiHop radio as the server port instead of the terminal block connection on the I/O base board. Settings include: None (default), Modbus, or Ethernet

Set the DXM Modbus Server Port ID
Set the DXM Modbus server port ID using the LCD menu system.

1. On the LCD, use the down arrow to highlight **System Config** and click the **Enter** button.
2. Highlight **DXM Modbus ID** and click **Enter**.
3. Use the up and down arrow buttons to change the DXM Modbus Server Port ID.
4. Press **Enter** to accept the ID change.
5. Use the configuration software to cycle power to the device.

After cycling power to the device, the updated DXM Modbus ID is listed under the **System Config** menu.

**Inputs and Outputs**
The I/O base board is a Modbus server device (ID 200) that communicates to the processor board using Modbus commands. Use the DXM Configuration Software to create a configuration using read/write maps that will access inputs or outputs on the I/O board.
Communication with the I/O board runs at a maximum rate of 10 ms per transaction. The parameter setting for the bus with the I/O board and the processor board are fixed. External Modbus communication runs at a maximum rate of 50 ms per transaction. The parameter settings for the external RS-485 buses are controlled by the DXM Configuration Software.

Refer to "Modbus Register Summary" on page 72 for more descriptions of each Modbus register on the DXM Controller.

Universal Inputs

The universal inputs can be programmed to accept different types of inputs: discrete NPN/PNP, 0 to 20 mA analog, 0 to 10 V analog, 10k thermistor, potentiometer sense, bridge, and NPN raw fast. Use the DXM Configuration Software tool to write to the appropriate Modbus registers in the I/O board to configure the input type.

The universal inputs are treated as analog inputs. When the universal inputs are defined as mA, V, or temperature, use Modbus registers to configure the operational characteristics of the inputs. These parameters are temperature conversion type, enable full scale, threshold and hysteresis. See "Modbus Register Summary" on page 72 for the parameter definitions.

When a universal input is configured as an NPN or PNP input type, it can be enabled to be a synchronous counter. Enable the counter function by setting Modbus register ‘Enable Rising’ or ‘Enable Falling’ to 1. See "Modbus Register Summary" on page 72 for the universal input register definitions.

Universal input pins

<table>
<thead>
<tr>
<th>Pin</th>
<th>Univ. Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
<td>Universal Input 1</td>
<td>Program the universal inputs to accept input types NPN, PNP, 10k thermistor, 0 to 20 mA, or potentiometer. The default setting is 8: NPN raw fast. To set the input type, write the following values to the Input Type Modbus registers.</td>
</tr>
<tr>
<td>46</td>
<td>Universal Input 2</td>
<td>0 = NPN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = PNP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = 0 to 20 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = 0 to 10 V DC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = 10k Thermistor</td>
</tr>
<tr>
<td>43</td>
<td>Universal Input 3</td>
<td>5 = Potentiometer Sense (DXM150 only)</td>
</tr>
<tr>
<td>42</td>
<td>Universal Input 4</td>
<td>6 = Not used</td>
</tr>
<tr>
<td>40</td>
<td>Universal Input 5</td>
<td>7 = Bridge</td>
</tr>
<tr>
<td>39</td>
<td>Universal Input 6</td>
<td>8 = NPN Raw Fast (default)</td>
</tr>
<tr>
<td>38</td>
<td>Universal Input 7</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Universal Input 8</td>
<td></td>
</tr>
</tbody>
</table>

Bridge Input

The bridge input is not implemented yet.

NPN vs NPN Raw Fast

The difference between NPN and NPN Raw Fast is the amount of settling time given to the input. Switch the input type to NPN if the input is not detecting a transition.

Potentiometer Sense (DXM150 only)

A potentiometer input is created from two inputs: a voltage source (pin 45) that supplies a voltage to the potentiometer and an input sense (Potentiometer Sense) to read the resistance. See Using Universal Inputs to Read a Potentiometer (p/n b_4462775) for more information.

Thermistor Input

A thermistor input must use a 10k thermistor between ground and the universal input. The thermax must be a 10k NTC (Banner model number BWA-THERMISTOR-002) or equivalent. Select the temperature conversion of degrees C (default) or degrees F by writing to the Modbus registers defined in Key definition for *(keyrefName)* not found in the DITA map.

Example: Configure Input 1 as a Synchronous Counter

1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.
3. Connect to the DXM by selecting the Device > Connection Settings menu option. You may connect using either USB or Ethernet.
4. Select a COMM port from the drop-down list and click Connect.
5. Click on the Register View tab on the left part of the page.
6. Change the Source Register selection to I/O Board Registers.
7. In the Write Registers area, write Modbus register 4908 to 1 to enable counting on the rising edge of the input signal.
8. Read Modbus registers 4910 and 4911 to get the 32-bit value of the count.
Example: Change Universal Input 2 to a 0 to 10 V DC Input

1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.
3. Connect to the DXM by selecting the Device > Connection Settings menu option. You may connect using either USB or Ethernet.
4. Select a COMM port from the drop-down list and click Connect.
5. Click on the Register View tab on the left part of the page.
6. Change the Source Register selection to I/O Board Registers.
7. Write a 3 to Modbus register 3326 on Modbus ID 200 (I/O board).
8. Cycle power to the device.
9. Using the Register View tab, read register 3326 to verify it is set to 3.

Example: Change Analog Output 1 to a 0 to 10 V DC Output

1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.
3. Connect to the DXM by selecting the Device > Connection Settings menu option. You may connect using either USB or Ethernet.
4. Select a COMM port from the drop-down list and click Connect.
5. Click on the Register View tab on the left part of the page.
6. Change the Source Register selection to I/O Board Registers.
7. Set jumper 1 on the I/O base board to the 0 to 10 V position. Refer to the base board image for the analog output jumper position.
8. Write a 3 to Modbus register 4008 on Modbus ID 200 (I/O board).
9. Cycle power to the device.
10. Using the Register View tab, read register 4008 to verify it is set to 3.

Example: Change Universal Input 8 to Read a Potentiometer Input

1. Launch the DXM Configuration Software tool.
2. Click on the Register View tab on the left part of the page.
3. In the upper right part of the window select Modbus Registers using Modbus ID radio button and enter Modbus ID 200.
4. To set universal input 8 as the sense, write Modbus register 3446 with 5 (Potentiometer Sense).
5. Verify the jumpers are still set to their default position. One jumper should be on pins 1 and 3 to get a 2.7 V source voltage out pin 45. The default position of the other jumper is on pins 4 and 6.
6. Connect one potentiometer side to power output (pin 45), connect the tap point of the pot to universal input 8 (pin 37), and connect the other end of the pot to ground (pin 36).

Isolated Discrete Inputs

The DXM has two (2) optically isolated inputs. The inputs signals are electrically isolated forming a barrier to protect the DXM from different ground potentials of the input signals.

Input 1 uses terminals 1A and 1B and the second input uses 2A and 2B. An input voltage should be applied between the terminals between 0 and 30 V DC, the on/off transition threshold is approximately 2.6 V.
**Isolated discrete input pins**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Modbus Register</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 14</td>
<td>501</td>
<td>Input 1A</td>
<td>Optically isolated AC input type, 0 to 12 to 30 V DC</td>
</tr>
<tr>
<td>Pin 15</td>
<td></td>
<td>Input 1B</td>
<td>Input to output isolation of 2.5 kV</td>
</tr>
<tr>
<td>Pin 16</td>
<td>503</td>
<td>Input 2A</td>
<td></td>
</tr>
<tr>
<td>Pin 17</td>
<td></td>
<td>Input 2B</td>
<td></td>
</tr>
</tbody>
</table>

**Synchronous Counters**—An isolated input can be programmed to count the input signal transitions. When an input is enabled as a counter, the counter value is stored into two 16-bit Modbus registers for a total count of 32-bits (unsigned). To program an input to capture the edge transition counts, follow "Example: Configure Input 1 as a Synchronous Counter " on page 39.

The counters are synchronous because the inputs are sampled at a 10 ms clock rate. The input logic does not detect rising or falling edges, it samples the input every 10 ms to find level changes. The input signals must be high or low for more than 10 ms or the input will not detect transitions. Because most signals are not perfect, a realistic limit for the synchronous counter would be 30 to 40 Hz.

Universal inputs can also be configured as a synchronous counter. See "Modbus Register Summary " on page 72 for all the register definitions. The procedure for creating a synchronous counter is the same as a isolated input with the addition of changing the input type to PNP or NPN.

**Relay Outputs for the DXM150-B1, 1500-B1, and 150-S1**

**Relay output pins**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Output</th>
<th>Description</th>
<th>Wiring</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 19</td>
<td>Output 1: Normally Open</td>
<td>SPDT (Form C) relay, 250 V AC, 16 A</td>
<td></td>
</tr>
<tr>
<td>Pin 20</td>
<td>Output 1: Common</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pin 21</td>
<td>Output 1: Normally Closed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pin 22</td>
<td>Output 3: Normally Open</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pin 23</td>
<td>Output 3: Common</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pin 24</td>
<td>Output 3: Normally Closed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NMOS Outputs**

**Pins for the NMOS outputs for the DXM150-B1, DXM1500-B1, and DXM150-S1 models**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Modbus Register</th>
<th>Output</th>
<th>Description</th>
<th>Wiring</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 25</td>
<td>505</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pin 27</td>
<td>506</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pin 28</td>
<td>507</td>
<td>NMOS Discrete Outputs</td>
<td>Less than 1 A maximum current at 30 V DC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON-State Saturation: Less than 0.7 V at 20 mA</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ON Condition: Less than 0.7 V</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF Condition: Open</td>
<td></td>
</tr>
<tr>
<td>Pin 30</td>
<td>508</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The DXM150-B2, DXM1500-B2, and DXM150-S2 models do not have NMOS outputs.

PNP and NPN Outputs for the B2 and S2 Models

<table>
<thead>
<tr>
<th>Pin</th>
<th>Output</th>
<th>Modbus Register</th>
<th>Description</th>
<th>PNP OUT Wiring</th>
<th>NPN OUT Wiring</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>1</td>
<td>501</td>
<td>PNP/NPN Output 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>2</td>
<td>502</td>
<td>PNP/NPN Output 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>3</td>
<td>503</td>
<td>PNP/NPN Output 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>4</td>
<td>504</td>
<td>PNP/NPN Output 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>5</td>
<td>505</td>
<td>PNP/NPN Output 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>6</td>
<td>506</td>
<td>PNP/NPN Output 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>7</td>
<td>507</td>
<td>PNP/NPN Output 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>8</td>
<td>508</td>
<td>PNP/NPN Output 8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The DXM150-B1, DXM1500-B1, and DXM150-S1 models do not have PNP/NPN outputs.

Analog Outputs (DAC)
The following characteristics are configurable for each of the analog outputs.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>Analog 1</td>
<td>0 to 20 mA or 0 to 10 V DC output (selectable using the Analog Output Characteristics Jumpers) Accuracy: 0.1% of full scale +0.01% per °C Resolution: 12-bit</td>
</tr>
<tr>
<td>32</td>
<td>Analog 2</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 6  Cellular Modem Boards

Cellular Modem Board
The LTE-M (United States) or LTE-M/NB-IoT (outside the United States) cellular modem is an optional accessory that is installed on the processor board on the two 12-pin sockets.

A - U.FL antenna connection
The U.FL connector should be to the left, with the antenna cable going to the left antenna U.FL connector. The SIM card slides into the socket on the back of this board.

Cellular Power Requirements
If the incoming voltage drops below 11.2 V DC, the cellular modem does not turn on and will not turn on until the voltage is above 11.8 V DC. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage. If cellular operation stops because of voltage, it is logged in this file.
Using the DXM Cellular Modem
The DXM cellular modem provides a remote network connectivity solution for the DXM.

To use the cellular modem:
1. Verify the cellular modem is installed and the correct antenna is connected to the cellular antenna port.
2. Activate the cellular service.
3. Configure the DXM to use the cellular network as the network interface.

Activating a Cellular Modem
Follow these basic steps, as detailed in this document, to activate the cellular capabilities of your DXM Controller.

1. Purchase a cellular modem kit from Banner Engineering Corp.
2. Install the cellular modem, connect the antenna cable, and connect the cellular antenna.
3. Activate a cellular plan to the SIM card, then insert the SIM card into the cellular modem.
4. Configure the DXM to use the cellular modem.

Purchase one of these cellular modem kit models

<table>
<thead>
<tr>
<th>Cellular Kit Model</th>
<th>Kit Description</th>
<th>Important Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SXI-CATM1VZW-001</td>
<td>Verizon CAT M1 cellular modem using Telit ME910 modem kit (Verizon part number SXI-M1V). Includes a cellular modem, SIM card, internal adhesive antenna, external SMA antenna, and antenna cable. The SIM card is specific to the LTE-M technology and cannot be used in other cellular modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International Mobile Equipment Identity) number. Cellular plans can be purchased through celldata.bannercds.com.</td>
<td>This cellular modem kit is for use in applications that require monthly data usage approaching 50 MB or 250 MB with push intervals no more frequent than every 10 minutes. This modem is only for use in the contiguous United States region. Please visit our support site for more details on coverage areas and cellular plan pricing.</td>
</tr>
<tr>
<td>SXI-CATM1ATT-001</td>
<td>AT&amp;T CAT M1 cellular modem using Telit ME910 modem kit (AT&amp;T part number SXI-M1A). Includes a cellular modem, SIM card, internal adhesive antenna, external SMA antenna, and antenna cable. The SIM card is specific to the LTE-M technology and cannot be used in other cellular modems. Requires a LTE AT&amp;T cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International Mobile Equipment Identity) number. Cellular plans can be purchased through celldata.bannercds.com.</td>
<td>This cellular modem kit is for use in applications that require monthly data usage approaching 50 MB or 250 MB with push intervals no more frequent than every 10 minutes. This modem is only for use in the North American region. Please visit our support site for more details on coverage areas and cellular plan pricing.</td>
</tr>
</tbody>
</table>

Continued on page 45
Continued from page 44

<table>
<thead>
<tr>
<th>Cellular Kit Model</th>
<th>Kit Description</th>
<th>Important Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SXI-CATM1WW-001</td>
<td><strong>Worldwide CAT M1</strong> cellular modem using Telit ME910 model kit. Includes a cellular modem, SIM card, internal adhesive antenna, external SMA antenna, and antenna cable. The SIM card is specific to the LTE-M/NB-IoT technology and cannot be used in other cellular modems. Requires an LTE cellular plan attached to the ICCID (SIM card) number and IMEI (International Mobile Equipment Identity) number. Cellular plans can be purchased through celldata.bannercds.com or a local roaming SIM provider.</td>
<td>This cellular modem kit is for use in applications that require monthly data usage approaching 50 MB or 250 MB with push intervals no more frequent than every 10 minutes. This modem is only for use in the European region within those countries that are members of the EU/EEA and adopt RED/CE compliant products. Please visit our support site for more details on coverage areas and cellular plan pricing.</td>
</tr>
</tbody>
</table>

For additional information, refer to the Banner Cloud Data Services support center (support.bannercds.com). The support center includes video tutorials, product documentation, technical notes, and links to download configuration software.

**IMPORTANT:** Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) cellular modem can offer SMS/text messaging capabilities directly from the device. Contact a support specialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered using the Banner CDS web service from any DXM model.

**Install the Cellular Modem (DXM100, 150, 700, and 1000 Models)**

Follow these steps to install the cellular modem and antenna cable.

**IMPORTANT:**
- Electrostatic discharge (ESD) sensitive device
- ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
- Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and assembling units on a grounded, static-dissipative surface.

**Installing the cellular modem**

1. SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.
2. Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
   The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM number to associate a wireless plan to this SIM card.
3. Insert the SIM card into the socket on the underside of the cellular modem while ensuring the conductive pads on the SIM card are interfacing with the terminals of the modem.
   There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation. Do not force the SIM card into the socket.
4. Orient the cellular modem according to the pin layout.
Install the Cellular Modem (DXM1200 Models)
Follow these steps to install the cellular modem and antenna cable.

**IMPORTANT:**
- **Electrostatic discharge (ESD) sensitive device**
- ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
- Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and assembling units on a grounded, static-dissipative surface.

![Installing the cellular modem](image)

1. SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.
2. Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
   The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM number to associate a wireless plan to this SIM card.
3. Insert the SIM card into the socket on the underside of the cellular modem while ensuring that the conductive pads on the SIM card are interfacing with the terminals of the modem.
   There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation. Do not force the SIM card into the socket.

- For the DXM100, DXM150, and DXM1000 models—Install the cellular modem board onto the processor board as shown. Use the diagram to verify the orientation is correct.
- For the DXM700 models—Install the cellular modem board onto the base board as shown. Use the diagram to verify the orientation is correct.
  - a. Verify the pins are properly aligned.
  - b. Verify the hole in the cell modem aligns with the hole on the DXM board.
  - c. Firmly press the modem into the 24-pin socket.
5. Attach the antenna cable between the cellular modem board to the base board as shown.
6. Install the external cellular antenna on the DXM’s SMA connector located next to the antenna cable.
4. Apply the internal antenna as shown paying attention to the antenna cable position.
   a. Pull back the adhesive protective paper from the middle of the antenna, only exposing the middle portion. Antenna application is easier if just a small middle portion of the adhesive is uncovered.
   b. Center the antenna on the side wall. Use the exposed adhesive in the middle of the antenna to hold the antenna in place while aligning the antenna to the full length of the housing.
   c. Slowly peel off the paper backing exposing the adhesive and stick to the plastic housing. The antenna should run below the rim of the housing.
   d. Press firmly.

5. Orient the cellular modem according to the diagram below.
The cellular modem is inserted into the main board with the antenna cable from the applied internal antenna attached to the cellular modem PCB.

   a. Verify the pins are properly aligned.
   b. Verify the hole in the cell modem aligns with the hole on the DXM board.
   c. Firmly press the modem into the 24-pin socket.
   d. Attach the antenna cable between the cellular modem board to the base board. The antenna cable uses the top antenna connection.

Activating a 4G LTE CAT M1 Cellular Plan

Activate a cellular plan for your DXM using the Banner Cloud Data Services website.

1. Go to celldata.bannercds.com to purchase cellular data plans.
2. If you have previously created an account, click Login and enter your username and password to continue.
3. If you are creating a login for the first time:
   a. Select the region in which the device will operate.
   c. Create a username and password (use an email address for the username).
   d. Enter your payment information, mailing address, agree to the terms and conditions.
4. Go to the My Services and Equipment section.
5. Enter the SIM Number (ICCID) and the Module Number (IMEI).
The ICCID is the 20-digit number of the SIM, the bottom barcode number on the SIM card carrier. If the carrier card is not available, the ICCID is also printed on the SIM card, but must be removed from its socket to be read. The IMEI is the 15-digit number on top of the 4G LTE device.
6. Click Activate.
Activate a Worldwide 4G LTE MNB-IOT Cellular Plan (RED-CE)

The Worldwide 4G LTE-M/NB-IOT cellular modem is operational in those European countries that are members of the EU/EEA and adopt RED/CE-compliant products. An international roaming SIM is provided with the Worldwide module and may be activated following the steps listed in “Activate a 4G LTE CAT M1 Cellular Plan” on page 47. However, there may be regions that are not covered by the provided SIM card. In this case, a local SIM card must be activated and operated with this device to acquire connectivity services.

1. Work with the local Banner technical support person to identify and purchase machine-to-machine (M2M) (data plan only) SIM cards in 3FF 'micro' form factor. Typical monthly data use will be 20-50 MB per month. When choosing a plan, pay close attention to data rates.
2. When activating the SIM, note the Access Point Name (APN) that the SIM provider states to use with their SIM. The IMEI is the 15-digit number on top of the cell module PCB, below the words Telit ME910G1-WW and above the barcode. The ICCID is the 20-digit number printed on the SIM card itself.

Configure the DXM Controller for a Cellular Modem

Use the DXM Configuration Software to create a configuration using a cellular connection.

1. Go to the Settings › Cloud Services screen.
2. Set the Push Interface to Cell
   All push data will be sent using the cellular modem.
3. Go to the Settings › Cellular screen. Under the Cell Configuration section, select the Cell module from the drop-down list.
   - For the United States (contiguous)—For Verizon LTE/CATM modems, select SXI-LTE-001 or SXI-CATM1VZW-001 and set the APN to vzwinternet.
   - For North America—For ATT LTE/CATM modems, select SXI-CATM1ATT-001 and set the APN to lot0119.com.attz. Requires a SIM module to be purchased from a wireless carrier based on the IMEI number of the cellular modem. The wireless carrier will provide the APN parameters. Not all parameters may be required.
   - For regions outside of North America—Select SXI-CATM1WW-001 and set the APN to m2m.tele2.com when using the SIM card provided with the kit from Banner Engineering. When using a local roaming SIM, please use the APN as suggested by your cellular connectivity (SIM) provider.
4. To send data to the webserver, complete the parameters on the Settings › Cloud Services screen. Set the Cloud push interval and the Web Server settings. (For more information, refer to the DXM Configuration Software Instruction Manual (p/n 201127)).
IMPORTANT: Banner Engineering offers several prepackaged solutions that report to the Banner Cloud Data Services web-based software platform via cellular connectivity. Many of these solutions execute the data push using a ScriptBasic file instead of the XML configuration file. If you are using a Banner prepackaged solution (ex. SOLUTIONSKIT9-VIBE), then you do not need to set the Cloud Push Interval on the Settings › Cloud Services screen. You still need to set the Push Interface to Cell and select the appropriate Cell Module and APN.

When the DXM is configured to use the cellular modem, the information on the cellular modem is found on the LCD menu under System Info › Cell. The menu does not display values until a transaction with the wireless cell tower is complete.

If there are no webserver parameters defined, the user must force a push to retrieve the data from the cellular network. On the LCD menu, select Push › Trigger Data Push.

Obtaining LTE service outside of the Banner Cellular Data Plans—Customers have the option of securing a data plan for the Verizon network themselves without using the Banner cellular data portal (celldata.bannercds.com). Suitable plans would include those available from Verizon directly or from a Mobile Virtual Network Operator (MVNO) licensed to resell Verizon network data plans. (The SXI-LTE-001 or SXI-CATM1VZW-001 will not function on AT&T, T-Mobile, or Sprint networks.) When purchasing a data plan, it is important to refer to the modem by its official Verizon network name (for example, SEN-SX002) and give the IMEI number (found on the cellular modem) to the plan provider. To use the SIM card that comes with the cellular modem kit, give the SIM card number to the provider. The required SIM card form factor is 3FF - Micro.
The LCD has four user-defined LED indicators, four control buttons, and an LCD. The four buttons control the menu system on the LCD menu.

The top-level menu always displays the time in a 24-hour format.
- The up and down arrows scroll through display items.
- The ENTER button selects the highlighted items on the display.
- The BACK button returns to a previous menu option.

The left display column shows an arrow at the beginning of the line if the menu has submenus. The right column shows a vertical line with an arrow at the bottom if the user can scroll down to see more menu items.

The DXM can be configured to require a passcode be entered before the LCD and Menu system will operate. The passcode configuration is defined in the DXM Configuration Software.

Registers
The Registers submenu displays the processor's local registers that can be configured using the DXM Configuration Software.

To configure these local registers, launch the DXM Configuration Software. Go to Local Registers and expand the view for a local register by clicking on the down arrow next to the register number. In the LCD Permissions field, select None, Read, Write, or Read/Write.
Read allows the register to be displayed and Write or Read/Write allows the register value to be changed using the LCD. The Units and Scaling parameters are optional and affect the LCD.

Push

The **Push** menu displays information about the last data sent to the Webserver.

```
Push menu
Push ----> Trigger Data Push ----> Trigger Data Push
Status Time (hh:mm:ss)  
↑  ↓  to change the value
ENTER  to accept
BACK  to return to the previous menu
```

The user can force an immediate push to the webserver using Trigger Push. If a current push is in process it may take several minutes to complete over cellular.

- The **Trigger Push** submenu forces an immediate push to the web server.
- The status and time fields indicate the success or failure of the last attempted push and the time of the last attempted push.

ISM Radio

The **ISM Radio** menu allows the user to view the Modbus ID of the internal ISM radio, enter binding mode, or run a site survey. This top-level **ISM Radio** menu is different from the **System Config > ISM Radio** submenu.

```
ISM Radio menu
ISM Radio ----> MultiHop/DX80 ID
Binding ----> Bind to > 1
Site Survey ----> Node/Modbus ID > 1
Please Wait...
Site Survey results OR Failed to start Site Survey
```

The first option under the **ISM Radio** menu only displays the type of radio in the DXM (MultiHop or DX80 Star) and the Modbus ID of the radio. To change the ISM Radio Modbus ID refer to the **System** menu.

Select **Binding** to enter binding mode or select **Site Survey** to run a site survey.

**Binding**—All ISM radio devices must be bound to the internal Gateway/client device before the DXM can access wireless devices. The first submenu under binding allows the user to set the wireless address of the device to bind with. This is required to bind with wireless devices that do not have rotary dials (for example M-GAGEs, ultrasonic sensors, and Q45 devices). See "Binding and Conducting a Site Survey with the ISM Radio " on page 15. For more information on binding a particular device, refer to the individual datasheet.

**Site Survey**—After creating a wireless network using the binding process, run a site survey on each device to see the link quality. See "Conduct a Site Survey from the DXM" on page 17.
IO Board

Use the **I/O Board** menu to view input values, output values, input counters values, and the charger status on the DXM I/O board. To change the configuration parameters, use the **System Config** menu.

### I/O Board menu

- **Inputs**
  - Input 1
  - Input 2
  - Input 3
  - Input 4

- **Outputs**
  - Output 1
  - Output 2
  - Output 3
  - Output 4
  - Output 5
  - Output 6

- **Counters**
  - Counter 1
  - Counter 2
  - Counter 3
  - Counter 4

- **Charger**
  - Supply (V)
  - Battery (V)
  - Charging (A)
  - Charge (%)

**Key:**
- **↑** to change the value
- **ENTER** to accept
- **BACK** to return to the previous menu

The **I/O Board** menu includes the following submenus.

**Inputs**
Lists the inputs. Depending upon the input type, the value and unit’s information will also be displayed.

**Outputs**
The DXM base configuration can include discrete, current, or voltage outputs. The output values will be displayed based on their configuration settings.

**Counters**
Counters on the DXM base board are associated to inputs but the count value is stored in different register. Adjust or view the count registers using the LCD menu.

**Charger**
The on-board solar/battery charger of the DXM stores information about the charging circuit in Modbus registers. Use the LCD menu to view information about the incoming voltage, charging current, battery voltage, and battery charge percentage.
System Config

Use the System Config menu to set DXM system parameters.

System Config menu

- System Config → ISM Radio → DX80 ID: x → New ISM Modbus ID: x
- Auto Detect Radio → Radio Detected Type: DX80 ID: 1
- Advanced Options → Ref Type: DX80 Ref Modbus ID: x
- Max Node Count: xx → New ISM Max Nodes: xx
- Binding #: xxxxx → New ISM Binding Code: xxxxx
- RF Ctrl: Dip 1.00W

- I/O Board → Inputs → Input x → In Type: Cnt Rise: Cnt Fall:
- Outputs → Output x → Default: Type: Voltage:

- Ethernet → DHCP: Update DHCP Mode → Updates IP Address
- IP: Update SN
- SN: Update GW Address
- GW: Resets Ethernet parameters to xml defaults.

- Charger
- Provision Cell → DXM Modbus ID: xxx
- LCD Contrast: xx
- Restart

ISM Radio

**DX80/MultiHop ID**—The ISM radio is set at the factory to be Modbus device address 1 (Modbus ID 1). For some applications, you may need to change the Modbus ID. Adjust the Modbus device address using the LCD menu system. Any other method may cause issues with the DXM not knowing which Modbus device address is assigned to the radio, which causes issues with running Binding or Site Survey from the LCD menu.

Set the radio Modbus ID to a valid number (1 through 247) that is not being used by the DXM system. Processor Local Registers allocate ID 199, the I/O board is set to ID 200, and the display board is set to ID 201. With a DX80 Gateway (star network), it’s easy to choose a new ID. With a MultiHop network, remember that the client MultiHop radio allocates a range of Modbus IDs for wireless devices, typically 11 through 110.

When setting the new ISM Modbus ID, the system changes the Modbus ID on the internal radio and changes the reference to it on the DXM. The reference Modbus ID is what the DXM uses to access the internal radio when running Binding or Site Survey.

**Auto Detect Radio**—If the internal Modbus ID of the radio was changed or the internal radio was changed, but not recorded, use Auto Detect Radio to determine the radio ID and radio type. The auto-detect routine broadcasts discovery messages and waits for a response. If other devices are connected to the external RS-485 ports, they may need to be disconnected for this process to work properly.

**Advanced Options**—The Advanced Options menu is typically not used unless the Modbus ID is changed without the DXM being involved, such as when you write directly to the radio Modbus registers.

- **Reference Type** selects the radio type between DX80 star architecture radios and a MultiHop radio. The DXM uses this reference to determine how to communicate to the internal radio. If set incorrectly, the DXM may not be able to run Site Survey from the LCD menu. Unless you are changing or adding the internal radio device, there should be no reason to change the radio type.
- **Reference Modbus ID** defines the Modbus ID the DXM uses when communicating with the internal radio. If this is set incorrectly, the DXM will not be able to run Binding or Site Survey through the LCD menu.

**Max Node Count**—Defines the maximum number of devices for the DX80 wireless network.
**Binding #**—This parameter allows the user to define the Binding code within the ISM radio. Typically, you will not have to adjust this number unless you are replacing an existing Gateway or client radio.

**RF Ctrl**—Displays the status of the ISM radio DIP switch 1 (off or on). The menu doesn't allow the user to change the DIP switch setting through the display.

**IO Board**

Use the **System Config › I/O Board** submenu to change the configuration parameters for the inputs, outputs, counters, and charger.

Use the **Inputs** menu to change the input type. The universal inputs on the DXM are defined from the factory as sinking inputs. To change the input type:

1. Go to the **System Config › I/O Board › Inputs** menu.
2. Select which input to change.
3. Select the input type. The available parameters include the Input Type and the Counter Edge Detect.

### Input parameters

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sinking</td>
<td>Discrete input, low active, 0 = ON, 1 = OFF</td>
</tr>
<tr>
<td>Sourcing</td>
<td>Discrete input, high active, 1 = ON, 0 = OFF</td>
</tr>
<tr>
<td>Current</td>
<td>Analog input, 0–20 mA</td>
</tr>
<tr>
<td>Voltage</td>
<td>Analog input, 0–10 V DC</td>
</tr>
<tr>
<td>Thermistor 2*</td>
<td>Thermistor input, 10k - J (r-t curve), beta(K) 3890</td>
</tr>
<tr>
<td>Thermistor 1*</td>
<td>Thermistor input, 10k - G (r-t curve), beta(K) 3575</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Type</td>
<td>Sinking or sourcing</td>
</tr>
<tr>
<td>Cnt Rise</td>
<td>Increment the count when the input transitions from 0 -&gt; 1</td>
</tr>
<tr>
<td>Cnt Fall</td>
<td>Increment the count when the input transitions from 1 -&gt; 0</td>
</tr>
</tbody>
</table>

Use the **Output** menu to change the default condition, output type, and switched power voltage.

### Output parameters

<table>
<thead>
<tr>
<th>Output Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Force output registers to a default condition if the I/O board has not been communicated with for a user-defined time period. The communications timeout parameter must be set to use the Default condition.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the output type: NMOS Sinking, Switch Power (Swch Pwr), Analog.</td>
</tr>
<tr>
<td>Voltage</td>
<td>Outputs defined as switched power can adjust the voltage: 5 V or 16 V</td>
</tr>
</tbody>
</table>

Use the **Charger** menu to change the charging algorithm for the battery. This parameter can also be set by writing Modbus register 6071 of the I/O board. See "Supplying Power from a Solar Panel" on page 36.

### Charger parameters

<table>
<thead>
<tr>
<th>Charger Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>Used when 12–24 V DC power supplies connected to the DXM power pins and the attached batteries are used as backup batteries. This limits the current during the battery charging process. (factory default setting)</td>
</tr>
<tr>
<td>Solar</td>
<td>Select Solar when a solar panel is connected to the power pins of the DXM. Solar panels are current limited by their design and therefore can charge the battery without managing the input power.</td>
</tr>
</tbody>
</table>
Ethernet
Use the Ethernet submenu to set the IP Address, Gateway Address, and Subnet mask of the DXM's Ethernet interface. You may change these settings either from the LCD menu (System Config › Ethernet) or from the XML configuration file created by the DXM Configuration Software.

The network address settings from the LCD menu have the highest priority and override settings in the XML configuration file. To use the parameter settings from the XML configuration file or use DHCP, execute the Reset under System Config › Ethernet or use the LCD display to set the IP Address, Gateway Address, and Subnet Mask to 255.255.255.255. Reboot the DXM after changing the Ethernet parameters.

The Ethernet cable should be attached before powering up the DXM.

 Provision Cell
If the DXM has a cellular modem installed, the modem must be provisioned on the network. This menu provisions the cellular modem on the network. For step by step directions, see "Using the DXM Cellular Modem" on page 44.

 DXM Modbus ID
Use the secondary Modbus RS-485 port when the DXM is connected to a Modbus RTU network as a Modbus server device. Set the Modbus ID for the secondary RS-485 port using the LCD display menu System Config › DXM Modbus ID.

 LCD Contrast
Use the LCD Contrast option to adjust the LCD contrast. Adjust the starting number lower to decrease the display contrast. The factory default is 28. Do not set a number less than 15 or the display may not be bright enough to see to change back.

 Reset
Use the Restart menu to force the main processor to restart. This does not affect the other boards in the system.
System Info

Various DXM system settings are shown in this menu. The Push, Ethernet, and Cell parameters are helpful for debugging network connections. This is a read only menu.

**System Info menu**

- **Controller**
  - Date:
  - Firmware:
  - Build:
  - Model:
  - Serial:

- **Push**
  - Method:
  - Interval: hh:mm
  - URL:
  - Page:
  - HTTPS: on/off
  - Site ID:

- **ISM Radio**
  - Serial:
  - Model:
  - Date:
  - RF FW Pt:
  - RF FW Ver:
  - RF EE Pt:
  - RF EE Ver:

- **IO Board**
  - Serial:
  - Model:
  - Date:
  - RF FW Pt:
  - RF FW Ver:
  - RF EE Pt:
  - RF EE Ver:

- **Ethernet**
  - DHCP:
  - IP:
  - Subnet:
  - Gate:
  - Mac:
  - DNS1:
  - DNS2:

- **Cell**
  - Signal:
  - Phn#:
  - Dev#:
  - SIM:
  - CellVer:
  - CellMdl:
  - CellFw:
  - CellMask:

- **Wifi**
  - IP:
  - Mode:
  - AP:
  - Stat:

- **Script**
  - Path:
  - Baud:
  - Code:

- **LCD Board**
  - Serial:
  - Model:
  - Date:
  - RF FW Pt:
  - RF FW Ver:
  - RF EE Pt:
  - RF EE Ver:

**Cell**

Shows the cellular MEID number (Mobil Equipment Identifier), MDN (Mobil Device Number), version, signal, firewall setting, and firewall mask. Some of these parameters are not visible until the cellular network is accessed.

**Controller**

Displays the date, build, model, and serial number.

**Ethernet**

Displays the IP address, MAC address, DHCP, Gateway address, and DNS settings.

**I/O Board**

Displays the serial number, model, date, firmware part numbers, and version numbers.

**ISM Radio**

Displays the serial number, model, date, firmware part numbers, and version numbers.

**LCD Board**

Displays the serial number, model, date, firmware part numbers, and version numbers.

**Push**

Shows the current parameters loaded from the XML configuration that applies to pushing data to a webserver, including method (Ethernet or cellular), interval, URL, page, HTTPS, and site ID.

**Script**

Displays the name of the ScriptBasic file running.

**Wifi**

Displays the Wifi IP address and other settings.
Display Lock

Display Lock protects the DXM LCD menu system from being used until the proper pass code is entered.

Display Lock menu

Display Lock → Enter password

↑ ↓ to change the value

ENTER to accept

BACK to return to the previous menu

The display lock feature uses the configuration software to set a passcode within the DXM. A valid passcode is 1 to 9 digits long and uses numbers 0 through 9. For example, 1234 or 209384754.
Chapter 8  Configuration Instructions

DXM Configuration Software

Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Overview of the configuration software features

The configuration software configures the DXM by creating an XML file that is transferred to the DXM using a USB or Ethernet connection. The DXM can also receive the XML configuration file from a Web server using a cellular or Ethernet connection.

This configuration file governs all aspects of the DXM operation.

The wireless network devices are a separate configurable system. Use the DX80 User Configuration Software to configure the internal DX80 wireless Gateway and the attached wireless Nodes. Use the MultiHop Configuration Software if the internal radio is a MultiHop device.

All tools can be connected to the DXM using a USB cable or an Ethernet connection.
Register Flow and Configuration

The DXM register data flow goes through the Local Registers, which are data storage elements that reside within the processor. Using the DXM Configuration Software, the controller can be programmed to move register data from the Local Register pool to remote devices, the internal radio, the I/O base (if applicable), or the display.

![Register flow diagram]

Basic Approach to Configuration

When programming an application in the DXM, first plan the overall data structure of the Local Registers. The Local Registers are the main storage elements in the DXM. Everything goes into or out of the Local Registers.

1. In the DXM Configuration Software, name the Local Registers to provide the beginning structure of the application.
2. Configure the read/write rules to move the data. The Read/Write rules are simple rules that move data between devices (Nodes, Modbus servers, sensors, etc) and the Local Registers.
3. Most applications require the ability to manipulate the Local Register data, not just move data around. Use the Action rules to make decisions or transform the data after the data is in the Local Registers. Action rules can apply many different functions to the Local Register data, including conditional statements, math operations, copy operations, or trending.
4. To perform scheduled events in Local Registers, go to the Scheduler screen in the DXM Configuration Software. These rules provide the ability to create register events by days of the week. The scheduler can also create events based on sunrise or sunset.

Troubleshooting a Configuration

View Local Registers using the Local Registers › Local Registers in Use screen of the DXM Configuration Software.

When a configuration is running on the DXM, viewing the Local Registers can help you to understand the application’s operation. This utility can also access data from remote devices.

To configure the Local Register data to display on the LCD menu, go to the Local Registers screen, set the LCD permissions to read or read/write.

Saving and Loading Configuration Files

The DXM Configuration Software saves its configuration information in a XML file. Use the File menu to Save or Load configuration files.

Save the configuration file before attempting to upload the configuration to the DXM. The DXM Configuration Software uploads the configuration file saved on the PC to the DXM; it will not send the configuration loaded in the tool.
Uploading or Downloading Configuration Files

The DXM requires a XML configuration file to become operational. To upload or download configuration files, connect a computer to the DXM using the USB port or Ethernet port. Then use the **Upload Configuration to Device** or **Download Configuration from Device** under the **Device** menu.

Scheduler

Use the **Scheduler** screens to create a calendar schedule for local register changes, including defining the days of the week, start time, stop time, and register values.

Schedules are stored in the XML configuration file, which is loaded to the DXM. Reboot the DXM to activate a new schedule.

If power is cycled to the DXM in the middle of a schedule, the DXM looks at all events scheduled that day and processes the last event before the current time.

For screens that contain tables with rows, click on any row to select it. Then click **Clone** or **Delete** to copy/paste or remove that row.

Create a Weekly Event

Use the **Scheduler › Weekly Events** screen to define weekly events.

![Scheduler > Weekly Events screen](image)

1. Click **Add Weekly Event**.
   A new schedule rule is created.

2. Click on the arrow to the left of the new rule to expand the parameters into view.
   The user-defined parameters are displayed.

3. Name your new rule.

4. Enter the local register.

5. Select the days of the week this rule applies to.

6. Enter the starting value for the local register.

7. Use the drop-down list to select the type of Start at time: a specific time or a relative time.

8. Enter the starting time.

9. Enter the end time and end value for the local register.

Register updates can be changed up to two times per day for each rule. Each rule can be set for any number of days in the week by clicking the buttons M, T, W, Th, F, S, or Su.

If two register changes are defined for a day, define the start time to be before the end time. Select **End Value** to enable the second event in a 24 hour period. To span across two days (crossing the midnight boundary), set the start value in the first day, without selecting **End Value**. Use the next day to create the final register state.

Start and end times can be specified relative to sunrise and sunset, or set to a specific time within a 24 hour period. When using sunrise or sunset times, set the GPS coordinates on the device so it can calculate sunrise and sunset.
Create a One-Time Event

Define one-time events to update registers at any time within a calendar year. Similar to Weekly events, the times can be specific or relative to sunrise or sunset. Define one-time events using the Scheduler › One Time Events screen.

1. Click on Add One Time Event. A new one-time event is created.
2. Click on the arrow to expand the parameters into view. The user-defined parameters are displayed.
3. Name your one-time event by clicking on the name link and entering a name.
4. Enter the local register.
5. Enter the starting time, date, and starting value for the local register.
6. Enter the ending time, date, and ending value for the local register.

Create a Holiday Event

Use the Scheduler › Holidays screen to create date and/or time ranges that interrupt weekly events.

1. Click on Add Holiday. A new rule is created.
2. Enter a name your new holiday rule.
3. Select the start date and time for the new holiday.
4. Select the stop date and time for the new holiday.

Authentication Setup

The DXM has three different areas that can be configured to require a login and password authentication.

- Webserver/ Cloud Services Authentication
- Mail Server Authentication
- DXM Configuration Authentication

The webserver and mail server authentication depends upon the service provider.

Set the Controller to use Authentication

The DXM can be configured to send login and password credentials for every HTTP packet sent to the webserver. This provides another layer of security for the webserver data.

Configuration requires both the webserver and the DXM to be given the same credentials for the login and password. The webserver authentication username and password are not stored in the XML configuration file and must be stored in the DXM.

1. From within the DXM Configuration Software, go to the Settings › Cloud Services screen.
2. In the upper right, select Show advanced settings.
3. Define the username and password in the Web Server Authentication section of the screen.
Controller Configuration Authentication

The DXM can be programmed to allow changes to the configuration files only with proper authentication by setting up a password on the Settings > Administration screen in the DXM Configuration Software.

With the DXM connected to the PC, click Get Device Status. The DXM status displays next to the button.

Use the DXM Configuration Software to:
- Set the Admin Password
- Change the Admin Password
- Remove the Admin Password

To change or remove an admin password, the current password must be supplied. The DXM must be connected to the PC to change the administration password.

The DXM can be unlocked without knowing the administration password, but doing this erases the configuration program, logging files, and any ScriptBasic program on the device. For instructions on how to do this, see the "Additional Information" on page 69 section.

EtherNet/IP Configuration

The DXM is defined from the factory to send/receive register data from the Gateway and the first 16 Nodes with an EtherNet/IP™(1) host.

To expand the number of devices going to Ethernet/IP, change the Devices in system parameter in the DX80 Gateway (default setting is 8) to 32. To change this value:

1. Launch the the DX80 Configuration Software.
2. In the menu bar, go to Device > Connection Settings and select Serial or Ethernet DXM.

---

(1) EtherNet/IP is a trademark of Rockwell Automation.
This allows the user to maximize the use of the EtherNet/IP buffer to 28 devices.

EDS (Electronic Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device to the PLC. Download the EDS files from the Banner website.

- DXM EDS Configuration File (for PLCs) (p/n b_4205242)
- DXM EIP Config File for DXM Controller with Internal Gateway (Models: DXM1xx-BxR1, DXM1xx-BxR3, and DXM1xx-BxCxR1) (p/n 194730)

Download an Existing Configuration from the DXM

If you have an existing configuration file, save the XML file locally as a backup on your computer.

1. Apply power to the DXM.
2. Connect an ethernet or USB cable between your computer and the DXM.
3. Launch the DXM Configuration Software v4 and select your DXM model.
4. On the Device > Connection Settings menu, select one of the following:
   - Select TCP/IP as the connection type and enter the IP Address of the DXM Controller; or
   - Select Serial as the connection type and select the appropriate Comm port
5. On the menu bar, select Device > Get XML configuration from DXM to download the XML configuration file.
6. Save the XML file locally on your computer.

Configuring the Controller

Use the configuration software to define the Protocol conversion for each local register to be EIP Originator > DXM or EIP DXM > Originator from the Edit Register or Modify Multiple Register screens.

Define a DXM local register as EIP Originator > DXM when the host PLC (Originator) will send data to the DXM local register (DXM).

Define a DXM local register as EIP DXM > Originator when that register data will be sent from the DXM (DXM) to the host PLC (Originator).

Data from an EIP controller in assembly instance 112 is data destined for the DXM local registers. The PLC is normally configured for INT or UINT data transfer. This allows for a seamless transfer of data.

<table>
<thead>
<tr>
<th>EIP Assembly Instance 112 (16-bit)</th>
<th>DXM Local Registers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adrs</td>
<td>Data</td>
</tr>
<tr>
<td>0</td>
<td>1122</td>
</tr>
<tr>
<td>1</td>
<td>5566</td>
</tr>
<tr>
<td>3</td>
<td>9900</td>
</tr>
<tr>
<td>4</td>
<td>3344</td>
</tr>
</tbody>
</table>

Data from the DXM local registers is sent to the EIP controller using assembly instance 100. Each local register in the DXM defined as EIP DXM > Originator is collected in numerical order and placed into the data buffer destined for assembly instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes (16-bits) for each local register are transferred.
Configure Local Registers to Export Data to a PLC

1. On the DXM Configuration Software: Go to the Local Registers screen.
2. Select the register(s) that will be exported to a Host PLC.
   A maximum of 228 registers can be read or written with Ethernet/IP.
3. In the Storage/Connectivity section, select EIP DXM -> Originator from the Protocol conversion drop-down list.
   To change a block of continuous local registers, use the Modify Multiple Registers screen.

Configure Local Registers to Import Data from a PLC

1. On the DXM Configuration Software: Go to the Local Registers screen.
2. Select the register(s) that will be imported from a Host PLC.
   A maximum of 228 registers can be read or written with Ethernet/IP.
3. In the Storage/Connectivity section, select EIP Originator -> DXM from the Protocol conversion drop-down list.
   To change a block of continuous local registers, use the Modify Multiple Registers screen.

To view the EIP Input and Output registers, go to the Tools > Protocol Conversion screen. You may also export the register map to a CSV file.

Save and Upload the Configuration File

After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM > Send XML Configuration to DXM menu.

Status indicator bar

- If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the cable and reconnect the DXM to the software.
- If the Application Status indicator is green, the file upload is complete.
- If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.

After the file transfer is complete, the device reboots and begins running the new configuration.

Configuring the Host PLC

On the host PLC, install the DXM using an EDS file or by using the following parameters:
- Assembly1: Originator to DXM = Instance 112, 456 bytes (228 words)
- Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXM. The host system sees the DXM as a generic device with the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM, Integer Type - INT).
IMPORTANT: Do not set the Requested Packet Interval (RPI) any faster than 150 ms.

Define the Network Interface Settings

On the Cloud Services screen (shown with Show advanced settings selected), define the network connection settings by selecting Ethernet or Cell from the Network Interface drop-down list. This determines how the DXM sends data.

If you don’t require pushing data to a web server, set the Cloud Push interval to zero.

Configure your Ethernet Connection

When selecting Ethernet, go to the Settings > Ethernet screen.

1. To define the Ethernet IP address, give the DXM a static IP address. In most cases you may select the device to use DHCP and have the IP address automatically assigned.
2. DNS settings are not typically required. The DXM uses a public service to resolve Domain names, but if the network connection does not have Internet access, the DNS settings may be required.
Configure your Cellular Connection

To use a cellular connection, select Cell as the network connection on the Settings > Cloud Services screen (see "Configure the DXM Controller for a Cellular Modem" on page 48). The Cellular screen does not display unless the Network interface is set to Cell.

Using a 4G LTE cell module requires a cellular plan; follow the instructions on p/n 205026 to activate a cell modem.

1. On the Settings > Cellular screen, select your cellular modem from the drop-down list.
2. Set the APN.
   - If you are using a Banner 4G LTE-M Verizon Module (ME910C1), set the APN to vzwidnet.
   - If you are using a Banner 4G LTE AT&T Module (ME910C1), set the APN to iot@119.com.attz.
   - If you are using a Banner 4G LTE-M/NB-IoT Worldwide Module (ME910G1), set the APN to m2m.telege.com.
   - If you are using a third-party SIM card, the APN, APN Username, and Password must be provided by the cellular service provider.

Ethernet and Cellular Push Retries

The DXM can be configured to send register data packets to a webserver. When the Ethernet or cell communications path is not operating, the DXM retries the send procedure. The communications retry process is outlined below for each configuration.

Regardless of the communications type (Ethernet or cellular), a failed attempt results in the register data packet being saved on the local micro SD card(1). The number of retries will depend upon the network connection type.

When there is bad cellular signal strength or there is no Ethernet connection, the transmission attempts are not counted as failed attempts to send data. Only when there is a good network connection and there are 10 failed attempts will the controller archive the data on the SD card. Data archived on the SD card must be manually retrieved.

Ethernet Push Retries

With an Ethernet-based network connection, the DXM retries a message five times. The five retry attempts immediately follow each other. After all attempts are exhausted, the register data packet is saved on the micro SD card.

At the next scheduled time, the DXM attempts to send the saved packet as well as the newly created register data packet. If it cannot send the new register data packet, the new register data packet is appended to the saved file on the micro SD card to be sent later. After 10 rounds of retries, the data set is archived on the micro SD card under folder _sxi. No additional attempts to resend the data are made; the data file must be manually retrieved.

Using SSL on Ethernet will have no retries, but will save each failed attempt to the micro SD card until 10 failed rounds. At this time, the register data packet is archived.

Cellular Push Retries

In a cellular-connected system there are no retries. Failed transmissions are saved on the micro SD card.

After 10 successive failed attempts, the data is archived in the _sxi folder. Send attempts with a low signal quality are not counted against the 10-count limit. For example, if the cellular antenna is disconnected for period that the DXM controller would have sent 20 messages under normal circumstances, all 20 messages would be saved and will be retried when the antenna is reconnected. If the signal quality was good, but the cellular network was not responding, the DXM archives the register data packets after 10 failed attempts.

Event/Action Rule or Log File Push Retries

Event-based pushes caused by Action rules follow the same process when failures occur, based on the network connection. The failed Event-based messages are resent with the next cyclical schedule or the next event message that triggers a push message.

---

(1) Enable HTTP logging to save data on the SD card; this is the factory default. See SETTINGS -> LOGGING in the DXM Configuration Tool.
Chapter 9  Additional Information

Working with Modbus Devices

The DXM has two physical RS-485 connections using Modbus RTU protocol.

The DXM can be a Modbus RTU client device to other server devices and can be a Modbus server device to another Modbus RTU client. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU client to control external server devices. All wired devices connected to the client RS-485 port must be server devices.

- As a Modbus RTU client device, the DXM controls the external server connected to the primary RS-485 port, the local ISM radio, the local I/O base board, and the local display board.
- As a Modbus RTU server device, the DXM local registers can be read from or written to by another Modbus RTU client device.

The secondary port (S+/S-) is the Modbus RTU server connection. The secondary (server) Modbus RS-485 port (S+/S-) is controlled by another Modbus client device, not the DXM. The server port is used by an external Modbus client device that will access the DXM as a Modbus server device.

**Processor Modbus system overview**

The DXM has dual Modbus roles: a Modbus server device and a Modbus client device. These run as separate processes.

The Modbus server port can only access the DXM local registers. To operate as a Modbus server device, the DXM needs to be assigned a unique Modbus ID as it pertains to the host Modbus network. This ID is separate from the internal Modbus IDs the DXM uses for its own Modbus network. The DXM Modbus ID is defined through the LCD menu. Other Modbus server port parameters are defined by using the configuration software.

The DXM operates the Modbus client port. Each device on the client port must be assigned a unique Modbus ID. There are Modbus IDs that are reserved for internal devices in the DXM.

June 05, 2023  © Banner Engineering Corp.
**DXM Internal Modbus IDs (factory default)**

<table>
<thead>
<tr>
<th>Modbus ID</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio should be assigned Modbus IDs starting at 11.</td>
</tr>
<tr>
<td>199</td>
<td>Local Registers—Internal storage registers of the DXM</td>
</tr>
<tr>
<td>200</td>
<td>I/O Base Board—All data and parameters for each input or output of the DXM.</td>
</tr>
<tr>
<td>201</td>
<td>LCD Display—The user has access to the LED indicators on the DXM.</td>
</tr>
</tbody>
</table>

**Assigning Modbus IDs**

Assign the DXM Modbus ID only if a Modbus client device is reading or writing the DXM Local Register data through the Modbus RS-485 server port (S+, S-).

Set the DXM ID from the LCD menu under **System > DXM Server ID**. The DXM can have any unique ID between 1 and 246, depending upon the host Modbus network. Other RS-485 server port parameters are set in the configuration software under the **Settings > General** tab.

**DXM Client Configuration**—When the DXM operates as a Modbus client device, use the configuration software to configure read or write operations of the DXM Modbus network. The DXM communicates with all internal and external peripheral devices using the external Modbus bus RS-485 (M+, M-)

There are four internal Modbus server devices that are configured from the factory with Modbus IDs. Assign IDs 2 through 10 to Modbus server devices that are physically wired to the DXM. Assign IDs 11 through 60 to wireless server within the MultiHop network.

Do not assign an ID of greater than 10 to Modbus server devices that are physically wired using the RS-485 port if there is an internal MultiHop ISM radio in the DXM. The MultiHop ISM radio attempts to send any Modbus data intended for IDs 11 through 60 across the radio network, which conflicts with wired server devices if the IDs overlap. The MultiHop client radio can be changed from the factory default of 11 through 60 Modbus IDs if more hardwired servers are required.

**Wireless and Wired Devices**

**Wireless DX80 Gateway**—The DX80 Gateway architecture is a star architecture in which all Nodes in the system send their data back to the Gateway. The host can access the entire network data from the Gateway, which is Modbus ID 1. Because the DXM will not be sending any Modbus messages across the wireless link, the timeout parameter can be set low (less than 1 second) and the device is treated like a directly connected device.

**MultiHop Client**—The MultiHop client radio forms a wireless tree network using repeaters and servers. Each device in a MultiHop network must be assigned a unique Modbus ID and is accessed as a separate device. For the DXM to talk with a MultiHop device in the wireless network, the client MultiHop device interrogates every message on the RS-485 bus. If they are within the wireless devices range (IDs 11 through 60), the message is sent across the wireless network. To change this range, the user must adjust the offset and range setting in the MultiHop client radio (Modbus ID 1). Modbus register 6502 holds the Modbus offset, default 11. Modbus register 6503 holds the number of Modbus server allowed (maximum of 100).

**Modbus IDs for wireless and wired devices**

<table>
<thead>
<tr>
<th>Modbus ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Allocated for the internal ISM radio device, either a DX80 Gateway or MultiHop client radio</td>
</tr>
<tr>
<td>2–10</td>
<td>Server addresses available for directly connected Modbus server devices to the client RS485 port (M+, M-)</td>
</tr>
<tr>
<td>11–60</td>
<td>Allocated for wireless MultiHop radio network devices. If there is not an internal MultiHop in the DXM, these server addresses are available to use for directly connected devices.</td>
</tr>
<tr>
<td>61–198</td>
<td>Available to users for direct connected Modbus server devices or the expansion of the wireless network server IDs to go past 50 wireless devices.</td>
</tr>
<tr>
<td>199</td>
<td>Allocated for internal Local Register</td>
</tr>
<tr>
<td>200</td>
<td>Allocated for the I/O base board; will be different for special DXM server-only models.</td>
</tr>
<tr>
<td>201</td>
<td>Allocated for the LCD display board, the user can read/write LEDs.</td>
</tr>
</tbody>
</table>
Modbus Communication Timeouts

A Modbus timeout is the amount of time a Modbus server is given to return an acknowledgment of a message sent by the Modbus client. If the Modbus client waits for the timeout period and no response is seen, the Modbus client considers it a lost message and continues on to the next operation.

The timeout parameter is simple to set for Modbus devices directly connected to the DXM, if there are no MultiHop wireless devices. Special considerations need to be made to set the timeout parameter when a MultiHop network uses the DXM as the client radio.

Configure controllers operating wireless networks to allow for enough time for hardware transmission retries. Set the Communications Timeout parameter to cover the expected time for messages to be sent throughout the wireless network. For the DXM, the Communications Timeout parameter is the maximum amount of time the DXM should wait after a request is sent until the response message is received from the Modbus server device. Use the DXM Configuration Software to set the timeout parameter on the Settings > System screen (select Show advanced settings).

The default setting for the timeout parameter is 5 seconds.

MultiHop Networks vs DX80 Star Networks

The DX80 star Gateway collects all the data from the Nodes, which allows the host system to directly read the data from the Gateway without sending messages across the wireless network. This allows for DX80 Gateway to be treated like any other wired Modbus device.

In a MultiHop network, the data resides at each device, forcing the controller to send messages across the wireless network to access the data. For this reason, carefully consider the value of the wireless timeout parameter.

Calculating the Communications Timeout for Battery-Powered MultiHop Radios

Battery-powered MultiHop radios are configured to run efficiently to maximize battery life. By optimizing battery life, the allowed communications window to receive messages is slow (once per 1.3 seconds) and sending message rates are standard (once per 0.04 seconds).

A MultiHop device is set from the factory with the retry parameter of 8. This means that under worst-case conditions, a message is sent from the DXM to an end device a total of nine times (one initial message and eight retry messages). The end device sends the acknowledgment message back to the DXM a maximum of nine times (one initial message and eight retries).

A single Modbus transaction may send up to two messages + 16 retry messages before the transaction is complete. In addition, the radios randomly wait up to one time period before retransmitting a retry message. So to allow for the random wait time, add one extra time period for each in-between time of retries.

To calculate the communication timeout parameter for a client to a server radio (no repeaters):

Client to Server Send time = (9 × 1.3 sec) + (8 retry wait × 1.3 sec) = 22 seconds
Server to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total Send/Receive time = 23 seconds
Minimum Timeout period = 23 seconds

If the link quality of the network is poor, the maximum transfer times may happen. Set the timeout parameter to accommodate the maximum number of retries that may happen in your application.

When MultiHop repeaters are added to the wireless network, each additional level of hierarchical network increases the required timeout period. Since MultiHop repeaters are running at the highest communications rate, the overall effect is not as great.

Client to Repeater Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Repeater to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Additional Timeout period for a repeater = 2 seconds

Using the timeout calculation above of 23 seconds, if a repeater is added to the network the timeout should be set to 25 seconds. For each additional MultiHop repeater device creating another level of network hierarchy, add an additional two seconds to the timeout period.

Calculating the Communication Timeout for 10–30 VDC MultiHop Radios

Line-powered (10–30 V DC) MultiHop devices operate at the maximum communication rate, resulting in a much lower timeout parameter setting. For each repeater added to the network, increase the timeout parameter 2 seconds.

For a client radio to a 10–30 V DC powered server radio (no repeaters):

© Banner Engineering Corp.
Client to Server Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Server to Client Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total send/receive time = 2 seconds
Minimum timeout period = 2 seconds

Adjusting the Receive Slots and Retry Count Parameters

The number of receive slots governs how often a MultiHop device can communicate on the wireless network.

Battery-powered devices typically have DIP switches that allow the user to set the number of receive slots, which directly affects the battery life of the radio. Adjusting the receive slots changes how often a message can be received. By default, the receive slots are set to 4 (every 1.3 seconds). When the receive slots are set to 32, the radio listens for an incoming message every 0.16 seconds.

Users may also leave the retry mechanism to the application that is accessing the wireless network, in this case the DXM. Adjust the number of retries in the MultiHop devices by writing the number of retries desired to Modbus register 6012. The factory default setting is 8.

Calculating the Communication Timeout for a DX80 Star Network

In the DX80 network, all Node data is automatically collected at the Gateway to be read. The DXM does not use the wireless network to access the data, which allows for much faster messaging and much lower timeout values.

For a DXM with an internal DX80 Gateway, set the timeout value 0.5 seconds. If other Modbus devices are connected to the RS-485 lines, the timeout parameter governs all communication transactions and must be set to accommodate all devices on the bus.

Modbus TCP Client

The DXM can operate as a Modbus TCP client on Ethernet. Users may define up to five socket connections for Modbus TCP server devices to read Modbus register data over Ethernet. Use the DXM Configuration Software to define and configure Modbus TCP client communications with other Modbus TCP servers.

Modbus Register Summary

DXM Modbus Registers

The DXM may have up to four internal Modbus server devices.

All Modbus registers are defined as 16-bit Modbus Holding Registers. When connecting external Modbus server devices, only use Modbus IDs 2 through 198. The local registers, the I/O base, and the LCD IDs are fixed, but the internal radio ID can be changed if needed.

**DXM Internal Modbus IDs (factory default)**

<table>
<thead>
<tr>
<th>Modbus ID</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio should be assigned Modbus IDs starting at 11.</td>
</tr>
<tr>
<td>199</td>
<td>Local Registers—Internal storage registers of the DXM</td>
</tr>
<tr>
<td>200</td>
<td>I/O Base Board—All data and parameters for each input or output of the DXM.</td>
</tr>
<tr>
<td>201</td>
<td>LCD Display—The user has access to the LED indicators on the DXM.</td>
</tr>
</tbody>
</table>

Modbus Registers for the MultiHop Radio Board Module

The DX80 MultiHop client radio is a tree-based architecture device that allows for repeater radios to extend the wireless network. Each device in a MultiHop network is a Modbus device with a unique Modbus ID.

Modbus registers in a MultiHop network are contained within each individual radio device. To obtain Modbus register data from a MultiHop device, configure the DXM to access each device across the wireless network as an individual Modbus server device.
Example MultiHop Modbus registers with generic devices.

<table>
<thead>
<tr>
<th>MultiHop Device</th>
<th>Modbus ID</th>
<th>Modbus Registers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DXM client radio</td>
<td>1</td>
<td>none</td>
</tr>
<tr>
<td>Server radio</td>
<td>11</td>
<td>Modbus register 1–16 are inputs, 501–516 are outputs</td>
</tr>
<tr>
<td>Repeater radio</td>
<td>12</td>
<td>Modbus register 1–16 are inputs, 501–516 are outputs</td>
</tr>
<tr>
<td>Server radio</td>
<td>15</td>
<td>Modbus register 1–16 are inputs, 501–516 are outputs</td>
</tr>
</tbody>
</table>

Modbus Registers for the Performance Gateway Radio Module

The DX80 Performance Gateway is a star-based architecture device that contains all the Modbus registers for the wireless network within the Gateway. To access any input or output values within the entire wireless network, read the appropriate Modbus register from Gateway.

There are 16 Modbus registers allocated for each device in the wireless network. The first 16 registers (1–16) are allocated for the Gateway, the next 16 (17–32) are allocated for Node 1, the next 16 (33–48) are allocated for Node 2 and so forth. There are no inputs or outputs on the DXM embedded Gateway but the Modbus registers are still allocated for them.

Although only seven Nodes are listed in the table, the Modbus register numbering continues for as many Nodes as are in the network. For example, the register number for Node 10, I/O point 15, is 175. Calculate the Modbus register number for each device using the equation:

\[
\text{Register Number} = \text{I/O#} + (\text{Node#} \times 16)
\]

Modbus holding registers

<table>
<thead>
<tr>
<th>I/O Point</th>
<th>Gateway</th>
<th>Node 1</th>
<th>Node 2</th>
<th>Node 3</th>
<th>Node 4</th>
<th>Node 5</th>
<th>Node 6</th>
<th>Node 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>17</td>
<td>33</td>
<td>49</td>
<td>65</td>
<td>81</td>
<td>97</td>
<td>113</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>18</td>
<td>34</td>
<td>50</td>
<td>66</td>
<td>82</td>
<td>98</td>
<td>114</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>19</td>
<td>35</td>
<td>51</td>
<td>67</td>
<td>83</td>
<td>99</td>
<td>115</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>20</td>
<td>36</td>
<td>52</td>
<td>68</td>
<td>84</td>
<td>100</td>
<td>116</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>21</td>
<td>37</td>
<td>53</td>
<td>69</td>
<td>85</td>
<td>101</td>
<td>117</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>22</td>
<td>38</td>
<td>54</td>
<td>70</td>
<td>86</td>
<td>102</td>
<td>118</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>23</td>
<td>39</td>
<td>55</td>
<td>71</td>
<td>87</td>
<td>103</td>
<td>119</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>24</td>
<td>40</td>
<td>56</td>
<td>72</td>
<td>88</td>
<td>104</td>
<td>120</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>25</td>
<td>41</td>
<td>57</td>
<td>73</td>
<td>89</td>
<td>105</td>
<td>121</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>26</td>
<td>42</td>
<td>58</td>
<td>74</td>
<td>90</td>
<td>106</td>
<td>122</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>27</td>
<td>43</td>
<td>59</td>
<td>75</td>
<td>91</td>
<td>107</td>
<td>123</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>28</td>
<td>44</td>
<td>60</td>
<td>76</td>
<td>92</td>
<td>108</td>
<td>124</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>29</td>
<td>45</td>
<td>61</td>
<td>77</td>
<td>93</td>
<td>109</td>
<td>125</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>30</td>
<td>46</td>
<td>62</td>
<td>78</td>
<td>94</td>
<td>110</td>
<td>126</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>31</td>
<td>47</td>
<td>63</td>
<td>79</td>
<td>95</td>
<td>111</td>
<td>127</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>32</td>
<td>48</td>
<td>64</td>
<td>80</td>
<td>96</td>
<td>112</td>
<td>128</td>
</tr>
</tbody>
</table>

Access all wireless network registers by reading Modbus ID 1

<table>
<thead>
<tr>
<th>DX80 Device</th>
<th>Modbus ID</th>
<th>Modbus Registers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DXM Gateway radio</td>
<td>1</td>
<td>Modbus registers 1–8 are inputs, 9–16 are outputs</td>
</tr>
<tr>
<td>Node 1</td>
<td>-</td>
<td>Modbus registers 17–24 are inputs, 25–32 are outputs</td>
</tr>
</tbody>
</table>

Continued on page 74
Alternative Modbus Register Organization

The Sure Cross DX80 Alternative Modbus Register Organization registers are used for reordering data registers to allow host systems to efficiently access all inputs or outputs using a single Modbus command. The register groups include the input/output registers, bit-packed registers, and analog registers. This feature is only available with the Performance models using version 3 or newer of the LCD firmware code.

Alternative Modbus register organization

<table>
<thead>
<tr>
<th>Name</th>
<th>Modbus Register Address (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs and Outputs, in order by device</td>
<td>2201 through 4784</td>
</tr>
<tr>
<td>Discrete Bit Packed (Status, Discrete Inputs, Discrete Outputs)</td>
<td>6601 through 6753</td>
</tr>
<tr>
<td>Analog Inputs (1–8) and Analog Outputs (1–8)</td>
<td>6801 through 9098</td>
</tr>
</tbody>
</table>

Input Registers and Outputs Registers

Modbus registers 2201 through 2584 are used to organize all inputs together. In this format, users can sequentially read all input registers using one Modbus message. Modbus registers 4401 through 4784 organize all outputs together to allow users to sequentially write to all output registers using one Modbus message.

Input and output registers

<table>
<thead>
<tr>
<th>Inputs (2201–2584)</th>
<th>16-bit Register Value</th>
<th>Outputs (4401–4784)</th>
<th>16-bit Register Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus Register Address (Decimal)</td>
<td>Gateway Inputs 1 through 8</td>
<td>Modbus Register Address (Decimal)</td>
<td>Gateway Outputs 1 through 8</td>
</tr>
<tr>
<td>2201–2208</td>
<td>...</td>
<td>4401–4408</td>
<td>...</td>
</tr>
<tr>
<td>2209–2216</td>
<td>Node 1 Inputs 1 through 8</td>
<td>4409–4416</td>
<td>Node 1 Outputs 1 through 8</td>
</tr>
<tr>
<td>2217–2224</td>
<td>Node 2 Inputs 1 through 8</td>
<td>4417–4424</td>
<td>Node 2 Outputs 1 through 8</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>2577–2584</td>
<td>Node 47 Inputs 1 through 8</td>
<td>4777–4784</td>
<td>Node 47 Outputs 1 through 8</td>
</tr>
</tbody>
</table>

Refer to your device's datasheet for a list of the active inputs and outputs. Not all inputs or outputs listed in this table may be active for your system.

Discrete Bit-Packed Registers

Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs. Bit packing involves using a single register, or range of contiguous registers, to represent I/O values.

When networks use similar Nodes to gather data using the same I/O registers for each Node, discrete data from multiple Nodes can be bit packed into a single register on the Gateway. The bit-packed data is arranged by I/O point starting at Modbus register 6601. For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit registers.

The most efficient way to read (or write) discrete data from a Sure Cross® DX80 Gateway is by using these bit-packed registers because users can read or write registers for all devices using one Modbus message. The following registers contain discrete bit-packed I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each Node in order of Node address.

© Banner Engineering Corp.
Discrete bit-packed register addresses and bit positions

<table>
<thead>
<tr>
<th>Bit-Packed Device Status Registers</th>
<th>Bit Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>6601</td>
<td>Node 15</td>
</tr>
<tr>
<td>6602</td>
<td>Node 31</td>
</tr>
<tr>
<td>6603</td>
<td>Node 47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bit-Packed Discrete Input 1</th>
<th>Bit Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>6611</td>
<td>Node 15</td>
</tr>
<tr>
<td>6612</td>
<td>Node 31</td>
</tr>
<tr>
<td>6613</td>
<td>Node 47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bit-Packed Discrete Output 1</th>
<th>Bit Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>6691</td>
<td>Node 15</td>
</tr>
<tr>
<td>6692</td>
<td>Node 31</td>
</tr>
<tr>
<td>6693</td>
<td>Node 47</td>
</tr>
</tbody>
</table>

Discrete bit-packed registers for inputs and outputs

<table>
<thead>
<tr>
<th>Modbus Register Address (Decimal)</th>
<th>Inputs</th>
<th>Description (Inputs)</th>
<th>Modbus Register Address (Decimal)</th>
<th>Outputs</th>
<th>Description (Outputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6601–6603</td>
<td>Status</td>
<td>for all devices</td>
<td>6691–6693</td>
<td>Output 1</td>
<td>from all devices</td>
</tr>
<tr>
<td>6611–6613</td>
<td>Input 1</td>
<td>from all devices</td>
<td>6701–6703</td>
<td>Output 2</td>
<td>from all devices</td>
</tr>
<tr>
<td>6621–6623</td>
<td>Input 2</td>
<td>from all devices</td>
<td>6711–6713</td>
<td>Output 3</td>
<td>from all devices</td>
</tr>
<tr>
<td>6631–6633</td>
<td>Input 3</td>
<td>from all devices</td>
<td>6721–6723</td>
<td>Output 4</td>
<td>from all devices</td>
</tr>
<tr>
<td>6641–6643</td>
<td>Input 4</td>
<td>from all devices</td>
<td>6731–6733</td>
<td>Output 5</td>
<td>from all devices</td>
</tr>
<tr>
<td>6651–6653</td>
<td>Input 5</td>
<td>from all devices</td>
<td>6741–6743</td>
<td>Output 6</td>
<td>from all devices</td>
</tr>
<tr>
<td>6661–6663</td>
<td>Input 6</td>
<td>from all devices</td>
<td>6751–6753</td>
<td>Output 7</td>
<td>from all devices</td>
</tr>
<tr>
<td>6681–6683</td>
<td>Input 8</td>
<td>from all devices</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Status registers (6601–6603) contain a bit-packed representation defining the devices that are operational in the wireless system. Each bit indicates Node in Sync (1) or Node Not in Sync (0).

If the device’s status register (input 8) contains a 128, a one (1) is written to the Discrete Status Register area, indicating the device is active in the wireless system. If the device’s I/O 8 contains any number other than a 128, a zero (0) is written, indicating the device is not active within the wireless network. In this way, an analog value representing the device’s status within the wireless network is converted to a discrete value.

A one (1) written to the Discrete Status Register area indicates the device is active within the wireless system. A zero (0) indicates the device is not active within the wireless network.

Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a sequential array of registers. The first register contains the least significant bit from the input values for the Gateway through Node 15. The second register contains the input values for Node 16 through Node 31, and the third register contains the input values for Nodes 32 through 47.

For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog value is above or below the selected threshold value (when using the threshold parameter configured in the User Configuration Software). For example, a least significant bit of one (1) indicates the analog value is above the selected threshold value. A least significant bit of zero (0) indicates the analog value is below the threshold value.
**Output registers** from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a sequential array of registers. Output 8 (I/O point 16) cannot be written using the discrete format.

Analog 16-Bit Registers (Registers 6801 through 9098)
The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most networks consist of similar Nodes reporting data using the same I/O registers for each Node. For this reason, the analog data is arranged by I/O point using Modbus registers 6801 through 9098.

For example, Input 1 for Gateway and all Nodes is stored in the first 48 contiguous blocks of 16-bit analog registers, beginning with register 6801.

In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one Modbus message. Using these registers is the most efficient way to read all status registers, read all analog inputs, or write all analog outputs.

The following registers contain analog I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each Node in order of Node address.

**Analog input and output registers**

<table>
<thead>
<tr>
<th>Modbus Register Address (Decimal)</th>
<th>Inputs</th>
<th>Description (Inputs)</th>
<th>Modbus Register Address (Decimal)</th>
<th>Outputs</th>
<th>Description (Outputs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6801</td>
<td>Input 1 for Gateway</td>
<td></td>
<td>8001</td>
<td>Output 1 for Gateway</td>
<td></td>
</tr>
<tr>
<td>6802</td>
<td>Input 1 for Node 1</td>
<td></td>
<td>8002</td>
<td>Output 1 for Node 1</td>
<td></td>
</tr>
<tr>
<td>6803</td>
<td>Input 1 for Node 2</td>
<td></td>
<td>8003</td>
<td>Output 1 for Node 2</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>6951</td>
<td>Input 2 for Gateway</td>
<td></td>
<td>8151</td>
<td>Output 2 for Gateway</td>
<td></td>
</tr>
<tr>
<td>6952</td>
<td>Input 2 for Node 1</td>
<td></td>
<td>8152</td>
<td>Output 2 for Node 1</td>
<td></td>
</tr>
<tr>
<td>6953</td>
<td>Input 2 for Node 2</td>
<td></td>
<td>8153</td>
<td>Output 2 for Node 2</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>7101</td>
<td>Input 3 for Gateway</td>
<td></td>
<td>8301</td>
<td>Output 3 for Gateway</td>
<td></td>
</tr>
<tr>
<td>7102</td>
<td>Input 3 for Node 1</td>
<td></td>
<td>8302</td>
<td>Output 3 for Node 1</td>
<td></td>
</tr>
<tr>
<td>7103</td>
<td>Input 3 for Node 2</td>
<td></td>
<td>8303</td>
<td>Output 3 for Node 2</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>7851</td>
<td>Input 8 (Status Register) for Gateway</td>
<td></td>
<td>9051</td>
<td>Output 8 for Gateway</td>
<td></td>
</tr>
<tr>
<td>7852</td>
<td>Input 8 (Status Register) for Node 1</td>
<td></td>
<td>9052</td>
<td>Output 8 for Node 1</td>
<td></td>
</tr>
<tr>
<td>7853</td>
<td>Input 8 (Status Register) for Node 2</td>
<td></td>
<td>9053</td>
<td>Output 8 for Node 2</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848 contains the input 1 value for Node 47.

**Internal Local Registers (ID 199) for the DXM100 and DXM150**
The main storage elements for the DXM are its Local Registers, which can store 4-byte values that result from register mapping, action rules, or ScriptBasic commands.

- Local Registers 1 through 850 are standard 32-bit unsigned registers.
- Local Registers 851 through 900 are non-volatile registers that are limited to 100,000 write cycles.
- Local Registers 1001 through 1900 are floating point format numbers. Each register address stores half of a floating point number. For example, registers 1001 and 1002 store the first full 32-bit floating point number.
- Local Registers 10001 through 19000 are system, read-only, registers that track DXM data and statistics.
Modbus Registers for Internal Local Registers (Modbus ID 199)

<table>
<thead>
<tr>
<th>Local Registers</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–845</td>
<td>32-bit unsigned</td>
<td>Internal processor memory</td>
</tr>
<tr>
<td>846–849</td>
<td>32-bit unsigned</td>
<td>Reset, Constant, Timer</td>
</tr>
<tr>
<td>851–900</td>
<td>32-bit unsigned</td>
<td>Data flash, non-volatile</td>
</tr>
<tr>
<td>1001–1900</td>
<td>32-bit IEEE Floating Point</td>
<td>Floating point registers, internal processor memory</td>
</tr>
<tr>
<td>&gt; 10000</td>
<td></td>
<td>Read-only virtual registers</td>
</tr>
</tbody>
</table>

Local Registers 1–850 (Internal Processor Memory, 32-bit, Unsigned)—The Local Registers are the main global pool of registers. Local Registers are used as basic storage registers and as the common data exchange mechanism. External Modbus device registers can be read into the Local Registers or written from the Local Registers. The DXM, as a Modbus client device or a Modbus server device, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP) uses the Local Registers as the accessible register data.

Local Registers 851–900 (Data Flash, Non-volatile, 32-bit, Unsigned)—The top 50 Local Registers are special non-volatile registers. The registers can store constants or calibration type data that must be maintained when power is turned off. This register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these registers should not be used as common memory registers that change frequently.

Local Registers 1001–1900 (32-bit IEEE Floating Point)—These Local Registers are paired together to store a 32-bit IEEE floating point format number in big endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value; registers 1003, 1004 store the second floating point number. There are a total of 500 floating point values; they are addressed as two 16-bit pieces to accommodate the Modbus protocol. Use these registers when reading/writing external devices that require Modbus registers in floating point format. Since Modbus transactions are 16-bits, the protocol requires two registers to form a 32-bit floating point number.

Virtual Registers—The DXM has a small pool of virtual registers that show internal variables of the main processor. Some register values will be dependent upon the configuration settings of the DXM. Do not use Read Rules to move Virtual Local Registers data into Local Registers. Use the Action Rule > Register Copy function to move Virtual Local Registers into Local Registers space (1-850).

Virtual registers

<table>
<thead>
<tr>
<th>Virtual Registers</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>GPS latitude direction (N, S, E, W)</td>
</tr>
<tr>
<td>10002</td>
<td>GPS latitude</td>
</tr>
<tr>
<td>10003</td>
<td>GPS longitude direction (N, S, E, W)</td>
</tr>
<tr>
<td>10004</td>
<td>GPS longitude</td>
</tr>
<tr>
<td>10011–10012</td>
<td>Resync timer</td>
</tr>
<tr>
<td>10013–10014</td>
<td>Resync timer rollover</td>
</tr>
<tr>
<td>10015–10016</td>
<td>Reboot cause (Restart Codes above)</td>
</tr>
<tr>
<td>10017–10018</td>
<td>Watchdog reset count</td>
</tr>
<tr>
<td>10021</td>
<td>IO Board Battery Voltage (mV)</td>
</tr>
<tr>
<td>10022</td>
<td>IO Board - Incoming Supply Voltage (mV)</td>
</tr>
<tr>
<td>10023</td>
<td>Cut-off Feature</td>
</tr>
<tr>
<td>10024</td>
<td>IO Board - Battery Charging Current (mA)</td>
</tr>
<tr>
<td>10025–10026</td>
<td>Http Push SSL Acquires</td>
</tr>
<tr>
<td>10027–10028</td>
<td>Http Push SSL Releases</td>
</tr>
</tbody>
</table>

Continued on page 78
## Virtual Registers

<table>
<thead>
<tr>
<th>Register Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10029–10030</td>
<td>Http Push SSL Forced Releases</td>
</tr>
<tr>
<td>10031–10032</td>
<td>Http Push Attempts</td>
</tr>
<tr>
<td>10033–10034</td>
<td>Http Push Successes</td>
</tr>
<tr>
<td>10035–10036</td>
<td>Http Push Failures</td>
</tr>
<tr>
<td>10037–10038</td>
<td>Http Push Last Status</td>
</tr>
<tr>
<td>10039–10040</td>
<td>Cellular Strength, BER</td>
</tr>
<tr>
<td>10055–10056</td>
<td>Alarms, smtp, attempts</td>
</tr>
<tr>
<td>10057–10058</td>
<td>Alarms, smtp, fails</td>
</tr>
<tr>
<td>10059–10060</td>
<td>Alarms, sms, attempts</td>
</tr>
<tr>
<td>10061–10062</td>
<td>Alarms, sms, fails</td>
</tr>
<tr>
<td>10100–10109</td>
<td>Number of read maps in default</td>
</tr>
<tr>
<td>10110–10117</td>
<td>Number of write maps in default</td>
</tr>
<tr>
<td>10118–10125</td>
<td>Number of passthrough maps in default</td>
</tr>
</tbody>
</table>

### Http Push SSL Forced Releases
Statistical counts of connections, disconnections and forced disconnects when the DXM controller creates a connection using HTTP non-encrypted.

### Http Push Attempts

- Last DXM push status
  - 0 = Initial state, no push attempt as finished yet
  - 1 = Attempt complete
  - 2 = Attempt aborted

### Cellular Strength, BER
Cellular signal strength. Value range: 0–31
- 0 = –113 dBm or less
- 1 = –111 dBm
- 2–30 = –109 dBm through –53 dBm in 2 dBm steps
- 31 = –51 dBm or greater
- 99 = not known or not detectable; BER not used

### Alarms, smtp, attempts
Email attempts (only available with some model configurations)

### Alarms, smtp, fails
Email failures (only available with some model configurations)

### Alarms, sms, attempts
SMS text message attempts (only available with some model configurations)

### Alarms, sms, fails
SMS text message failures (only available with some model configurations)

### Read Map statistics

- Number of read map successes
- Number of read map timeouts
- Number of read map errors
- Read map success streak

### Write Map statistics

- Number of write map successes
- Number of write map timeouts
- Number of write map errors
- Write map success streak

### API message passing statistics

- Number of passthrough successes
- Number of passthrough timeouts
- Number of passthrough errors
- Passthrough success streak

### DX80 Gateway automatic messaging buffer statistics

- Number of 43 buffer successes
- Number of 43 buffer timeouts
- Number of 43 buffer errors
- 43 buffer success streak

### Read/Write maps statistics

- Read map success count
- Write map success count
- Read map timeout count
- Write map timeout count
- Read map error count
- Write map error count
- Read map is in default
The reset codes are in virtual register 11015 and define the condition of the last restart operation.

<table>
<thead>
<tr>
<th>Reset Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Undefined</td>
</tr>
<tr>
<td>1</td>
<td>Unknown</td>
</tr>
<tr>
<td>2</td>
<td>General</td>
</tr>
<tr>
<td>3</td>
<td>Brownout</td>
</tr>
<tr>
<td>4</td>
<td>Watchdog</td>
</tr>
<tr>
<td>5</td>
<td>User</td>
</tr>
<tr>
<td>6</td>
<td>Software</td>
</tr>
<tr>
<td>7</td>
<td>Return from backup mode</td>
</tr>
</tbody>
</table>

Modbus Registers for the -B1 and -S1 Model I/O Board

By default, the I/O board Modbus ID is 200.

**Base board input connection**

<table>
<thead>
<tr>
<th>Modbus Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Isolated discrete input 1 (1A and 1B)</td>
</tr>
<tr>
<td>2</td>
<td>Isolated discrete input 2 (2A and 2B)</td>
</tr>
<tr>
<td>3</td>
<td>Universal input 1</td>
</tr>
<tr>
<td>4</td>
<td>Universal input 2</td>
</tr>
<tr>
<td>5</td>
<td>Universal input 3</td>
</tr>
<tr>
<td>6</td>
<td>Universal input 4</td>
</tr>
<tr>
<td>7</td>
<td>Universal input 5</td>
</tr>
<tr>
<td>8</td>
<td>Universal input 6</td>
</tr>
<tr>
<td>9</td>
<td>Universal input 7</td>
</tr>
<tr>
<td>10</td>
<td>Universal input 8</td>
</tr>
</tbody>
</table>

**Base board output connection**

<table>
<thead>
<tr>
<th>Modbus Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>501</td>
<td>Relay 1</td>
</tr>
<tr>
<td>502</td>
<td>Not used</td>
</tr>
<tr>
<td>503</td>
<td>Relay 2</td>
</tr>
<tr>
<td>504</td>
<td>Not used</td>
</tr>
<tr>
<td>505</td>
<td>NMOS Output 5</td>
</tr>
<tr>
<td>506</td>
<td>NMOS Output 6</td>
</tr>
<tr>
<td>507</td>
<td>NMOS Output 7</td>
</tr>
<tr>
<td>508</td>
<td>NMOS Output 8</td>
</tr>
<tr>
<td>509</td>
<td>DAC Output 1</td>
</tr>
<tr>
<td>510</td>
<td>DAC Output 2</td>
</tr>
</tbody>
</table>
Modbus Registers for the -B2 and -S2 I/O Board

By default, the I/O board Modbus ID is 200.

**Base board input connection**

<table>
<thead>
<tr>
<th>Modbus Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Optically isolated input 1</td>
</tr>
<tr>
<td>2</td>
<td>Optically isolated input 2</td>
</tr>
<tr>
<td>3</td>
<td>Universal input 1</td>
</tr>
<tr>
<td>4</td>
<td>Universal input 2</td>
</tr>
<tr>
<td>5</td>
<td>Universal input 3</td>
</tr>
<tr>
<td>6</td>
<td>Universal input 4</td>
</tr>
<tr>
<td>7</td>
<td>Universal input 5</td>
</tr>
<tr>
<td>8</td>
<td>Universal input 6</td>
</tr>
<tr>
<td>9</td>
<td>Universal input 7</td>
</tr>
<tr>
<td>10</td>
<td>Universal input 8</td>
</tr>
</tbody>
</table>

**Base board output connection**

<table>
<thead>
<tr>
<th>Modbus Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>501</td>
<td>PNP/NPN Output 1</td>
</tr>
<tr>
<td>502</td>
<td>PNP/NPN Output 2</td>
</tr>
<tr>
<td>503</td>
<td>PNP/NPN Output 3</td>
</tr>
<tr>
<td>504</td>
<td>PNP/NPN Output 4</td>
</tr>
<tr>
<td>505</td>
<td>PNP/NPN Output 5</td>
</tr>
<tr>
<td>506</td>
<td>PNP/NPN Output 6</td>
</tr>
<tr>
<td>507</td>
<td>PNP/NPN Output 7</td>
</tr>
<tr>
<td>508</td>
<td>PNP/NPN Output 8</td>
</tr>
<tr>
<td>509</td>
<td>DAC Output 1</td>
</tr>
<tr>
<td>510</td>
<td>DAC Output 2</td>
</tr>
</tbody>
</table>

**Board output settings**

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
<th>Values</th>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3704</td>
<td>Enable Discrete Output 1</td>
<td>0 = NPN; 1 = PNP</td>
<td>3705</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3724</td>
<td>Enable Discrete Output 2</td>
<td>0 = NPN; 1 = PNP</td>
<td>3725</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3744</td>
<td>Enable Discrete Output 3</td>
<td>0 = NPN; 1 = PNP</td>
<td>3745</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3764</td>
<td>Enable Discrete Output 4</td>
<td>0 = NPN; 1 = PNP</td>
<td>3765</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3784</td>
<td>Enable Discrete Output 5</td>
<td>0 = NPN; 1 = PNP</td>
<td>3785</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3804</td>
<td>Enable Discrete Output 6</td>
<td>0 = NPN; 1 = PNP</td>
<td>3805</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3824</td>
<td>Enable Discrete Output 7</td>
<td>0 = NPN; 1 = PNP</td>
<td>3825</td>
<td>Invert Output</td>
</tr>
<tr>
<td>3844</td>
<td>Enable Discrete Output 8</td>
<td>0 = NPN; 1 = PNP</td>
<td>3845</td>
<td>Invert Output</td>
</tr>
</tbody>
</table>

For example, to change between PNP/NPN outputs, set parameter register 3704 to 0 for NPN and 1 for PNP.
Modbus Configuration Registers for the Discrete and Universal Inputs

Modbus configuration registers are identified below. The configuration software creates a graphical view of the I/O board parameters. This allows for easy and quick configuration of the I/O board parameters.

For the DXM150-Bx models, use the DXM Configuration Software to configure the registers using the Local Registers › Local Registers in Use › Edit Registers screen.

For the DXM150-Sx models, a DXM client radio is required to access the remote Modbus server device and configure the discrete and universal inputs. Manually write to these Modbus registers to set parameters or configure the input parameters using the Configuration › Configure Device › Inputs screen of the MultiHop Configuration Software.

Registers for isolated discrete input 1

<table>
<thead>
<tr>
<th>Register</th>
<th>Isolated Discrete Input 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>3013</td>
<td>Enable rising edge counter</td>
</tr>
<tr>
<td>3014</td>
<td>Enable falling edge counter</td>
</tr>
<tr>
<td>3015</td>
<td>High register for counter</td>
</tr>
<tr>
<td>3016</td>
<td>Low register for counter</td>
</tr>
</tbody>
</table>

Registers for isolated discrete input 2

<table>
<thead>
<tr>
<th>Register</th>
<th>Isolated Discrete Input 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>3033</td>
<td>Enable rising edge counter</td>
</tr>
<tr>
<td>3034</td>
<td>Enable falling edge counter</td>
</tr>
<tr>
<td>3035</td>
<td>High register for counter</td>
</tr>
<tr>
<td>3036</td>
<td>Low register for counter</td>
</tr>
</tbody>
</table>

Universal input parameter Modbus registers

<table>
<thead>
<tr>
<th>Universal Inputs</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Full Scale</td>
<td>3303</td>
<td>3323</td>
<td>3343</td>
<td>3363</td>
<td>3383</td>
<td>3403</td>
<td>3423</td>
<td>3443</td>
</tr>
<tr>
<td>Temperature °C/F</td>
<td>3304</td>
<td>3324</td>
<td>3344</td>
<td>3364</td>
<td>3384</td>
<td>3404</td>
<td>3424</td>
<td>3444</td>
</tr>
<tr>
<td>Input Type</td>
<td>3306</td>
<td>3326</td>
<td>3346</td>
<td>3366</td>
<td>3386</td>
<td>3406</td>
<td>3426</td>
<td>3446</td>
</tr>
<tr>
<td>Threshold</td>
<td>3308</td>
<td>3328</td>
<td>3348</td>
<td>3368</td>
<td>3388</td>
<td>3408</td>
<td>3428</td>
<td>3448</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>3309</td>
<td>3329</td>
<td>3349</td>
<td>3369</td>
<td>3389</td>
<td>3409</td>
<td>3429</td>
<td>3449</td>
</tr>
<tr>
<td>Enable Rising</td>
<td>4908</td>
<td>4928</td>
<td>4948</td>
<td>4968</td>
<td>4988</td>
<td>5008</td>
<td>5028</td>
<td>5048</td>
</tr>
<tr>
<td>Enable Falling</td>
<td>4909</td>
<td>4929</td>
<td>4949</td>
<td>4969</td>
<td>4989</td>
<td>5009</td>
<td>5029</td>
<td>5049</td>
</tr>
<tr>
<td>High Register for Counter</td>
<td>4910</td>
<td>4930</td>
<td>4950</td>
<td>4970</td>
<td>4990</td>
<td>5010</td>
<td>5030</td>
<td>5050</td>
</tr>
<tr>
<td>Low Register for Counter</td>
<td>4911</td>
<td>4931</td>
<td>4951</td>
<td>4971</td>
<td>4991</td>
<td>5011</td>
<td>5031</td>
<td>5051</td>
</tr>
</tbody>
</table>

Universal input register ranges

<table>
<thead>
<tr>
<th>Register Types</th>
<th>Unit</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete input/output</td>
<td></td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Universal input 0 to 10 V</td>
<td>mV</td>
<td>0</td>
<td>10000 *</td>
</tr>
<tr>
<td>Universal input 0 to 20 mA</td>
<td>µA</td>
<td>0</td>
<td>20000 *</td>
</tr>
<tr>
<td>Universal input temperature –40 °C to +85 °C</td>
<td>C or F, signed, in tenths of a degree</td>
<td>–400</td>
<td>850</td>
</tr>
<tr>
<td>Universal potentiometer</td>
<td>unsigned</td>
<td>0</td>
<td>65535</td>
</tr>
</tbody>
</table>

* Setting Enable Full Scale to 1 sets the ranges to a linear scale of 0 to 65535.
Modbus Configuration Registers for the Analog Output

The I/O base board has two analog outputs that are selectable as 0 to 20 mA (factory default) or 0 to 10 V. To change the analog output characteristic, physical jumpers on the I/O board and a Modbus register parameter must both be changed.

For step-by-step instructions on changing the output characteristics see "GUID-A2BE672D-663F-44BC-A564-3DD2E7053C49" on page 0.

Parameters for Analog Output 1 start at 4001 through 4008. Parameters for Analog Output 2 start at 4021 through 4028.

<table>
<thead>
<tr>
<th>Analog output 1</th>
<th>Analog output 2</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>4001</td>
<td>4021</td>
<td>Maximum Analog Value</td>
<td></td>
</tr>
<tr>
<td>4002</td>
<td>4022</td>
<td>Minimum Analog Value</td>
<td></td>
</tr>
<tr>
<td>4003</td>
<td>4023</td>
<td>Enable Register Full Scale</td>
<td>0 = Store readings in unit-specific data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Linear rate from 0 to 65535</td>
</tr>
<tr>
<td>4004</td>
<td>4024</td>
<td>Hold Last State Enable</td>
<td>0 = Disables Hold Last State and uses the Default Output State setting during an error condition</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Sets the output to its last known value</td>
</tr>
<tr>
<td>4005</td>
<td>4025</td>
<td>Default Output State</td>
<td></td>
</tr>
<tr>
<td>4008</td>
<td>4028</td>
<td>Analog Output Type</td>
<td>0 to 20 mA or 0 to 10 V DC output (I/O board jumper selectable)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Accuracy: 0.1% of full scale +0.01% per °C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Resolution: 12-bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>After changing the jumper position, write the appropriate value to the Modbus registers to define your analog output to match the setting selected by the jumper.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = 0 to 20 mA output (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = 0 to 10 V output</td>
</tr>
<tr>
<td>2952</td>
<td></td>
<td>Enable Default Communication Timeout</td>
<td>0 = Disable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Enable</td>
</tr>
<tr>
<td>2953</td>
<td></td>
<td>Communication Default I/O Timeout (100 ms/Count)</td>
<td>Number of 100 ms periods</td>
</tr>
<tr>
<td>2954</td>
<td></td>
<td>Enable Default on Power Up</td>
<td>0 = Disable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Sends device outputs to their default condition</td>
</tr>
</tbody>
</table>

**Analog Output Type**—The analog outputs may be configured as either 0 to 20 mA outputs (default) or 0 to 10 V outputs. To change the analog output type change the hardware jumper position and write to the Modbus register that defines the analog output type. For analog output 1, write to Modbus register 4008, for analog output 2 write to Modbus register 4028. Write a value of 2 (default) to select 0 to 20 mA; write a value of 3 to select 0 to 10 V.

**Default Output Conditions**—Default output triggers are the conditions that drive outputs to defined states. Example default output conditions include when radios are out of sync, when a device cycles power, or during a host communication timeout.

- **2952 Enable Default Communication Timeout**—A “communication timeout” refers to the communication between any Modbus client host and the DXM baseboard. Set this register to 1 to enable the default condition when the host has not communicated with the DXM baseboard for the period of time defined by the Communication Default IO Timeout.

- **2953 Communication Default I/O Timeout (100 ms/Count)**—This parameter defines the host timeout period in 100-millisecond increments. If a host does not communicate within this timeout period, the device outputs are set to the default values.

- **2954 Enable Default on Power Up**—Setting this parameter to 1 sends the device outputs to their default condition when the DXM baseboard is powered up. Set to 0 to disable this feature.

**Default Output State**—The Default Output State parameter represents the default condition of the analog output. When an error condition exists, the outputs are set to this 16-bit user-defined output state. To define the error conditions for device outputs, refer to the MultiHop default output parameters 2950–2954.

**Enable Register Full Scale**—Set to 1 to enable a linear range from 0 to 65535 for the specified input range. For a 4 to 20 mA output, a value of 0 represents 4 mA and 65535 represents 20 mA. Set this parameter to 0 to store readings in unit-specific...
data. For example, the register data representing a 15.53 mA reading is 15530. For units of current (0 to 20 mA outputs), values are stored as µA (micro Amps), and voltage values are stored as mV (millivolts).

**Hold Last State Enable**—Set the Hold Last State to 1 to set the output to its last known value before the error occurred. Set this parameter to 0 to disable the Hold Last State and use the Default Output State setting during an error condition.

**Maximum Analog Value**—The Maximum Analog Value register stores the maximum allowed analog value. The specific units of measure apply to the register value. For example, the register may contain 20000, for 20 mA, or for a voltage output the register may contain 8000, for 8 volts.

**Minimum Analog Value**—The Minimum Analog Value register stores the minimum allowed analog value. The specific units of measure apply to register value. For example, the register may contain 4000, for 4 mA, or for a voltage output the register may contain 2000, for 2 volts.

**Modbus Configuration Registers for the IO (Definitions)**

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Full Scale</td>
<td>Set to 1 to enable a linear range from 0 to 65535 for specified input range. For a 4 to 20 mA input, a value of 0 represents 4 mA and 65535 represents 20 mA. Set this parameter to 0 to store input readings in unit-specific data. For example, the register data representing a 15.53 mA reading is 15530. For units of current (0 to 20 mA inputs), values are stored as µA (micro Amps) and voltage values are stored as mV (millivolts).</td>
</tr>
</tbody>
</table>

**Enable Rising/Falling**

Use these registers to enable the universal input logic to count on a rising transition or a falling transition. Write a one (1) to enable; write a zero (0) to disable.

**High/Low Register for Counter**

The low and high registers for the counter hold the 32-bit counter value. To erase the counter, write zeroes to both registers. To preset a counter value, write that value to the appropriate register.

**Hysteresis and Threshold**

Threshold and hysteresis work together to establish the ON and OFF points of an analog input. The threshold defines a trigger point or reporting threshold (ON point) for a sensor input. When the input value is higher than the threshold, the input is ON. Hysteresis defines how far below the threshold the analog input is required to be before the input is considered OFF. A typical hysteresis value is 10% to 20% of the unit’s range.

In the example shown, the input is considered on at 15 mA. To consider the input off at 13 mA, set the hysteresis to 2 mA. The input will be considered off when the value is 2 mA less than the threshold.

**Input Type**

Program the universal inputs to accept input types NPN, PNP, 10k thermistor, 0 to 10 V, 0 to 20 mA, or potentiometer. The default setting is 8: NPN raw fast. To set the input type, write the following values to the Input Type Modbus registers.

- 0 = NPN
- 1 = PNP
- 2 = 0 to 20 mA
- 3 = 0 to 10 V DC
- 4 = 10k Thermistor
- 5 = Potentiometer Sense (DXM150 only)
- 6 = Not used
- 7 = Bridge
- 8 = NPN Raw Fast (default)

**Temperature °C/°F**

Set to 1 to represent temperature units in degrees Fahrenheit, and set to 0 (default) to represent temperature units in degrees Celsius.

**Modbus Configuration Registers for Power**

To monitor the input power characteristics of the DXM, read the following power Modbus registers. The on-board thermistor is not calibrated, but can be used as a non-precision temperature input.
Configuration registers for power

<table>
<thead>
<tr>
<th>Modbus Register</th>
<th>Description</th>
</tr>
</thead>
</table>
| 6071            | Battery backup charging algorithm.  
|                 | 0 = Battery is recharged from a solar panel  
|                 | 1 = Battery is recharged from 12 to 30 V DC (default) |
| 6081            | Battery voltage (mV). If no battery is present, the value in this register is less than 5 V. If the value in this register is greater than the incoming voltage register, the battery is powering the system. |
| 6082            | Battery charging current (mA). The charging configuration charges the battery when the incoming voltage register value is greater than the battery voltage register value. This register shows the charging current in milliamps. |
| 6083            | Incoming supply voltage (mV) (solar or power supply). The incoming power can be from a solar panel or from a power supply. The battery is charging when the incoming voltage register value is greater than the battery voltage register value. The battery is powering the system when the incoming voltage register value is less than the battery voltage register value. |
| 6084            | On-board thermistor temperature (°C). A thermistor measures the temperature of the solar controller board and its surrounding area and uses the temperature as part of the battery charge calculations. This register stores the thermistor reading in tenths of degrees C. This is not a calibrated input: divide by 10 to calculate the temperature in degrees C. For calibrated temperature inputs, define one of the universal inputs as a temperature input. |

Modbus Registers for the LCD Board (Slave ID 201)

Control the four user-defined LEDs using the display board’s Modbus registers. Using write maps or ScriptBasic, write to the Modbus registers shown.

Do not write to any other LCD Modbus registers. They are used by the LCD for menu data.

LED registers (Modbus ID 201)

<table>
<thead>
<tr>
<th>Registers</th>
<th>I/O Connection</th>
<th>Parameter</th>
</tr>
</thead>
</table>
| 1102      | LED 1 (top, green) | 0 = Off  
|           |                 | 1 = On |
| 1103      | LED 2 (red)     |          |
| 1104      | LED 3 (amber)   |          |
| 1105      | LED 4 (bottom, amber) |   |

Using the Display LEDs

Turn on the DXM LEDs by writing to the LEDs’ Modbus registers.

This example shows how to configure the DXM using the configuration software to read four universal inputs and write the state values to the display LEDs.

1. Using the configuration software, go to the Local Registers › Local Registers in Use screen.
2. Define the local registers by assigning names to the first four registers and setting the LCD permissions parameter to read/write. The LCD permissions show the register contents on the LCD menu under the REGISTER menu. You can also set the value from the LCD menu.
3. Create a Read Rule to read the four universal inputs from the I/O board (Modbus ID 200) and write the values in local registers 1 through 4.
After a configuration file is uploaded, the DXM reboots. The new configuration is now running.

Turning on any one of the universal inputs 1 through 4 on the I/O base board of the DXM now turns on an LED on the display.

On the DXM's LCD menu, the arrow on the left side of the register line indicates this local register can be written to. Try changing the configuration to delete the Read Rule then turn on/off the LEDs by changing the register value through the LCD display.

Using the Auxiliary Power Outputs
The DXM has two auxiliary power outputs, pin 35 and pin 45. They are controlled by hardware jumpers on the I/O base board. Refer to the wiring board diagram for more information.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Pin 35, Pin 45 | The auxiliary power outputs are controlled by hardware jumpers (PWR Out jumper bank). Jumper 2 is the power jumper for pin 45. Jumper 1 is the power jumper for pin 35.  
|            |  - The pin 45 jumper selects 2.7 V when in the "a" position and 12 V battery in the "b" position.  
|            |  - The pin 35 jumper selects 4.2 V when in the "a" position and device power on pin 2 in the "b" position. |
Working with Solar Power
A reliable solar system requires careful planning and monitoring to size the components correctly. The recommendations provided are for the DXM system as an autonomous system.

Adding extra components increases the power requirements and likely requires increasing the solar system components. Depending upon the geographical location, the size of the solar panel and battery may vary.

Setting the DXM for Solar Power
By default, the DXM is set from the factory to charge a backup battery from a line power source.

For DXM models with an LCD, use the buttons and menu system to change the charging algorithm to solar power. Go to System Config > I/O Board > Charger. Use the up/down arrows to select Solar.

For DXM models without an LCD, use the configuration software to adjust the I/O board Modbus register 6071. Set the register to 0 to select battery charging from a solar panel, and set to 1 to select battery charging from incoming 12 to 30 V DC supply.

To minimize the power consumption (may not apply to all models):
- If Ethernet is not being used, save up to 25% of the consumed power by disabling Ethernet. Set DIP switch 1 to the ON position on the processor board then reboot.
- Instead of powering external devices all the time, take advantage of the switched power mechanisms to turn off devices when possible.
- Minimize the number of cellular transactions and the amount of data pushed across the cellular modem.

Solar Components
The components of a solar system include the battery and the solar panel.

Battery
The DXM solar controller is designed to use a 12 V sealed lead acid (SLA) battery. The characteristics of a solar system require the battery to be of a certain type. There are two types of lead acid batteries:
- SLI batteries (Starting Lights Ignition) designed for quick bursts of energy, like starting engines
- Deep Cycle batteries - greater long-term energy delivery. This is the best choice for a solar battery.

Since a solar system charges and discharges daily, a deep cycle battery is the best choice. There are different versions of a lead acid battery: wet cell (flooded), gel cell, and an absorbed glass mat (AGM).

Wet cell batteries are the original type of rechargeable battery and come in two styles, serviceable and maintenance free. Wet cell batteries typically require special attention to ventilation as well as periodic maintenance but are the lowest cost. The gel cell and AGM battery are sealed batteries that cost more but store very well and do not tend to sulfate or degrade as easily as a wet cell. Gel or AGM batteries are the safest lead acid batteries you can use.

Battery capacity is a function of the ambient temperature and the rate of discharge. Depending upon the specific battery, a battery operating at –30 °C can have as much as 40 percent less capacity than a battery operating at 20 °C. Choose enough battery capacity based on your geographical location.

<table>
<thead>
<tr>
<th>State of Charge (%)</th>
<th>Open Circuit Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>13.0 or higher</td>
</tr>
<tr>
<td>75</td>
<td>12.6</td>
</tr>
<tr>
<td>50</td>
<td>12.1</td>
</tr>
<tr>
<td>25</td>
<td>11.66</td>
</tr>
<tr>
<td>0</td>
<td>11.4 or less</td>
</tr>
</tbody>
</table>

© Banner Engineering Corp.
June 05, 2023
A larger capacity battery typically lasts longer for a given solar application because lead-acid batteries do not like deep cycling (discharging a large percentage of its capacity). Depending upon the battery, a battery discharging only 30 percent of its capacity before recharging will have approximately 1100 charge/discharge cycles. The same battery discharging 50 percent of its capacity will have approximately 500 charge/discharge cycles. Discharging 100 percent leaves the battery with only 200 charge/discharge cycles.

Use this information as a guide to the approximate state of charge and in determining when to apply conservation measures. Batteries degrade over time based on discharge/charge cycles and environmental conditions. Always monitor the battery system to obtain the best performance of the solar powered system.

Solar Panel
Banner solar panels come in two common sizes for the DXM: 5-watt and 20-watt. Both panels are designed to work with the DXM but provide different charging characteristics. Use the 5-watt panel for light-duty operation and use the 20-watt panel when you require greater charging capabilities.

<table>
<thead>
<tr>
<th>Solar Panel</th>
<th>Voltage</th>
<th>Current (A)</th>
<th>Typical DXM Configurations</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 Watt</td>
<td>17 V</td>
<td>0.29 A</td>
<td>DXM Controller configured as a server, ISM radio, I/O base board</td>
</tr>
<tr>
<td>20 Watt</td>
<td>21 V</td>
<td>1 A</td>
<td>DXM Controller with ISM radio and Cellular modem</td>
</tr>
</tbody>
</table>

Photovoltaic panels are very sensitive to shading. Unlike solar thermal panels, PV solar panels cannot tolerate shading from a branch of a leafless tree or small amounts of snow in the corners of the panel. Because all cells are connected in a series string, the weakest cell will bring down the other cells' power level.

Good quality solar panels will not degrade much from year to year, typically less than 1 percent.

To capture the maximum amount of solar radiation throughout the year, mount a fixed solar panel to optimize the sun's energy. For the northern hemisphere, face the panel true south. For the southern hemisphere, face the panel true north. If you are using a compass to orientate the panels, compensate for the difference between true north and magnetic north. Magnetic declination varies across the globe.

A solar panel's average tilt from horizontal is at an angle equal to the latitude of the site location. For optimum performance, adjust the tilt by plus 15 degrees in the winter or minus 15 degrees in the summer. For a fixed panel with a consistent power requirement throughout the year, adjust the tilt angle to optimize for the winter months: latitude plus 15 degrees. Although in the summer months, the angle may not be the most efficient, there are more hours of solar energy available.

For sites with snow in the winter months, the increased angle helps to shed snow. A solar panel covered in snow produces little or no power.

Recommended Solar Configurations
These solar panel and battery combinations assume direct sunlight for at least two to three hours a day. Solar insolation maps provide approximate sun energy for various locations. The depth of battery discharge is assumed to be 50 percent.

<table>
<thead>
<tr>
<th>Solar Panel Output (W)</th>
<th>Battery Capacity (Ahr)</th>
<th>Days of Autonomy</th>
<th>DXM Current (mA)</th>
<th>DXM Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>10</td>
<td>10</td>
<td>25</td>
<td>DXM-Sx models with an ISM radio and I/O base board</td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>10</td>
<td>30</td>
<td>DXM-Bx models with an ISM radio and no cellular modem</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>10</td>
<td>35</td>
<td>DXM-Bx models with an ISM radio and cellular modem</td>
</tr>
</tbody>
</table>

Battery capacity (amp hour) is a standard amp rating taken for 20 hours. Battery capacity should be monitored for reliable system power and may need to be increased for cold weather locations.

Monitoring Solar Operation
The DXM solar controller provides Modbus registers that allow the user to monitor the state of the solar panel input voltage, the battery voltage, the charging current, and the temperature in °C. The DXM can be configured to monitor the health of the charging system as well as send an alert message when the battery is too low.
The charts show a typical charging cycle, with each vertical grid representing about eight hours. The chart shows three days of charging.

**Solar Panel Voltage (mV) -- Cloudy First Day**

**Battery Voltage (mV) - Cloudy First Day**

**Clear the Password on DXM100 and DXM150 Models Only**

By default, the DXM Controllers does not require a password to load a configuration file. If a password is defined, the password must be entered before uploading a configuration file. To change the password, you must already know the current password. If you do not know the current password, follow these steps to clear the password.

**IMPORTANT:** Clearing the password erases the current configuration and any program files, log files, or history files.

**IMPORTANT:** DO NOT follow these instructions if you have a DXM700, DXM1000, or DXM1500 model. If you attempt to clear the password of a DXM700, DXM1000, or DXM1500 with these instructions, the firmware of your device will be erased and your controller will no longer function.

1. Turn the power OFF to the DXM Controller.
2. Set DIP switch 4 to the ON position.
3. Press and hold the processor button.
4. Turn the power ON to the DXM Controller.
   - The processor board's LED flashes to indicate the process is complete (about 10-20 seconds).
5. Set DIP switch 4 to the OFF position.
6. Cycle power to the DXM Controller.
7. Reload the configuration file before resuming normal operation.
All measurements are listed in millimeters [inches], unless noted otherwise.

*Dimensions for the DXM150 and DXM1500 models*
Chapter 11  Troubleshooting

Restoring Factory Default Settings for the IO Base Board

To reset the I/O base board to factory defaults, write to two Modbus registers in the base board. The default ID for the base board is 200.

To reset the DXM I/O base board parameters back to factory defaults:
1. Write a 1 to Modbus register 4152
2. Write a 10 to Modbus register 4151

To reboot (cycle power) the DXM I/O base board:
1. Write a 0 to Modbus register 4152
2. Write a 10 to Modbus register 4151

### Restoring Factory Defaults for the I/O Base Board

<table>
<thead>
<tr>
<th>Register</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4151</td>
<td>0–255</td>
<td>Reset/restore trigger. This timer is based in 100 millisecond units. Once written, the timer starts to count down to zero. After the timer expires, the restore factory defaults are applied if register 4152 = 1. If register 4152 is zero, the I/O board is reset. Default value: 0. 1 = 100 milliseconds, 10 = 1 second.</td>
</tr>
<tr>
<td>4152</td>
<td>0–1</td>
<td>0 = Reboots (cycles power) to the I/O base board 1 = Restores factory defaults for I/O parameters</td>
</tr>
</tbody>
</table>

Updating the DXM Processor Firmware

There are two different update procedures, depending on the DXM firmware version of your device.

**Update Your DXM Processor Firmware (Prior to Version 2.0)**

To update DXM Processor firmware prior to version 2.0, use the SAM-BA program from MicroChip/Atmel. Following these instructions to update the DXM100 or DXM150 processor firmware.

2. Install the SAM-BA program.
3. Set the processor board jumper (jumper C, shown below in the "boot load off" position).
a. Disconnect the DXM Controller from its power supply.
b. Open the hardware cover.
c. Using your fingers or tweezers, move the jumper to the "boot load on" position (jumper on the top two pins).
d. Connect the DXM back to its power supply.
e. The lower left LED on the I/O base board is solid when power is turned on. After the LED begins flashing, remove power.
f. Move the jumper back to its original position.
g. Replace the hardware cover.
h. Connect the DXM back to its power supply.

4. Launch the SAM-BA program. Select the COM port and correct board. Click **CONNECT**.

5. On the **SCRIPTS** pull-down menu select **ENABLE FLASH ACCESS**. Click **EXECUTE**.
Updating Your DXM Processor Firmware (Version 2 or Later)

DXMs with processor firmware version 2.0 or later have a built-in boot loader program to update the firmware. Use the configuration software version 3 or later, the BannerCDS webserver, or manually write the files on the SD card to update the firmware.

The new firmware file loads into the **BOOT** directory of the SD card on the DXM. The configuration software or BannerCDS website handles the reprogramming process automatically. During the programming process, the internal LEDs on the processor board indicate the status of the programming.

6. In the **SCRIPTS** pull-down menu, select **BOOT FROM FLASH (GPNVM1)**. Click **EXECUTE**. Click **EXECUTE** again if the message indicates it failed.

7. In the **Flash** tab, click on the folder icon for the **Send File Name** field. Select the boot load file (must be a *.bin file) and click **SEND FILE**. The file is: **DXM PROCESSOR FIRMWARE V2.02** or go to the software section of the Wireless Reference Library on [www.bannerengineering.com](http://www.bannerengineering.com).

8. After the load is complete, the program asks if you want to lock the flash region. Click **NO**.

9. Close the SAM-BA bootloader program.

10. Cycle the power to the DXM.

   The new code should now be running and the LEDs should be on.

© Banner Engineering Corp.
Update process overview

<table>
<thead>
<tr>
<th>Reprogramming Step</th>
<th>Approximate time required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loading new firmware file (*.HEX)</td>
<td>configuration software: 2 minutes over Ethernet or 15 minutes over USB BannerCDS: 2 minutes over Ethernet or 5 minutes over Cellular</td>
<td>Send the new firmware image to the DXM. After the new image is on the device, the controller resets. LED3 is red during the loading process.</td>
</tr>
<tr>
<td>Verify the contents of the new firmware file</td>
<td>1 minute</td>
<td>When the DXM finds a file that should be installed, LED4 (amber) flashes at about a 1 second rate while the contents of the file are validated.</td>
</tr>
<tr>
<td>New firmware file is valid</td>
<td></td>
<td>After validation successfully completes, LED4 is on (amber).</td>
</tr>
<tr>
<td>New firmware file is being loaded</td>
<td>2 minutes; do not remove power to the DXM during the programming process.</td>
<td>LED3 (red) blinks approximately once per second. LED3 continues to blink during the application programming process.</td>
</tr>
<tr>
<td>Finished</td>
<td></td>
<td>After programming has completed, the DXM resets and begins running the new firmware</td>
</tr>
</tbody>
</table>

The firmware file names follow an 8.3 filename convention. The first 5 characters are the firmware part number in hexadecimal; the last 3 characters of the part number are the major/minor version number. For example, if 30FA9052.hex is the firmware programming file, 200617 decimal (30FA9 hex) is the firmware part number and 0.5.2 (0502) is the decoded version number.

Update Your DXM Processor Firmware Using the DXM Configuration Software

To update your processor firmware using the DXM Configuration Software, follow these instructions.

1. Using the DXM Configuration Software version 3 or later, connect to the DXM via USB\(^{(1)}\) or Ethernet. File loads to the DXM will take about 15 minutes using USB or approximately 2 minutes using Ethernet.

2. On the configuration software, go to Settings > General > Device Information to verify the current firmware version. You must load a different version with the same firmware number for the boot loader to operate. Download firmware files from the Banner website.

3. Under Settings > Reprogram, click Select upgrade file to select the firmware file to program.

After the file load is completed, the DXM restarts and loads the new firmware file. It takes about 2 minutes to complete the programming process. The device reboots when finished. Verify the firmware has been updated, under Settings > General > Device Information.

Update Your Processor Firmware Using the BannerCDS Website

To update your processor firmware (version 2.0 or later) using the DXM website, follow these instructions.

To use the website to update the firmware file, first configure the DXM to push data to the website.

1. Go to Dashboard > Sites and click + to verify the current firmware part number and version on the DXM.

Data collected from the DXM is displayed.

---

\(^{(1)}\) While the file download is in process over a USB connection, do not use other applications on the PC. After the DXM reboots for a firmware update, the USB port may be unresponsive. Clear the connection by disconnecting the USB cable and restarting the DXM Configuration Software.
Update Your Processor Firmware Manually

To manually update your processor firmware (version 2.0 or later) using SD card, follow these instructions.

The firmware file can manually be put on the SD card in the BOOT directory (must have version 2.0 or later on the DXM).

2. From the main **Dashboard > Sites** screen, click on **Update**.
   A popup box appears.

3. Set the **Communications Type** to **Push Reply**, and set the **Update Type** to **Firmware file**.
4. Choose the appropriate **Upload File (*.HEX)** and click **Queue**. Click **Close**.

At the next scheduled push interval, the DXM retrieves the new firmware file. The new firmware file must be the same part number of firmware that is currently in the DXM.

1. Disconnect the DXM from its power supply.
2. Remove the micro SD card from the DXM.

   a. Open the cover housing to the DXM.
   b. Use your fingernail to slide the top metal portion of SD card holder.
   c. The metal cover hinges upward, allowing access to remove the SD card.
   d. Press down on the SD cover and slide back into position to close the SD card holder.

3. Insert the micro SD card into an SD card reader to access the data from a PC.
4. Load the new firmware file (*.hex) into the BOOT directory of the micro SD card.
5. Re-insert the micro SD card into the DXM by sliding the card into the holder.
6. Reconnect the DXM to its power supply.

   The automatic boot process should begin. If the boot process does not begin, verify the firmware file is correct and it is a different version than what is currently installed on the device.
Troubleshooting Issues

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Communication contention between the LCD and process | The LCD and the processor applications share the external Modbus connection. If the processor is configured to constantly interact with Modbus, it may cause issues with the LCD attempting to use the functions of the ISM radio. To alleviate the contention do one of these things:  
  • Load a DXM configuration file that slows down the read/write rules.  
  • Disable the DXM configuration file from loading into the processor by setting DIP switch 4 to ON (on the processor board). Reboot the device. When the processor reboots, it will not load the configuration file and remains idle. |
| Cellular modem did not turn on               | If the incoming voltage drops below 11.2 V DC, the cellular modem does not turn on and will not turn on until the voltage is above 11.8 V DC. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage. If cellular operation stops because of voltage, it is logged in this file. |

Modbus Operation

All Modbus transactions are managed by a central Modbus engine. If there are Modbus messages intended for a Modbus server that doesn't exist, the Modbus engine waits for a response until the timeout period is expired. This slows down the Modbus polling loop for read and write operations.

For this reason, verify all Modbus read and write operations are intended for Modbus server devices that are in the network. If a Modbus server is not in the network, either a wired or wireless device, the operation of the LCD menu system can be compromised. Operations like Binding, Site Survey, or accessing the ISM menu may be slower. This is because all internal devices (such as the ISM radio, LCD, etc) of the DXM are also Modbus servers.
## Accessories

For a complete list of all the accessories for the Sure Cross wireless product line, please download the Accessories List (p/n b_3147091).

### Cordsets
- MQDC1-506—5-pin M12, straight, single-ended, 6 ft
- MQDC1-530—5-pin M12, straight, single-ended, 30 ft
- MQDC1-506RA—5-pin M12, right-angle, single-ended, 6 ft
- MQDC1-530RA—5-pin M12, right-angle, single-ended, 30 ft

### Misc Accessories
- BWA-CG.5-3XS.6-10—Cable Gland Pack: 1/2-inch NPT, Cordgrip for 3 holes of 2.8 to 5.6 mm diam, 10 pack
- BWA-HW-052—Cable Gland and Vent Plug Pack: includes 1/2-inch NPT gland, 1/2-inch NPT multi-cable gland, and 1/2-inch NPT vent plug, one each

### Static and Surge Suppressor
- BWC-PRC827-DC—Surge Suppressor, bulkhead, DC Blocking, N-Type Female, N-Type Male

### Antenna Cables
- BWC-1MRSMN05—LMR200 RP-SMA to N-Type Male, 0.5 m
- BWC-2MRSFRS6—LMR200, RP-SMA Male to RP-SMA Female Bulkhead, 6 m
- BWC-4MNFN6—LMR400 N-Type Male to N-Type Female, 6 m

### Short-Range Omni Antennas
- BWA-2O2-D—Antenna, Dome, 2.4 GHz, 2 dBi, RP-SMA Box Mount
- BWA-9O2-D—Antenna, Dome, 900 MHz, 2 dBi, RP-SMA Box Mount
- BWA-9O2-RA—Antenna, Rubber Fixed Right Angle, 900 MHz, 2 dBi, RP-SMA Male Connector

### Medium-Range Omni Antennas
- BWA-9O5-C—Antenna, Rubber Swivel, 900 MHz 5 dBi, RP-SMA Male Connector
- BWA-2O5-C—Antenna, Rubber Swivel, 2.4 GHz 5 dBi, RP-SMA Male Connector

### Long-Range Omni Antennas
- BWA-9O8-AS—Antenna, Fiberglass, 3/4 Wave, 900 MHz, 8 dBi, N-Type Female Connector
- BWA-2O8-A—Antenna, Fiberglass, 2.4 GHz, 8 dBi, N-Type Female Connector

### Long-Range Yagi Antennas
- BWA-9Y10-A—Antenna, 900 MHz, 10 dBi, N-Type Female Connector

### Cellular Antenna
- BWA-CELLA-002—Cellular multiband, 2 dBi, RP-SMA male connection, 6.3 inch blade style. Datasheet: b_4475176

### Enclosures and DIN Rail Kits
- BWA-AH864—Enclosure, Polycarbonate, with Opaque Cover, 8 × 6 × 4
- BWA-AH1084—Enclosure, Polycarbonate, with Opaque Cover, 10 × 8 × 4
- BWA-AH12106—Enclosure, Polycarbonate, with Opaque Cover, 12 × 10 × 6
- BWA-AH8DR—DIN Rail Kit, 8", 2 trilobular/self-threading screws
- BWA-AH10DR—DIN Rail Kit, 10", 2 trilobular/self-threading screws
- BWA-AH12DR—DIN Rail Kit, 12", 2 trilobular/self-threading screws

### Power Supplies
- PSD-24-4—DC Power Supply, Desktop style, 3.9 A, 24 V DC, Class 2, 4-pin M12 quick disconnect (QD)
- PSDINP-24-13—DC power supply, 1.3 Amps, 24 V DC, with DIN Rail Mount, Class I Division 2 (Groups A, B, C, D) Rated
- PSDINP-24-25—DC power supply, 2.5 Amps, 24 V DC, with DIN Rail Mount, Class I Division 2 (Groups A, B, C, D) Rated
- BWA-SOLAR PANEL 20W—Solar Panel, 12 V, 20 W, Multicrystalline, 573 × 357 × 30, “L” style mounting bracket included (does not include controller)
Chapter 13  
Product Support and Maintenance

File System and Archive Process
The DXM file system consists of two physical components: the serial EEPROM that stores non-volatile configuration information and a removable micro SD card that stores file backup data and user-created files.

**EEPROM Files**—The serial EEPROM stores basic data that is required to be non-volatile, including network configuration data, IP address, MAC address, network masks, firewall settings, and authentication information. The controller XML configuration file created by the DXM Configuration Software is stored in EEPROM. The small section of non-volatile local registers is also stored in EEPROM.

**Micro SD Card Files**—The micro SD card contains most files at the root level. The archive directory contains files kept by the system for history backup. Archive files are stored in the directory _sxi and are only accessible by removing the SD card.

- Data Log Files
- HTTP Push Files
- User-created ScriptBasic file
- ScriptBasic program file
- CmVMon file
- _sxi Archive directory

**Data Log files**
Users may create up to four data log files using the DXM Configuration Software. The log files are stored in the root directory on the SD card. When the file size limit is reached, the filename is changed to include the date and time and the file is moved into the archive directory _sxi. Archived log files are deleted based on the Clear Logs parameter.

**HTTP Push File**
If the DXM is configured to send data to a webserver or host system, the device creates an HTTP LOG file on the SD card. The HTTP log is created only if the Logging Interval is non-zero and the HTTP enable log is set. An entry is placed in the HTTP log file at the Logging Interval specified by the user. At the Push Interval time, the HTTP log file is sent to the webserver or host system. If the transmission is successful, the HTTP log file is time stamped and placed into the archive directory (_sxi). If the transmission fails, the file remains in the root directory and subsequent Logging Intervals are appended to the file and are sent at the next Push Interval. See "Ethernet and Cellular Push Retries " on page 67.

**User Created ScriptBasic Files**
Users may use ScriptBasic to create files on the SD card by using the FILEOUT function. The filenames are fixed and up to five files can be created in the root directory.

**ScriptBasic Program File**
The main ScriptBasic program that runs at boot time is stored on the SD card in the root directory.
CmVMon File
The CmVMon.txt file (Cellular milli-Volt Monitor) is created by
the system and is used to track power events. Every power-up
cycle is date/time stamped with the voltage read from the I/O
board. The value 24487 is equal to 24.487 volts. If the voltage
drops below 11.2 V, another entry is put in the log file indicat-
ing the cellular modem will shut down.

<table>
<thead>
<tr>
<th>CM</th>
<th>Date/Time</th>
<th>Action</th>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM</td>
<td>2015-09-22 18:52:43</td>
<td>VMon</td>
<td>24487</td>
</tr>
<tr>
<td>CM</td>
<td>2015-10-13 20:49:47</td>
<td>VMon</td>
<td>24004</td>
</tr>
<tr>
<td>CM</td>
<td>2015-10-16 15:00:20</td>
<td>VMon</td>
<td>24014</td>
</tr>
<tr>
<td>CM</td>
<td>2015-10-19 19:12:26</td>
<td>VMon</td>
<td>12845</td>
</tr>
</tbody>
</table>

_dxI Archive Directory
Only two types of files are moved into the archive directory:
data log files and HTTP log files. Data log files are date/time
stamped and placed into the archive directory when the size
limit is reached. HTTP log files are date/time stamped then
placed into the archive directory when they are successfully
sent to the webserver or host system. If the HTTP log files
were not successfully sent after the retries have been ex-
hausted, the files are placed into a root directory called sav.

DXM150 Documentation
- DXM Wireless Controller Sell Sheet, p/n 194063
- DXM150-B1 Wireless Controller Datasheet, p/n 178136
- DXM150-B2 Wireless Controller Datasheet, p/n 195952
- DXM150-Bx Wireless Controller Instruction Manual, p/n 190038
- DXM150-S1 Modbus Server Datasheet, p/n 160171
- DXM150-S2 Modbus Server Datasheet, p/n 200634
- DXM150-Sx Modbus Server Instruction Manual, p/n 195455
- DXM ScriptBasic Instruction Manual, p/n 191745
- DXM Controller API Protocol, p/n 186221
- DXM Controller Configuration Quick Start, p/n 191247
- DXM Configuration Software v4, p/n b_4496867
- DXM Configuration Software v4 Instruction Manual, p/n 209933
- DXM EDS Configuration file for Allen-Bradley PLCs, p/n b_4205242
- EIP Configuration File for DXM 1xx-BxR1 and R3 models, p/n 194730
- Activating a Cellular Modem, p/n b_4419353
- Additional technical notes and videos

For more information about the DXM150 family of products, including technical notes, configuration examples, and ScriptBa-
sic programs, please visit www.bannerengineering.com/wireless.

DXM1500 Documentation
- DXM Wireless Controller Sell Sheet, p/n 194063
- DXM1500-B1 Wireless Controller Datasheet, p/n 210854
- DXM1500-B2 Wireless Controller Datasheet, p/n 210855
- DXM150-Bx and 1500-Bx Wireless Controller Instruction Manual, p/n 190038
- DXM ScriptBasic Instruction Manual, p/n 191745
- DXM Controller Configuration Quick Start, p/n 191247
- DXM Configuration Software (p/n b_4447978)
- DXM Configuration Software Instruction Manual, p/n 158447
- DXM EDS Configuration file for Allen-Bradley PLCs
- EIP Configuration File for DXM 1xx-BxR1 and R3 models (p/n 194730)
- Activating a Cellular Modem (p/n b_4419353)
- Video tutorials: Search "DXM Tutorial" at youtube.com/bannerengineering.
- Additional technical notes

For more information about the DXM1500 family of products, including technical notes, configuration examples, and Script-
Basic programs, please visit www.bannerengineering.com.

DXM Support Policy
The DXM Wireless Controllers are industrial wireless controllers that facilitate Industrial Internet of Things (IIoT) applications.
As a communications gateway, it interfaces local serial ports, local I/O ports, and local ISM radio devices to the Internet using
either a cellular connection or a wired Ethernet network connection. In a continuing effort to provide the best operation for
the DXM, stay connected with Banner Engineering Corp to hear about the latest updates through the Banner website. Create
a login today to stay informed of all Banner product releases.

Firmware Updates
The DXM has been designed to be a robust and secure IOT device. To provide the most reliable and secure device possible,
periodic firmware updates are released to enhance and expand the capabilities of the DXM. Firmware updates and descrip-
tion details are found on the Banner website. Customers with critical update requirements will get access to pre-released
firmware from the factory.

Website Information
The Banner website is the main method of disseminating DXM information to customers. The data found on the website in-
clude:
- DXM instruction manuals
- Configuration manuals
- Firmware downloads
- Firmware release notes
- Errata data, any known issues with a release of firmware
- Possible work-around solutions for known issues
- DXM Solutions Guides

Feature Requests
Our customer is our most valuable resource to improve our DXM. If you have suggestions for improvements to the DXM or
configuration tools, please contact Banner Engineering Corp.

Potential DXM Issues
Potential issues with the DXM are collected from Banner's support engineers to provide solutions. Users can get help from
the website documentation or by calling Banner Engineering for support help. Solutions are as simple as configuration adjust-
ments, work-around configuration solutions, or potential new firmware updates.

DXM Security
The DXM was designed to collect local wireless sensor data, local sensor data, provide simple control, and send the data to
the cloud.

The DXM does not run a Linux or Windows based operating system but an embedded real-time operating system (RTOS)
environment. As a proprietary operating system, the security aspects are easier to manage and minimize.

Security updates are released through the Banner Engineering Corp website (www.bannerengineering.com) and New Pro-
duct Release Announcements (NPRA).

FCC and ISED Certification, 900 MHz, 1 Watt Radios
This equipment contains transmitter module RM1809 or SX7023EXT.

<table>
<thead>
<tr>
<th>Radio Module RM1809</th>
<th>Radio Module SX7023EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC ID: UE3RM1809</td>
<td>FCC ID: UE3SX7023EXT</td>
</tr>
<tr>
<td>IC: 7044A-RM1809</td>
<td>IC: 7044A-SX7023EXT</td>
</tr>
<tr>
<td>HVIN: RM1809</td>
<td>HVIN: 223150</td>
</tr>
</tbody>
</table>

FCC Notices
IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified by the FCC / ISED for use with other
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.
IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified for fixed base station and mobile applications. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID label must be visible through a window on the final device or it must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside of the final device that contains the following text:

Transmitter Module [RM1809 or SX7023EXT]
Contains FCC ID: [UE3RM1809 or UE3SX7023EXT]
Contains IC: [7044A-RM1809 or 7044A-SX7023EXT]
HVIN: [RM1809 or 223150]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 2) This device must accept any interference received, including interference that may cause undesired operation.

Antenna WARNING: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in “Certified Antennas for 900 MHz 1 Watt” on page 102. When integrated into OEM products, fixed antennas require installation preventing end-users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
WARNING: Antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons.

AVISSEMMENT: Les antennes utilisées pour cet émetteur doivent être installées de manière à assurer une distance de séparation d’au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-transmitter product procedures.

The radio transmitter modules RM1809 and SX7023EXT have been approved by FCC and ISED Canada to operate with the antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 900 MHz 1 Watt

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Antenna Type</th>
<th>900 MHz Radio Module</th>
<th>Maximum Gain</th>
<th>Impedance</th>
<th>Minimum Required Cable/Connector Loss</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Integral Antenna</td>
<td>RM1809</td>
<td>Unity gain</td>
<td>50 Ω</td>
<td>0</td>
</tr>
<tr>
<td>BWA-901-x</td>
<td>Omni, 1/4 wave dipole</td>
<td>RM1809</td>
<td>≤2 dBi</td>
<td>50 Ω</td>
<td>0</td>
</tr>
<tr>
<td>BWA-902-C</td>
<td>Omni, 1/2 wave dipole, Swivel</td>
<td>RM1809 or SX7023EXT</td>
<td>≤2 dBi</td>
<td>50 Ω</td>
<td>0</td>
</tr>
<tr>
<td>BWA-906-A</td>
<td>Omni Wideband, Fiberglass Radome</td>
<td>RM1809</td>
<td>≤8.2 dBi</td>
<td>50 Ω</td>
<td>2.2 dB</td>
</tr>
<tr>
<td>BWA-905-B</td>
<td>Omni Base Whip</td>
<td>RM1809</td>
<td>≤7.2 dBi</td>
<td>50 Ω</td>
<td>1.2 dB</td>
</tr>
<tr>
<td>BWA-9Y10-A</td>
<td>Yagi</td>
<td>RM1809</td>
<td>≤10 dBi</td>
<td>50 Ω</td>
<td>4 dB</td>
</tr>
<tr>
<td>BWA-905-C</td>
<td>Coaxial sleeve</td>
<td>SX7023EXT</td>
<td>≤5 dBi</td>
<td>50 Ω</td>
<td>0</td>
</tr>
<tr>
<td>BWA-906-AS</td>
<td>Omni</td>
<td>SX7023EXT</td>
<td>≤6 dBi</td>
<td>50 Ω</td>
<td>0</td>
</tr>
</tbody>
</table>
FCC and ISED Certification, 2.4GHz

This equipment contains transmitter module DX80-2400 or SX243.

<table>
<thead>
<tr>
<th>Radio Module DX80-2400</th>
<th>Radio Module SX243</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC ID: UE300DX80-2400</td>
<td>FCC ID: UE3SX243</td>
</tr>
<tr>
<td>IC: 7044A-DX8024</td>
<td>IC: 7044A-SX243</td>
</tr>
<tr>
<td>HVIN: DX80G2 / DX80N2</td>
<td>HVIN: SX243</td>
</tr>
</tbody>
</table>

FCC Notices

IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified by the FCC / ISED for use with other products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified for fixed base station and mobile applications. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID/IC label must be visible through a window on the final device or it must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside of the final device that contains the following text:

Transmitter Module [DX80-2400 or SX243]
Contains FCC ID: [UE300DX80-2400 or UE3SX243]
Contains IC: [7044A-DX8024 or 7044A-SX243]
HVIN: [DX80G2, DX80N2 or SX243]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 2) This device must accept any interference received, including interference that may cause undesired operation.

Antenna Warning: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified Antennas for 2.4 GHz" on page 103. When integrated into OEM products, fixed antennas require installation preventing end-users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas

WARNING: Antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons.

AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent être installées de manière à assurer une distance de séparation d'au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-transmitter product procedures.

The radio transmitter modules DX80-2400 and SX243 have been approved by FCC and ISED Canada to operate with the antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 2.4 GHz

<table>
<thead>
<tr>
<th>Model</th>
<th>Antenna Type</th>
<th>2.4 GHz Radio Module</th>
<th>Maximum Gain</th>
<th>Impedance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integral antenna</td>
<td>DX80-2400 or SX243</td>
<td>Unity gain</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Continued on page 104
### Antenna Specifications

<table>
<thead>
<tr>
<th>Model</th>
<th>Antenna Type</th>
<th>2.4 GHz Radio Module</th>
<th>Maximum Gain</th>
<th>Impedance</th>
</tr>
</thead>
<tbody>
<tr>
<td>BWA-2O2-C</td>
<td>Omni, 1/2 wave dipole, Swivel</td>
<td>DX80-2400 or SX243</td>
<td>≤ 2 dBi</td>
<td>50 Ω</td>
</tr>
<tr>
<td>BWA-2O2-D</td>
<td>Omni, Dome, Box Mount</td>
<td>DX80-2400 or SX243</td>
<td>≤ 2 dBi</td>
<td>50 Ω</td>
</tr>
<tr>
<td>BWA-2O2-E</td>
<td>Omni, 1/4 wave dipole, Swivel</td>
<td>DX80-2400 or SX243</td>
<td>≤ 2 dBi</td>
<td>50 Ω</td>
</tr>
<tr>
<td>BWA-2O5-C</td>
<td>Omni, Collinear, Swivel</td>
<td>DX80-2400</td>
<td>≤ 5 dBi</td>
<td>50 Ω</td>
</tr>
<tr>
<td>BWA-2O5-MA</td>
<td>Omni, full-wave dipole, NMO</td>
<td>DX80-2400</td>
<td>≤ 4.5 dBi</td>
<td>50 Ω</td>
</tr>
<tr>
<td>BWA-2O6-A</td>
<td>Omni, Dome, Box Mount</td>
<td>DX80-2400</td>
<td>≤ 6 dBi</td>
<td>50 Ω</td>
</tr>
<tr>
<td>BWA-2O7-C</td>
<td>Omni, Coaxial Sleeve, Swivel</td>
<td>DX80-2400</td>
<td>≤ 7 dBi</td>
<td>50 Ω</td>
</tr>
</tbody>
</table>

### Additional Notes

**Información México:** La operación de este equipo está sujeta a las siguientes dos condiciones: 1) es posible que este equipo o dispositivo no cause interferencia perjudicial y 2) este equipo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operación no deseada.

Banner es una marca registrada de Banner Engineering Corp. y podrán ser utilizadas de manera indistinta para referirse al fabricante. "Este equipo ha sido diseñado para operar con las antenas tipo Omnidireccional para una ganancia máxima de antena de 6 dBd y Yagi para una ganancia máxima de antena 10 dBd que en seguida se enlistan. También se incluyen aquellas con aprobación ATEX tipo Omnidireccional siempre que no excedan una ganancia máxima de antena de 6dBd. El uso con este equipo de antenas no incluidas en esta lista o que tengan una ganancia mayor que 6 dBd en tipo omnidireccional y 10 dBd en tipo Yagi, quedan prohibidas. La impedancia requerida de la antena es de 50 ohms."

### Approved Antennas

<table>
<thead>
<tr>
<th>Antenas SMA</th>
<th>Modelo</th>
<th>Antenas Tipo-N</th>
<th>Modelo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antena, Omni 902-928 MHz, 2 dBd, junta de caucho, RP-SMA Macho</td>
<td>BWA-9O2-C</td>
<td>Antena, Omni 902-928 MHz, 6 dBd, fibra de vidrio, 1800mm, N Hembra</td>
<td>BWA-906-A</td>
</tr>
<tr>
<td>Antena, Omni 902-928 MHz, 5 dBd, junta de caucho, RP-SMA Macho</td>
<td>BWA-9O5-C</td>
<td>Antena, Yagi, 900 MHz, 10 dBd, N Hembra</td>
<td>BWA-9Y10-A</td>
</tr>
</tbody>
</table>

### Mexican Importer

Banner Engineering de México, S. de R.L. de C.V.
David Alfaro Siqueiros 103 Piso 2 Valle oriente
San Pedro Garza Garcia Nuevo León, C. P. 66269

81 8363.2714

### ANATEL


### Contact Us

Banner Engineering Corp. headquarters is located at: 9714 Tenth Avenue North | Minneapolis, MN 55441, USA | Phone: + 1 888 373 6767

For worldwide locations and local representatives, visit [www.bannerengineering.com](http://www.bannerengineering.com).
Warnings

**WARNING:**
- Do not use this device for personnel protection
- Using this device for personnel protection could result in serious injury or death.
- This device does not include the self-checking redundant circuitry necessary to allow its use in personnel safety applications. A device failure or malfunction can cause either an energized (on) or de-energized (off) output condition.

**IMPORTANT:** Please download the complete DXM Controller technical documentation, available in multiple languages, from www.bannerengineering.com for details on the proper use, applications, Warnings, and installation instructions of this device.

**IMPORTANT:** Por favor descargue desde www.bannerengineering.com toda la documentación técnica de los DXM Controller, disponibles en múltiples idiomas, para detalles del uso adecuado, aplicaciones, advertencias, y las instrucciones de instalación de estos dispositivos.

**IMPORTANT:** Veuillez télécharger la documentation technique complète des DXM Controller sur notre site www.bannerengineering.com pour les détails sur leur utilisation correcte, les applications, les notes de sécurité et les instructions de montage.

Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna configurations installed without surge suppressors invalidate the manufacturer’s warranty. Keep the ground wire as short as possible and make all ground connections to a single-point ground system to ensure no ground loops are created. No surge suppressor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected to the Sure Cross device during a thunderstorm.

Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio frequency emissions. **Customers who want to re-export this product to a country other than that to which it was sold must ensure the device is approved in the destination country.** The Sure Cross wireless products were certified for use in these countries using the antenna that ships with the product. When using other antennas, verify you are not exceeding the transmit power levels allowed by local governing agencies. This device has been designed to operate with the antennas listed on Banner Engineering’s website and having a maximum gain of 9 dBi. Antennas not included in this list or having a gain greater than 9 dBi are strictly prohibited for use with this device. The required antenna impedance is 50 ohms. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen such that the equivalent isotropically radiated power (EIRP) is not more than that permitted for successful communication. Consult with Banner Engineering Corp. if the destination country is not on this list.

**IMPORTANT:**
- Never operate a 1 Watt radio without connecting an antenna
- Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
- To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure Cross MultiHop (1 Watt) radio without an antenna connected.

**IMPORTANT:**
- Electrostatic discharge (ESD) sensitive device
- ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
- Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and assembling units on a grounded, static-dissipative surface.
Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING OR TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for personal protection applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior express approval by Banner Engineering Corp. will void the product warranties. All specifications published in this document are subject to change; Banner reserves the right to modify product specifications or update documentation at any time. Specifications and product information in English supersede that which is provided in any other language. For the most recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.